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CD PCPLUS DAN FILE PDF
Saya langsung aja:

1. Pada awal November 2003
saya kembalikan CD PCplus seri
ke-2 atas saran bagian Sirkulasi
yang dialamatkan ke bagian
Redaksi untuk diganti dengan
yang lebih baik (gambar
banyak yang pecah-pecah dan
ada isi yang sama). Bagaimana
kabarnya?

2. Apa saya harus membeli lagi
yang baru komplit dengan
bukunya? CD seri ke-3 yang
saya beli langsung melalui PT.
PRIMA INFOSARANA MEDIA
pun ada halaman yang kosong
hanya judulnya saja (misalnya
halaman 63). Bagaimana ya?
Padahal saya sudah terlanjur
cinta dengan PCplus. Kalau
begini terus saya bisa "broken
heart" lho. Nanti saya
kembalikan lagi nasibnya sama
dengan CD sebelumnya, Apa
CD seri ke-1 begitu juga
hasilnya? Soalnya belum
dibuka semua.

3. Kenapa PCplus makin pelit aja.
CD seri ke-1 berisi bundel
sampai 40 edisi trus software-
nya banyak lagi, CD seri ke-2
dan ke-3 kok cuma berisi 20
edisi? Bisa nggak saya
berlangganan secara
elektronik, maksudnya saya
dikirimi tiap edisi yang terbit
melalui e-mail dalam format
PDF seperti yang di CD dan
harganya ikut untuk yang di
Pulau Jawa, itung-itung

mengirit cost.
4. Bagaimana ya mengedit file PDF

seperti  yang di CD PCplus sesuai
keiginan saya (mengambil
beberapa artikel yang sama
untuk dijadikan satu atau
memperbesar hasil print,
soalnya saya coba print 1
halaman susah bacanya). Saya
punya software Adobe
Pagemaker & Adobe Acrobat,
apa itu bisa, kalau bisa
bagaimana caranya? Saya masih
belajar lho.

Terima kasih atas perhatiannya.

Basry Dar
basrydar@yahoo.com

Red: 1&2. Permasalahan ini sudah
ditanggapi oleh bagian Sirkulasi dan
sejauh yang kami terima laporannya,
masalah tersebut telah diselesaikan
dengan baik. 3. Makin pelit?
Tergantung dari sudut mana
melihatnya. Yang jelas, sekarang ini
bundel PCplus maksimum akan dirilis
setiap 20 edisi mengingat keterbatasan
tempat dan bahan. 4. Tepat, Anda bisa
menggunakan Adobe Acrobat (bukan
yang Acrobat Reader).

INGIN WORKSHOP
Salam informatika.

Perkenalkan nama saya May Rosi
Wibawa, semester 7 STMIK-STT
Mitra Karya Bekasi jurusan Teknik
Informatika. Mohon maaf
sebelumnya, sudah lama saya
membaca PCplus dan sering Rosi

baca di situ ada workshop tentang
merakit PC atau tentang network-
ing. Saya sangat tertarik karena
selama saya kuliah dan hampir
selesai sepertinya tak ada
pengetahuan yang membekas
karena selama ini memang belum
ada yang mengadakan di daerah
Bekasi pada umumnya, juga
kampus saya pada khususnya. Atau
mungkin Rosi yang terlalu kuper?

Rosi adalah salah satu
mahasiswa kelas malam, yang mana
waktu kami habis di kerja dan
kampus. Seringnya dosen mangkir
membuat kami semakin patah
semangat, juga kebijakan kampus
yang kadang sangat tidak
mendukung kami sehingga kami
seperti katak dalam tempurung.
Baru akhir-akhir ini Rosi bersama
beberapa mahasiswa baru yang
bukan kelas malam membentuk
sebuah bengkel informatika dengan
nama siput-ti (smart person under
technology - information technol-
ogy).

Kami cuma 2 orang dengan
kurang lebih 5 simpatisan dan kami
ingin memberi wajah baru di
kampus kami seiring dengan
perjalanan waktu dan pesatnya
pertumbuhan dunia teknologi
informasi kami minta saran kami
ingin juga mengadakan kegiatan di
kampus kami, tapi kendalanya kami
belum tahu tentang prosedurnya,
mulai dengan apa yang perlu
disiapkan, seperti proposal, mencari
sponsor, dan ruang lingkup
kegiatan bisa enggak ya kakak-
kakak di sana bantu Rosi? Mungkin
kasih tahu apa yang bisa saya
lakukan pra kegiatan tersebut,
berapa kira-kira dana yang kami
keluarkan untuk itu, karena ini
masih yang pertama kami pengen
ini bersifat gratis khususnya untuk
mahasiswa di kampus kami. Tapi
untuk kerja sama dengan PCplus
sudah barang pasti tak gratis kan.
Bisa bantu kami kan?

Kami ingin ada suatu
perubahan satu semester lagi kami
sudah selesai insya Allah. Atau kami
harus waiting list jadi kami ngajuin
sebuah proposal dan kami tunggu
konfirmasinya sampai kami patah
semangat lagi ups .....maaf .  Atau
kami main aja ya ke basecamp-nya
PCplus, jadi kami bisa kenalan
dengan orang-orang di balik dapur
Redaksi PCplus. Pasti asyik kali ya?
Tapi kalau jam kerja sepertinya
susah karena kami juga kerja,
sementara simpatisan kami yang
enggak kerja masih malu-malu, jadi
kami ini benar-benar kasihan,
seperti kata iklan... “kasian deh lu.”

Saya tunggu balasan dari
kakak-kakak di meja redaksi PCplus
minta maaf kalau ada yang kurang
berkenan. Terima kasih dan hormat
saya.

May Rosi Wibawa
rosi@indonesia.fns.co.id
may_rossy@yahoo.com

Base Camp siput-ti
STMIK - STT MITRA KARYA BEKASI

Red: Kami salut dengan keinginan
Anda untuk maju, dan setiap langkah
untuk maju pasti butuh perjuangan
dan pengorbanan. Apabila Anda
ingin mengetahui secara persis
prosedur workshop atau ingin
menyelenggarakan kegiatan di
kampus Anda, silakan menghubungi
Sdr Jimmy Rambing (jimmy@e-
pcplus.com atau di 5483008 ext.
3716). Materi dan waktu pelaksanaan
bisa dibicarakan lebih lanjut dan
nggak usah terlalu merisaukan
masalah dana, karena asal ada upaya
pasti ada dana yang mengikuti upaya
tersebut. Terus terang, kami sangat
menghargai jerih payah para siput TI
yang merayap pelan-pelan di
belantara TI yang berkembang sangat
pesat. Terus maju dan jangan pernah
patah semangat.

BAHAS XML
Saya saat ini sedang

mempelajari tentang eXtensible
Markup Language (XML), suatu
gebrakan yang sangat menarik
terutama dalam perkembangan
teknologi Web. Cuma masih
sangat disayangkan, pembahasan
maupun perbincangan mengenai
topik ini masih sangat sedikit,
apalagi buku-buku dan tutorial
mengenai hal ini, masih sulit dan
jarang ditemukan. Coba dong,
dear PCplus mengangkat masalah
ini, siapa tau aja banyak yang bisa
membantu saya dan bisa sama
sama mengembangkan XML ini.
Thanks.

Sahrul Kifli
adonk_jogja@yahoo.com

Jogjakarta

Red: Coba lihat arsip PCplus tahun
2004 yang membahas tentang XML.
Untuk membuatnya menjadi artikel
berseri, saat ini belum mungkin. Kami
akan mengusahakannya mengingat
bahasan tersebut memang, seperti
Anda katakan, akan mewarnai
perkembangan Web di masa
mendatang.

GAMBAR TUTORIAL
Semoga seluruh Redaksi

PCplus sehat dan selalu
menelorkan rubrik yang menarik.
To the point aza. Aku ucapin
buaaanyak terima kasih padamu
karena kamu telah membuatku
tambah ilmu about IT, tetapi aku
maaf yach aku ada sedikit unek-
unek nih, mengenai beberapa
gambar yang dimuat. Beberapa
gambar kaum hawa yang
ditampilkan sungguh
mengganggu pandangan mata
(terakhir pada plusTutorial) kalo
bisa edisi selanjutnya mohon
dipilih gambar yang lebih sesuai,
jangan gambar-gambar semacam
itu, misalnya gambar flora&fauna.
Juga tolong dipikirkan efeknya
buat pembaca kalo melihat
gambar semacam
itu.....waspadalah terima
kasihhhhhhh.............. Sekali lagi
mohon maaf mungkin ini agak

mengganggu perasaan.

Ro Gun
gunxx63@yahoo.com

Red: Terima kasih atas masukannya,
kami akan laksanakan tanpa
keberatan atau alasan apapun.

PC REWEL
Saya baru membeli PC +/- 6

bulan lalu, dengan spesifikasi
sebagai berikut:
• Monitor 17" Samsung 765mb
• Motherboard MSI 875p Neo

(dual channel)
• Prosesor Intel P4 2,4c GHz FSB

800
• Memory Corsair Twinx 2x

256MB (DDR PC3200)
• Hard disk Seagate Barracuda

7200, 40Gb, ATA 100
• VGA PixelView 128 MB Ti

4200 (driver version 4.5.2.3).

Dari saya beli sampai saat
ini, saya mempunyai problem
yaitu monitor sering berkedip-
kedip (gambar jadi hitam,
kemudian normal lagi, dan terus
berulang- ulang dengan tempo
yang berbeda-beda). Mohon
bantuan bapak, apa yang harus
saya lakukan, sebab dari
penjualnya menyarankan saya
agar ganti VGA Tipe FX 5600?

Mentari
mentarifc@dnet.net.id

Red: Masalah ini bisa bersumber
dari segi software maupun
hardware. Dari segi hardware,
pastikan tidak ada kerusakan pada
monitor, kartu grafis, dan
mainboard. Pastikan juga kartu
grafis sudah terpasang dengan
benar, begitu pula dengan koneksi
ke monitor. Pastikan juga suplai
daya (termasuk tegangan tentunya)
sudah benar. Periksa juga setting
BIOS pada CMOS, jangan
melakukan overclock. Dari segi
software, coba gunakan driver
nVidia terbaru dan DirectX 8.1 ke
atas. Semoga membantu.

LAPTOP, NOTEBOOK,
DESKNOTE

Saya pernah bilang bahwa
laptop dan notebook itu beda.
Benarkah? Apalagi bedanya
dengan desknote? Tolong diulas.
Terima kasih.

Riani Firda
riani_firda@yahoo.com

Red: Umumnya, laptop sering juga
disebut sebagai notebook dan bisa
dipertukarkan satu sama lain dalam
hal penyebutannya. Perbedaan
notebook dengan desknote adalah
dari jenis prosesor yang digunakan,
ketersediaan baterai, dan bobot
antara keduanya. Desknote
menggunakan prosesor desktop,
biasanya dijual tanpa baterai (ada
juga yang menyertakan baterai),
dan bobotnya lebih berat
dibandingkan notebook.

Zaman yang Berubah Cepat

Apa yang berbeda dari kartu nama sekarang ini dibandingkan dengan
sepuluh lima belas tahun yang lalu? Desainnyakah? Jenis kertasnyakah?
Tipografi hurufnyakah? Warnanyakah? Ternyata bukan!

Yang membedakan adalah @ dan www. Pada zaman itu, kartu nama
sudah terasa lengkap bila dibubuhi nama lengkap, jabatan, alamat yang
jelas dan nomor telepon. Sekarang ini, sekalipun sudah ada gelar yang
mentereng, nomor telepon sampai tiga biji, faksimili, nomor ponsel dua
buah, orang yang kita beri kartu nama pasti akan menanyakan alamat e-
mail Anda. Beberapa orang bahkan menyediakan nomor identitas (user ID)
dari instant messenger keluaran Yahoo, ICQ atau MSN.

Tak jarang, kartu nama juga dilengkapi dengan situs bertanda www
atau http://. Boleh jadi, kita selama ini tak terlalu memperhatikan per-
ubahan ini karena boleh jadi perubahan tersebut sudah dianggap wajar.

Begitulah. Masyarakat ini berubah sedemikian cepat. Sebelum Anda
makin ketinggalan mengikuti geliatnya, di lembaran plusFokus kali ini kami
menyajikan sebuah panduan untuk memiliki situs. Sebuah panduan yang
tak hanya ringkas dan jelas, tetapi juga benar-benar memandu dalam arti
yang sesungguhnya, mulai dari mendesain sampai dengan cara hosting-
nya.

Artikel lain menyuguhkan kiat tentang mengakali sebuah game
supaya kita tidak frustrasi untuk menyelesaikannya. Kiat ini boleh jadi
perlu Anda simak supaya tujuan Anda memainkan game untuk
mendapatkan hiburan bisa tercapai. Seringkali, karena game itu terlampau
susah, kita justru dibuat frustrasi.

Tak kalah pentingnya adalah apabila Anda berminat untuk
mengikuti kegiatan workshop yang akan diselenggarakan oleh PCplus
di berbagai kota. Di edisi ini, informasi tentang kegiatan tersebut
tersedia lengkap dan jangan sampai Anda ketinggalan informasi
dan kehabisan tempat.

Itu saja. Selamat membaca.

Salam hangat dari Palmerah
Redaksi



Jaringan Optik Siemens,
Perkembangan Baru dalam Dunia
Jaringan di Indonesia. Perkembangan dunia
telekomunikasi saat ini yang diiringi dengan pergolakan ekonomi
dan keadaan pasar yang lemah membuat para penyedia jaringan
harus memikirkan cara untuk mengoptimalkan investasi
jaringannya. Mereka membutuhkan sebuah cara untuk memenuhi
permintaan akan jaringan data yang semakin meningkat tanpa
harus meninggalkan layanan suaranya.

Menurut Siemens, Surpass hiT 70 Series (Siemens Next
Generation Multi-Service Provisioning Platform) memungkinkan
para penyedia jasa jaringan untuk mengembangkan portofolionya
dan memberikan pelayanan menggunakan infrastruktur SDH
(Synchronous Digital Hierarchy) yang sudah ada, serta memastikan
pemakaian yang efisien dari bandwidth yang tersedia untuk
transmisi data dan suara.

Surpass bisa didefinisikan sebagai gabungan solusi dan
layanan jaringan masa depan bagi para penyedia layanan jaringan.
Teknologi Surpass terdiri dari Next Generation Optics dan Switch-
ing. Next Generation Optics menawarkan solusi transmisi suara
dan data berkapasitas besar  melalui jaringan optik. Selain itu,
teknologi Surpass hiT 70 Series mendukung Virtual Local Area
Networks (VLANs) dan Virtual Private Networks (VPNs) untuk
mendukung layanan jaringan korporat untuk daerah nasional. (raa)

Korea Selatan Bermasalah karena
Online Gaming. Pernah mendengar tentang seorang
bocah 12 tahun bernama Lim? Dalam permainan game online
“Lineage”, Lim adalah seorang jagoan yang bisa mengatasi segala
tantangan dan marabahaya. Dalam kenyataannya, kehidupan Lim
tak seindah itu. Saking cintanya pada game, ia nekat mencuri uang
sebesar US$16.000 dari ayahnya dan pergi meninggalkan rumah
hanya untuk bermain game. Lim ditemukan di sebuah kafe
Internet bernama PC Baang.

Kasus Lim mewakili gambaran masalah sosial yang dihadapi
Korea Selatan sebagai pasar game online terbesar dengan jaringan
broadband yang luas. Di sana, pemain game yang sukses bisa
mengumpulkan banyak uang dengan mengoleksi item virtual
seperti pedang atau ramuan ajaib dari berbagai game semacam
Lineage, dan kemudian menjualnya ke pemain lain dengan barter
uang dalam arti sebenarnya. Kenyataan akan makin meluasnya
transaksi jual-beli barang-barang cyber merupakan hal yang perlu
diperhatikan, dan pemerintah Korea Selatan dinilai perlu
membuat semacam peraturan yang bisa mengatasi sisi gelap dari
game online.

Tercatat kira-kira 70 persen dari 48 juta penduduk Korea
Selatan mengakses Internet, 11 juta di antaranya menggunakan
layanan Internet berkecepatan tinggi. Booming-nya game online
di negara tersebut terbukti dengan adanya beberapa cable
channel yang menyiarkan berbagai acara game profesional selama
24 jam dalam sehari dan adanya klub-klub bagi para pemain
game. Banyak anak yang menghabiskan kurang lebih 10 jam
waktunya (dalam sehari) di depan komputer, hanya untuk
mempersiapkan diri dalam kontes game dan mempelajari strategi
untuk menang. Kebanyakan dari pencandu game ini adalah anak-
anak yang berumur belasan tahun.

Adakah pengaruh game online pada kesehatan? Sebuah
media lokal di Korea Selatan melaporkan adanya 6 kematian yang
berhubungan dengan game online sejak tahun 2002, termasuk di
antaranya sebuah kasus pembunuhan yang dilakukan oleh
seorang pemain terhadap saudara perempuannya sendiri. Setelah
diselidiki, ternyata si pemain mengalami gangguan jiwa yang
menyebabkan ia bingung membedakan antara dunia nyata dan
dunia online-nya. Dalam banyak kasus, para pecandu game
mengalami beberapa masalah kejiwaan. Mereka memperlihatkan
sikap buruk di sekolah dan bermasalah dengan orang-orang di
lingkungannya. Setiap minggunya dilaporkan kurang lebih 30
kasus yang berhubungan dengan game online, dan angka ini terus
meningkat. Wah, gawat! (raa)

AcerPower F1, PC Bisnis
yang Mendukung Prosesor
P4 2,5GHz. Acer sendiri mengklaim produk
barunya ini sebagai PC terbaik yang ditujukan
untuk kelas bisnis. Kelebihannya terletak pada
prosesor yang diusungnya, Pentium 4 2,5GHz
berteknologi Hyper-Threading dengan 800MHz
FSB-nya. Selain itu , Acer juga melengkapi
AcerPower F1 dengan built-in LAN dan
memori yang mendukung DDR 400/
333/266. Untuk menunjang
kemampuan grafis dan suaranya, PC
ini dilengkapi dengan chipset on-board
SiS 661FX dan AGP 8X.

Dilihat dari segi fisik, penampilan AcerPower
F1 bisa dibilang biasa saja. Kelebihannya, PC bisnis ini
memiliki 3 slot PCI, 5 rak drive yang memungkinkan user
menambah kapasitas harddisk-nya, 6 port USB 2.0 (2 terletak di
bagian depan), dan 2 slot DIMM yang memungkinkan user meng-upgrade RAM-nya hingga 2GB.
Acer sendiri telah mencantumkan memori 128MB DDR 400 dalam AcerPower F1. Sebagai informasi,
satu paket penjualan PC ini sudah termasuk dengan monitor CRT 15 inci dan OS yang diberikan adalah
Windows XP Professional. Satu agak aneh, yang disebut oleh Acer sebagai uncomplicated keyboard
untuk PC ini ternyata adalah jenis keyboard biasa alias non-multimedia keyboard. (raa)

Qbic IQ3601, Sistem Mini
Barebone Soltek yang
Terbaru. Serial Qbic IQ bisa dibilang istimewa bila
dilihat dari segi tampilannya. Seri Qbic terbaru, IQ3601
menggunakan prosesor VIA C3 Ezra-T 1GHz yang
menawarkan konsumsi daya, level noise, heat, dan biaya
yang rendah. Sistem mini barebone ini juga berfungsi

sebagai mesin multimedia yang terintegrasi dengan decoder
MPEG2 yang bisa menghasilkan video berkualitas DVD.

Qbic IQ3601 dilengkapi dengan 6 kanal audio on-board, S/PDIF, USB 2.0,
IEEE1394, dan fungsi TV opsional. Mini barebone ini berdimensi 33cm(P) x 21,5cm(L) x 20cm(T). Casing-
nya terbuat dari aluminium dengan pilihan warna hitam atau perak. Software yang telah termasuk
dalam paket penjualan paket Qbic ini adalah Trend Micro PC-cillin 2004, PowerQuest,
PartitionMagic 6.0 SE, Drive Image 4.0, FarStone Virtual Drive 7 dan RestoreIT 3. (raa)

Sony Adopsi Chipset SiS648 untuk Seri Notebook
VAIO-nya. Chipset tersebut akan melengkapi produk-produk VAIO GR berbasis layar – mulai
dari 15, 16, hingga 17inchi – yang akan segera hadir di pasar. Seri GR dilengkapi dengan  DVD-RW/CD-
RW combo drive yang memungkinkan user untuk merekam dan memainkan 4 format media DVD.
Layar monitornya menggunakan display UXVGA LCD dengan teknologi Sony yang terbaru, XBRITE,
yang bisa memberikan hasil playback DVD dan tampilan TV terbaik. Dengan adanya Giga Pocket TV
tuner, user bisa merekam program acara TV favoritnya, atau bahkan menggunakan input analog untuk
merekam dari VHS.

Notebook VAIO berseri GR didesain untuk menjalankan aplikasi-aplikasi berperforma tinggi.
Dilengkapi dengan prosesor Intel Pentium 4 atau Celeron, seri GR mendukung 2 model sistem bus
533MHz dan 400MHz. Keduanya memiliki fitur NVIDIA GeForce420 Go Graphics Accelerator untuk
grafik 3D, dan bisa digunakan sebagai mesin game LAN. Pilihan memori on-board yang diberikan oleh
Sony adalah 256 atau 512MB RAM. (raa)

Win32.Xombe.Downloader, Satu Lagi Jenis Trojan
yang Menyebar Lewat E-mail. Meskipun tak memiliki kemampuan untuk
menyebarkan dirinya sendiri (seperti Sobig.F), Win32.Xombe.Downloader mampu menyerang sistem
komputer dengan taktik social engineering. Dalam e-mail yang mengandung trojan ini terdapat
sebuah file attachment winxp_sp1.exe berukuran 4.096 byte untuk menipu si penerima yang akan
mengira bahwa file tersebut berisi Windows XP Service Pack 1.

Nama lain dari Win32.Xombe.Downloader adalah Downloader-GJ (McAfee), Trojan Xombe
(Symantec), TrojanDownloader.Win32.Xombe (Kapersky), atau Win32.Xombe.A. Field From pada e-
mail berisi <windowsupdate@microsoft.com>, subjeknya Windows XP Service Pack 1 (Express) –
Critical Update. Isi pesan pada e-mail tersebut berbunyi:

Window Update has determined that you are running a beta version of Windows XP Service Pack 1 (SP1). To
help improve the stability of your computer, Microsoft recommends that you remove the beta version of
Windows XP SP1 and re-install Windows XP SP1. If you cannot remove the beta version, you should still
reinstall Windows XP SP1.
Windows XP SP1 provides the latest security, reliability, and performance updates to the Windows XP family
of operating systems. Windows XP SP1 is designed to ensure Windows XP platform compatibility with newly
released software and hardware, and includes updates to resolve issues discovered by customers or by
Microsoft's internal testing team.
The maximum download size is approximately 3 MB, however the size of the download and time required
may be less for computers that have had updates previously installed.
To minimize the download time needed for installation, setup will only download those files which are
required to bring your computer up to date. Windows XP SP1 includes Internet Explorer 6 SP1. Anti-virus
software programs may interfere with the installation of Windows XP SP1. Please disable anti-virus software
while installing the service pack.
Just run the file winxp_sp1.exe in attach and make sure to restart your PC after installation will be com-
pleted.

©2004 Microsoft Corporation. All rights reserved. Terms of Use Privacy Statement

Jika user men-download file attachment tersebut, trojan ini akan memperbanyak dirinya dan
masuk ke dalam direktori sistem dan menambah registry value untuk menjalankan copy dirinya pada
Windows startup. (raa)

plusAktual V • 20 - 26 Januari 2004
PCplus 159

| 3

ISTIMEWA

ISTIMEWA

ARE/PCplus



plusAktual V • 20 - 26 Januari 2004
PCplus 159

4 |

Sun Microsystem Luncurkan
Layanan Software Support untuk
OpenOffice.org. Sun yang dikenal sebagai pendiri
dan pendukung utama projek open source OpenOffice.org kini
menawarkan layanan Sun Software Support bagi konsumen
OpenOffice.org. Sun juga meningkatkan dukungannya untuk
produk komersil StarOffice. Keputusan Sun untuk memperluas
layanan pendukungnya tersebut dilatarbelakangi oleh tingginya
permintaan akan suite desktop alternatif dengan harga yang
terjangkau.

Alasan lainnya, Sun ingin mengikuti pergerakan global yang
dilakukan oleh pemerintah dan institusi, seperti pemerintahan kota
Munich, Departemen Perdagangan Israel dan Departemen Dalam
Negeri Perancis untuk bermigrasi ke software yang lebih
terjangkau dan aman seperti StarOffice dan OpenOffice.org.

Ada 2 paket layanan pendukung yang disediakan bagi para
pengguna OpenOffice.org. Pertama adalah Sun Software Stan-
dard Support yang terdiri atas akses telepon dan online yang tak
terbatas ke para teknisi ahli, pengiriman dan penelusuran online,
update peranti lunak dan patches serta akses menuju sumber
online self-serve. Dan yang kedua adalah Sun Software Premium
Support yang meliputi layanan dukungan standar dan 24 jam
coverage serta transfer telepon langsung yang dirancang untuk
lingkungan yang selalu membutuhkan layanan 24 jam. (raa)

NVIDIA
GeForce
FX5700
Menyusul
Sukses
FX5600. Kartu grafis
terbaru keluaran Soltek ini
dilengkapi dengan dukungan
OpenGL 1.5 dan DirectX 9.0.
FX5700 diperuntukkan bagi
pasar high-end yang

membutuhkan teknologi grafis dan fitur-fitur video mutakhir.
Soltek sendiri menyediakan 2 model untuk seri FX5700, SL-5700-
QD dan SL-5700-XD. SL-5700-QD memiliki memori sebesar 256MB
DDR, sedangkan SL-5700-XD sebesar 128MB DDR. Keduanya
dilengkapi dengan AGP 8X, TV-Out dan DVI.

Ada banyak fitur yang dimiliki GeForce FX5700, antara lain
adalah mesin NVIDIA CineFX 2.0, Intellisample HCT (High-
resolution Compression Technology), teknologi UltraShadow,
teknologi proses 0,13 mikron, teknologi NVIDIA nView multi-
display, 400MHz RAMDACs (mendukung display QXGA hingga
resolusi 2048 x 1536 @ 85Hz), DVC (Digital Vibrance Control) 3.0,
UDA (Unified Driver Architecture), decoder MPEG-2 dan 64-
phase Video Scaler. (raa)

Microsoft Sediakan Akses Teknologi untuk Program
Bakti BCA. Bantuan yang diberikan Microsoft untuk program bakti ini berupa peranti lunak,
lengkap dengan lisensinya, kepada 2 sekolah yang terpilih (SMUN1 dan SLTPN1 Gading Rejo) yang
terletak di desa Tanggamus, Bandar Lampung, Sumatera Selatan.

Peranti lunak yang diberikan adalah Microsoft Windows XP Professional dan Microsoft Office XP
Professional, masing-masing berisi 1 unit Full Package Product (FPP) dengan 11 unit lisensi per sekolah.
Guru-guru pun diberikan pelatihan mengenai OS Windows XP, Micosoft Word 2003, Excel 2003 dan
penggunaan Internet. Total bantuan yang diberikan kira-kira sebesar US$22.000. Menurut Cynthia
Iskandar, Community Affairs Manager PT Microsoft Indonesia, program ini merupakan bagian dari
Microsoft Giving for Indonesia, sebuah program bakti sosial Microsoft di Indonesia. (raa)

VT6421 PCI Serial ATA RAID Controller Keluaran VIA
Tawarkan Fleksibilitas Penyimpanan pada PC. Produk
baru ini terintegrasi dengan antarmuka Cardbus (PCMCIA) untuk konektivitas mobile dengan USB 2.0
host controller. VT6421 dilengkapi dengan Serial ATA dua kanal, menawarkan kecepatan transfer data
hingga 150Mbps. Terpisah dengan konektivitas Serial ATA, VT6421 menyediakan dukungan terhadap
RAID multi-level, termasuk RAID level 0 untuk performa maksimal, RAID level 1 untuk keamanan
maksimal dan JBOD. Produk ini juga menawarkan dukungan untuk IDE devices tanpa harus
menggunakan adapter. VIA VT6421 kompatibel dengan platform berbasis prosesor Intel atau AMD,
serta OS Windows 9X/ME/NT4/2K/XP dan Linux. (raa)

Linux Kian Banyak Pendukung-nya. Intel dan IBM, cuma salah dua
dari pendukung OS yang kian populer ini. IBM sendiri telah mengadopsi Linux yang dinilai sebagai OS
dengan prospek bagus ke dalam berbagai produk dan layanannya. Sama dengan IBM, Intel juga
mendukung Linux dengan membuat chip yang bisa mendukung OS tersebut. Hal ini sangat
menguntungkan Intel sebagai perusahaan semikonduktor terbesar di dunia. Intel, selain sebagai penyedia
chip yang mendukung Windows, kini juga dikenal sebagai penyedia chip untuk Linux yang jadi
kompetitor utama Windows.

Sebagaimana ditulis Reuters, Open Source Development Labs (disingkat OSDL) yang merupakan
sebuah konsorsium industri non-profit yang berlokasi di Beaverton, Oregon, AS, mengatakan bahwa saat
ini dana yang telah terkumpul untuk memromosikan Linux adalah sebesar US$3 juta dari target US$10
juta. Sebagai informasi, Intel dan IBM juga tercatat sebagai anggota konsorsium tersebut. (raa)
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Handset CDMA Gratis dari SanexTel dan Visa
International. Handset akan dibagikan kepada
para pengguna kartu debet Visa Electron dan
kartu kredit Visa di Jabotabek. Program
bertajuk Visa FlexiTalk ini dilangsungkan
selama bulan Januari hingga Maret 2004.
Syaratnya hanya dengan berlangganan Flexi
pascabayar selama 12 bulan dengan minimum
penggunaan dalam jumlah tertentu. Untuk
handset tipe sanex SC-5200, minimum
penggunaan per bulan adalah Rp. 138.000,
tipe SC-9530 minimum penggunaan adalah
Rp. 150.000 per bulan, dan tipe SC-7080
minimum penggunaannya adalah Rp. 250.000
per bulan. (fbi)
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Cakrawala Gintings
cakra@e-pcplus.com Apa Itu FireWire?

F

Kabel api?
Mengerikan sekali!

Ternyata tidak!
FireWire menjanjikan

perpindahan data
tingkat tinggi

dibandingkan dengan
standar yang lain.

Siapa sih yang
menemukan pertama

kali dan cocok
digunakan untuk
apa? Simak yang

berikut ini!

ireWire atau
sering juga
dikenal sebagai
IEEE1394 adalah suatu

serial bus yang memiliki performa
tinggi utamanya bila
dibandingkan dengan RS232C
yang hingga saat ini masih tersedia
pada mainboard.

FireWire ini diciptakan oleh
Apple dengan tujuan yang bisa
dikatakan sama dengan tujuan
diciptakannya standar USB,
hanya saja bandwidth maksimum
yang dimiliki FireWire jauh lebih
besar dibandingkan USB generasi
awal. Hal ini membuat FireWire
cocok digunakan untuk alat-alat
yang bermain dengan data yang
besar seperti halnya digital
camcorder.

Saat ini FireWire sudah mulai

tersedia secara onboard pada
mainboard, khususnya mainboard
kelas atas. Sebagian peripheral
seperti halnya kartu suara juga
kadang telah dilengkapi dengan
FireWire. Saat ini dengan
tersedianya USB 2.0, secara band-
width maksimum USB sudah dapat
mengimbangi FireWire khususnya
IEEE1394a.

FIREWIRE
Seperti telah disebutkan di

atas, FireWire ini merupakan serial
bus. Hal ini berakibat pada tidak

banyaknya konektor yang
diperlukan untuk melakukan
koneksi dengan peripheral. Secara
umum konektor yang digunakan
dalam melakukan koneksi secara
FireWire memiliki 6 pin pada salah
satu ujungnya dan 4 pin pada ujung
yang lainnya. Ujung dengan 6 pin
ini biasanya dipasangkan pada PC
sementara ujung dengan 4 pin
biasanya dipasangkan pada

peripheral yang ingin dihubungkan.
Konektor yang kedua ujungnya
memiliki 6 pin maupun yang kedua
ujungnya memiliki 4 pin juga
tersedia di pasaran.

FireWire ini seperti halnya USB
juga bisa memberikan daya rendah
pada peranti yang
membutuhkannya. Untuk peranti
yang membutuhkan daya tinggi,
peranti tersebut haruslah
menggunakan catu daya tersendiri.

Adapun ujung konektor
FireWire yang menggunakan 6 pin
memiliki susunan pin (diurutkan

dari pin 1 hingga 6) power, ground,
B twisted pair -, B twisted pair +, A
twisted pair -, dan A twisted pair +.
Untuk ujung konektor FireWire
yang menggunakan 4 pin
susunannya (diurutkan dari pin 1
hingga 4) adalah B twisted pair -, B
twisted pair +, A twisted pair -, dan
A twisted pair +. Untuk lebih
jelasnya mengenai susunan pin
tersebut silakan Anda lihat gambar

yang terlampir (Gambar A).
Dari segi kecepatan, versi kabel

akan memiliki kecepatan sebesar
100, 200, ataupun 400Mb/s (khusus
untuk IEEE1394b bisa mencapai
800Mb/s). FireWire ini mampu
mendukung hingga 63 piranti.
Adapun panjang kabel maksimal
yang dianjurkan adalah sekitar 4,5
meter.

Bila digunakan secara daisy
chain (dengan cara seperti
menghubungkan dua buah
harddisk Paralel ATA pada sebuah
kabel Paralel ATA), maksimal peranti
yang diperbolehkan adalah 16.
Dengan konfigurasi seperti ini,
panjang koneksi yang bisa terjadi
adalah sekitar 72 meter.

FireWire ini populer digunakan
untuk mentransfer data dari digital
camcorder. Hal ini didukung oleh
mampunya FireWire ini untuk
melakukan transfer secara isochro-
nous. Selain secara isochronous
transfer secara asynchronous juga
didukung oleh FireWire ini.
Isochronous bisa dikatakan adalah
proses yang membutuhkan
koordinasi waktu untuk bisa
berhasil. Transmisi suara dan
gambar digital merupakan salah
satu proses seperti ini. Isochronous
ini bisa juga diartikan menyatakan
kesamaan (uniform) dalam waktu
dan memberikan jaminan band-

FireWire sudah mulai menjadi
standar pada mainboard masa
kini.
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width dengan mentransfer data
dalam jumlah yang sama (uniform)
setiap detiknya.

Kepopuleran FireWire ini
dalam melakukan transfer data
digital audio dan video (misalnya
transfer dari digital camcorder)
terlihat pula dari dukungan sistem
operasi yang umum digunakan,
khususnya Windows. Bila yang
digunakan adalah USB, sering kali
seseorang masih harus meng-
install driver yang disertakan
meskipun telah menggunakan
Windows XP misalnya. Hal ini
sering kali tidak diperlukan bila
menggunakan FireWire. PC+

Gambar A – Susunan Pin dalam kabel FireWire.
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Mari Download
dengan Baik dan

Benar

Porsi pembahasan
mengenai software

belum akan
berkurang, dan masih
akan banyak pembaca

yang berminat
mencoba sendiri

software yang
dibahas, ada baiknya

juga membahas
khusus mengenai pen-

download-an.
Semacam bekal

perjalanan setahun ke
depan. Setuju?

entu saja hal
yang paling
mendasar dari
pen-download-an

adalah informasi mengenai link
atas file tersebut di Internet.
Sebuah artikel pembahasan
software yang baik biasanya
selalu mencantumkan direct link
ke software tersebut. Jika tidak,
jangan takut. Ada banyak cara
untuk menemukan file tersebut
di Internet.

Cara yang paling
dasar adalah dengan
menggunakan search
engine atau mesin
pencari. Beberapa
search engine yang
populer adalah
Google, Yahoo!, dan
Altavista. Kata kunci
yang bisa digunakan
yaitu:
nama_file+nama_
pengembang
_software_
tersebut+download
(dengan tanda
tambah tetapi tanpa
tanda kutip).

Cara lainnya
adalah lewat situs
yang khusus melayani down-
load file seperti
Downloads.com, Simtel,
Fileforum ataupun Tucows.
Pencarian file juga bisa
dilakukan lewat
FileMirrors.com, situs pencari
file bagian dari program
download manager yang
bernama GetRight.

Alternatif lain bisa juga
lewat file sharing network, FTP,
maupun IRC. Tetapi serpertinya
pengguna Internet kebanyakan
kurang suka dengan dua cara
terakhir karena membutuhkan
usaha ekstra.

PERANGKAT YANG
DIBUTUHKAN

Selain komputer dan
koneksi Internet, Anda juga
membutuhkan sebuah down-
load manager. Tujuannya tentu
saja untuk memperlancar proses
download dengan cara
membagi-bagi file yang akan di-
download dan men-download
setiap bagian secara bersamaan.
Dengan begini kecepatan pen-
download-an bisa ditingkatkan.
Selain itu, download yang
sedang berlangsung  disimpan
sementara di lokasi tertentu
sebelum nantinya disatukan.
Dengan begini jika koneksi

terputus pun tidak akan ada
masalah.

Jika Anda pikir koneksi di
rumah terlalu lambat dan mahal,
sepertinya Anda perlu
mengunjungi warnet terdekat.
Dengan bermodalkan disket dan
beberapa ribu rupiah untuk biaya
perjamnya, Anda bisa
mendapatkan kenyamanan
koneksi dengan kecepatan tinggi.

Banyak nominasi download
manager, bisa dicari saja sendiri.
Beberapa nama yang menonjol
adalah DAP, GetRight, dan
Flashget. Pilih saja yang menurut
Anda paling memuaskan
kinerjanya.

Jika Anda suka dengan MP3
ataupun file video dan memiliki
kecepatan koneksi yang lumayan,
sepertinya file sharing network
bisa menjadi pilihan. Software
yang dibutuhkan adalah
semacam Kazaa, eMule, WinMx
dan program peer to peer
sharing lainnya. Yang harus
diperhatikan adalah bahwa

biasanya program semacam ini
mengandung spyware. Karena itu
saya pribadi memilih Kazaa Lite
yang lebih aman.

MEMBUAT DIREKTORI
KHUSUS

Meskipun bukanlah suatu
keharusan, tetapi membuat
direktori download khusus untuk
menyimpan (sementara) semua
hasil download bukanlah ide
yang jelek. Cara ini akan
memudahkan Anda mencari hasil
download yang sudah selesai.

Jikalau memungkinkan,
buatlah direktori ini di harddisk
yang berbeda dengan harddisk

utama komputer Anda,
atau setidaknya di partisi
yang lain. Tujuannya untuk
melindungi data Anda dan
memudahkan proses
instalasi ulang jika
dibutuhkan.Pastikan ada
cukup ruang untuk
menampung semua file
yang Anda download.

Langkah yang lebih
jauh adalah dengan
membuat direktori per
kategori file yang Anda
download. Misalnya
direktori Software, Musik,
Gambar, dan Video, yang
di dalamnya ada
subdirektori seperti Utility,
Games, dan Internet
untuk kategori software.

Ana bisa memikirkan nama-nama
yang lebih sesuai dengan kondisi
dan keperluan masing-masing.

Kenapa? Belum tahu cara
membuat direktori? Mudah, kok.
Buka Windows Explorer, pilih
tempat di mana Anda akan
membuat direktori baru tersebut,
klik kanan, pada jendela menu
yang muncul pilih New>Folder,
lalu beri nama direktori tersebut

dengan menu klik kanan Re-
name.

DOWNLOAD DAN BELANJA
SOFTWARE

Anda sudah tahu nama file
program yang akan Anda
download, program download
manager sudah siap, direktori
khusus sudah menunggu, maka
yang harus Anda lakukan adalah
menghubungkan komputer ke
dunia maya, dan men-download
file tersebut.

Masuklah ke
salah satu situs
download,
misalnya
Downloads.
com. Pada
halaman
awalnya Anda
bisa melakukan
pencarian
dengan
memasukkan
kata kuncinya.
Bisa berupa
nama file
tersebut, bisa
juga merupakan
fungsi dari
software
tersebut.
Misalnya:
download
manager. Hasil
pencarian yang sesuai dengan
kata kunci akan ditampilkan.
Makin spesifik kata kuncinya,
makin sedikit dan terarah hasil
yang didapat.

Tetapi selain mencari suatu
file tertentu, Anda juga bisa
“belanja” file lain. Kenapa
disebut belanja, walaupun
sesungguhnya kita tidak
diwajibkan membayar apapun
untuk men-download file?
Karena kegiatannya mirip
dengan kegiatan belanja para
ibu-ibu muda di mal, lihat kiri
lihat kanan, ketemu barang-
barang yang bagus, lalu hap!
Barang diambil.

Karena pada situs-situs
download selalu ada preview dari
file baru yang bagus dan unik
sehingga walaupun sebetulnya
tujuan kita hanyalah mencari dan
men-download 1-2 file saja,
akhirnya kita akan “kalap” dan
men-download lebih dari itu.
Apalagi jika koneksi Internet
yang digunakan tidak terbatas...

Ada beragam kategori
software di sana mulai dari
update bagi software yang sudah
Anda miliki, program pengolah
gambar terbaru, utilitas untuk
meningkatkan kinerja komputer,
browser, screensaver, pemutar
MP3, DVD player, apa saja. Untuk
yang maniak game, hati-hati dan

Download Accelerator Plus, perangkat lunak
download yang populer.

Kazaa Lite K++, yang lebih aman.

tahan diri ya!
Bagi yang bingung dengan

begitu banyaknya pilihan,
kenapa tidak menggunakan
daftar New Releases dan
Most Popular? Disini diberikan
file apa yang terbaru dan file
mana yang paling sering di-
download. Gunakan sistem file
rating sebagai referensi, file
dengan lebih banyak bintang
(atau simbol lain seperti “sapi”
pada Tucows) artinya kinerja

dan antarmuka-nya lebih baik.
Setelah menemukan apa

yang Anda inginkan, klik saja
link download-nya dan biarkan
semua berjalan sebagaimana
mestinya.

MENGINSTAL SOFTWARE
Setelah file selesai di-

download, langkah berikutnya
adalah menginstalnya. Sebagian
besar file akan mempunyai
ekstensi EXE atau ZIP. File
dengan akhiran exe akan
secara otomatis membuka
program installer begitu Anda
mengkliknya dua kali, dan Anda
hanya perlu mengikuti langkah-
langkah yang ditunjukkan oleh
wizard yang muncul sampai
dengan program terinstal.

Sedangkan file dengan
akhiran zip adalah file yang
dikompres untuk
meminimalkan ukurannya.
Anda memerlukan bantuan
program tambahan seperti
WinZip atau WinRAR untuk
bisa membukanya. Di dalam file
zip tersebut akan ada file
installer-nya. Biasanya namanya
adalah setup.exe atau
install.exe. Klik dua kali file
tersebut untuk melakukan
proses instalasi.

Lalu, tunggu apa lagi? Mari
kita men-download! PC+

Tampilan Situs Downloads.com
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Pertimbangan Penting
Pilih Web Hosting

Ketika situs Web telah
selesai dibuat, tibalah

saatnya untuk
dipajang di Internet.

Etalasenya adalah
server milik penyedia
layanan Web hosting.

Semua file yang
berkaitan dengan

situs Web dititipkan
ke situ. Bisa gratis,

bisa pula tidak.

enyedia
layanan Web
hosting, baik
yang gratis maupun

yang komersil, sangat banyak
dan menawarkan berbagai
kapasitas, fasilitas, dan biaya
(khusus yang berbiaya) yang
bervariasi. Perlu pintar-pintar
memilih di mana situs Web di-
upload. Bagaimana memilihnya?

SECARA UMUM
Situs yang selalu lambat

kalau diakses atau seringkali
down akan ditinggalkan
pengunjungnya. Kecepatan
diaksesnya suatu situs
dipengaruhi berbagai hal yang
salah satunya adalah tempat
Web hosting. Jika Web hosting
tempat sebuah situs dititipkan
selalu konsisten memberikan
kecepatan yang tidak menge-
cewakan, maka bolehlah dipilih.

Belum lama berselang,
seorang rekan redaksi bertanya
tempat gratis yang paling cocok
untuk meng-upload situs yang
berisi file source, yang
ukurannya besar untuk Internet,
dari rubrik plusTutorial. Tempat
yang paling cocok untuk kasus
ini tentu saja Web hosting yang
menyediakan kapasitas besar.
Memang, yang gratis menye-
diakan kapasitas yang lebih
terbatas dibandingkan dengan
yang komersil. Namun demikian,
ada persaingan antar penyedia
layanan gratisan untuk menye-
diakan kapasitas yang gemuk.

Hati-hati pula terhadap
rayuan unlimited space
(kapasitas tanpa batas) yang
seringkali dituliskan di iklan Web
hosting komersil. Unlimited yang
tertera di iklan itu hanya rayuan
gombal. Biasanya, unlimited
space ini dijelaskan lebih lanjut
di bagian term and condition. Di
situ barulah dijelaskan bahwa
tidak terbatas selama masih
dibawah 30GB, misalnya. Pada
saat kapasitas file melebihi
kapasitas yang disediakan,
pemilik situs tidak diberikan
informasi. Namun sekonyong-
konyong, tagihan yang
membumbung tiba di meja.
Apakah ini yang namanya

unlimited?
Ada tidaknya script di dalam

suatu halaman situs turut
menentukan pemilihan tempat
Web hosting. Tidak semua tempat
Web hosting kompatibel dengan
script seperti CGI atau PHP. Jadi,
perhatikan script apa saja yang
mampu mereka layani. Beberapa
Web hosting yang bukan gratisan
ada yang menyediakan layanan
untuk mengganti pesan error dan
mencegah pencurian bandwidth.

YANG  GRATIS
Situs Web sederhana yang

dibuat secara iseng-iseng dengan
budget yang sederhana pula
cocok di-upload di Web hosting
gratisan. Karena banyaknya
penyedia layanan gratisan dengan
berbagai variasi fasilitas, PCplus
membeberkan beberapa hal yang
perlu diperhatikan dalam memilih
Web hosting gratisan.

Kalau pengusaha Web
hosting gratisan tidak menarik
biaya dari konsumennya, dari
mana ia memperoleh uang?
Jawabnya: iklan. Situs Web yang
di-upload di situ, pada saat
diakses, akan didampingi iklan.
Iklannya bisa berupa banner yang
ditambahkan di halaman situs,
berupa pop-up window, atau
bahkan berupa frame tambahan.
Tentu saja, semakin sedikit iklan,
semakin nyaman sebuah situs
dijelajahi.

Tidak hanya kapasitas yang
dibutuhkan untuk meng-upload
situs milik redaksi pengasuh rubrik
plusTutorial itu, pembatasan tipe
file dan ukuran yang ditawarkan
pun harus diperhatikan. Beberapa
Web hosting gratisan melarang
beberapa tipe file dan membatasi
ukuran sebuah file yang dapat di-
upload. Contoh pelarangan tipe
file adalah pelarangan terhadap
file ber-extension EXE untuk
mencegah penyebaran virus.
Sedangkan pembatasan ukuran
file biasanya ditujukan demi
lancarnya lalu lintas di situs yang
bersangkutan.

Kemudahan dalam meng-
upload file situs dapat diperoleh
dengan menggunakan FTP.
Dengan bantuan software FTP,
manajemen file lebih teratur.
Bahkan, waktu peng-upload-an
bisa lebih singkat dengan
menggunakan software FTP
apabila dibandingkan dengan
meng-upload langsung dari situs.

Ada kalanya setelah
beberapa kali diakses situs Web
yang sudah di-upload mendadak
down. Berkali-kali diakses dalam
waktu yang berbeda pun tetap
saja down. Apa yang terjadi?
Mungkin saja ada pembatasan
traffic yang dapat digunakan
selama satu hari atau satu bulan.
Jadi, setelah traffic mencapai
batas maksimum, secara otomatis
si penyedia layanan untuk

sementara menutup situs Web.
Esok atau bulan depan mungkin
baru bisa diakses kembali.

YANG KOMERSIL
Situs Web yang serius, agar

lebih meyakinkan, biasanya di-
upload di Web hosting berbiaya.
Dan biasanya, Web hosting ini
menawarkan berbagai
keuntungan yang lebih banyak
dibandingkan dengan Web
hosting gratisan.

Jangan cepat percaya jika ada
iklan Web hosting yang
menawarkan unlimited band-
width. Kasus ini hampir sama
dengan unlimited space. Pemilik
Web hosting harus membayar
bandwidth, jadi hampir tidak
mungkin mereka mau
menanggung biaya untuk
bandwidth. Contohnya, term and
condition menyebutkan bahwa
dalam satu bulan situs memiliki
unlimited bandwidth selama
traffic-nya kurang dari 30GB.
Lewat dari itu, dikenai biaya
sekian dolar per MB-nya.

Salah satu keuntungan yang
paling membedakan web hosting
berbiaya dari yang gratis adalah
adanya technical support. Yang
perlu diperhatikan adalah
bagaimana technical support
mereka mampu memuaskan
pelanggannya. Misalnya, dengan
menawarkan layanan ini selama
24 jam sehari, 7 jam seminggu,
365 hari setahun.

Karena situs yang di-upload
di web hosting jenis ini adalah
situs-situs serius, seperti e-
commerce, maka fasilitas-fasilitas
seperti SSL, MySQL, dan shopping
cart perlu ditambahkan. Dan
biasanya, untuk fasilitas-fasilitas
ini dibutuhkan biaya khusus.

Agar keren, biasanya pemilik
situs meminta alamat e-mail sesuai
dengan domain yang sudah

dibuat. Misalnya pemilik situs
www.alexpangestu.com ingin
memiliki e-mail dengan alamat
admin@alexpangestu.com. Jumlah
serta kapasitas e-mail yang
diperoleh bisa menjadi bahan
pertimbangan. Yang masih
berhubungan dengan e-mail
adalah autoresponders (yang
dapat menjawab e-mail secara
otomatis), POP3 (agar e-mail
kompatibel dengan software
penerima e-mail), dan mail
forwarding (agar e-mail dapat di-
forward ke e-mail yang sekarang
dimiliki).

Kebanyakan Web host
berbiaya menyediakan fasilitas
untuk mengatur berbagai macam
aspek dari account yang dimiliki.
Pada dasarnya hal-hal yang dapat
dilakukan dari fasilitas ini adalah
menambah, menghapus, dan
mengatur alamat e-mail, serta
mengganti password. Fasilitas
dasar lainnya adalah me-mainte-
nance isi  situs seperti menambah
atau mengurangi file, meng-
update isi situs, dan mengganti
file.

Sebuah situs bisa memiliki
subdomain. Fungsinya adalah agar
seorang pemilik situs bisa memiliki
alamat lain dari domain miliknya.
Lihat bagaimana tarif untuk mem-
peroleh subdomain. Tarif untuk
subdomain bisa berupa tarif sekali
bayar, sebulan sekali, setahun
sekali, dan jangka waktu lainnya.

Sistem operasi yang
digunakan oleh Web hosting
server bisa pula menjadi bahan
pertimbangan. Jika sebuah situs
menggunakan ASP, mau tidak
mau situs di-upload di Web
hosting yang ditopang oleh
Windows NT/2000/XP/Server 2003.
Namun, apabila situs
menggunakan PHP yang lebih
portable, menggunakan server
yang ditopang oleh UNIX perlu

diperhatikan. Berbagai fasilitas
untuk memproteksi gambar,
memblok alamat IP, pengubahan
halaman error, dan lainnya dapat
diperoleh tanpa meminta ijin
dari tempat Web hosting.

Yang paling sering ditanya
mungkin adalah masalah harga.
Berapa harga sewa tempat
selama satu tahun? Cocokkah
dengan fasilitas serta layanan
yang diberikan? Bagaimana
pembayarannya?

Pada Web hosting gratisan,
para pemilik situs tidak bisa
mengklaim apa-apa jika suatu
saat tempat mereka meng-
upload tiba-tiba down. Namun
Web hosting yang tidak gratis
biasanya menawarkan refund
atau discount pada saat server
mereka down dan mengakibat-
kan situs yang di-upload di sana
tidak dapat diakses. Besarnya
refund atau discount tergantung
dari lamanya down.

Jaga gengsi dengan meng-
upload situs di layanan yang
berasal dari luar negeri? Jangan.
Upload situs lebih baik dilakukan
di layanan dalam negeri. Selain
kemudahan dalam berkonsultasi
dengan technical support, traffic
Internet tidak lari ke luar negeri.
Secara tidak langsung,
membantu agar devisa tidak
kabur ke luar negeri.

LALU BAGAIMANA?
Mungkinkah semua fasilitas

lengkap dimiliki oleh sebuah
Web hosting? Mungkin saja, tapi
jarang. Namun demikian,
pemilihan Web hosting bisa
diefisienkan dengan cara
menyesuaikan dengan situs yang
dibuat. Apa saja yang
dibutuhkan oleh situs, itulah
yang menjadi bahan
pertimbangan dalam memilih
layanan Web hosting. PC+
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F.X. Bambang Irawan
fbi@e-pcplus.com Panduan Belanja Ponsel

Tahun 2004 (Bagian-1)

V

Belanja ponsel
memang harus cerdas.

Salah pilih akan bisa
bikin kesal karena
merasa ponselnya
“loyo”. Sebab itu,

cermati dulu
spesifikasi ponsel

yang kita lirik untuk
dibeli.

endor ponsel
mati-matian
menyediakan ponsel
yang sesuai dengan

kebutuhan hidup kita. Fitur-
fitur dipasang pada ponsel
sesuai dengan dinamika dan
gaya hidup suatu kelompok
tertentu dengan kebutuhan
tertentu. Apa saja kebutuhan
berponsel kita? Tentukan
sendiri dengan memilih
beberapa item teknologi dan
fitur yang diusung ponsel-
ponsel masa kini berikut ini.

BATERAI
Banyak orang tidak

mempertimbangkan soal jenis
atau ketahanan baterai yang
dipasang pada ponsel yang
mereka beli. Bisa dimaklumi,
karena tidaklah mungkin
mereka menguji ketahanan
baterai ketika menimang-
nimang ponsel idaman di depan
penjualnya. Mereka Cuma
punya waktu beberapa menit
untuk itu.

Masalah baterai umumnya
baru muncul jauh sesudah
ponsel menyertai gerak langkah
si empunya. Setelah lama, baru
orang sadar bahwa baterai
ponselnya loyo, tidak tahan
lama, atau malah suka drop.
Meski ada juga yang cukup puas
dengan ketahanan baterainya.

Baterai yang digunakan
oleh ponsel-ponsel terbaru
umumnya adalah Lithium-Ion
(Li-Ion). Baterai Li-Ion
menggantikan baterai Ni-MH.
Jenis ini populer karena lebih
ringan dan kompak, tidak
mempunyai “memory effect”
dan tingkat “self discharge”-nya
rendah.

Yang lebih baru adalah

Lithium Polymer. Baterai ini sama
dengan Li-Ion, hanya
kapasitasnya dua kali lebih
banyak. Namun sayang, Li-
Polymer belum banyak
diaplikasikan karena harganya
masih mahal.

Daya tahan baterai yang
diklaim oleh vendor ponsel saat
ini dikategorikan menjadi dua:
daya tahan untuk standby
(standby time) dan daya tahan
untuk bicara (talk time). Rata-
rata talktime adalah 4 jam,
sedang standby time sekitar 300
jam.

DIMENSI/BOBOT
Dengan makin tingginya

nilai desain dan fashion sebuah
ponsel, maka ponsel yang
ramping adalah pilihan utama
pembuat ponsel saat ini. Bahkan
ada ponsel yang sengaja
diproduksi dengan memberi
bobot yang sangat besar
terhadap nilai estetika.
Contohnya adalah ponsel-ponsel
seri Xelibri produksi Siemens.

Ponsel-ponsel terkini

umumnya mempunyai panjang
yang tak lebih dari sepuluh
centimeter. Itu artinya hanya
lebih panjang sedikit
dibandingkan kartu nama.
Sedang lebarnya antara 4 sampai
4,5 centimeter. Bobot ponsel

lebih beragam, yaitu umumnya
antara 70-100 gram, meski
karena tuntutan desain bobotnya
ada yang mencapai dua kali
bobot itu.

HARGA
Soal harga memang sangat

relatif. Namun, sebuah ponsel
baru yang berharga 600 ribuan
hampir bisa dibilang murah
secara absolut. Apalagi jika
mengingat bahwa mengajukan
permohonan pemasangan
telepon fixed susahnya bukan
main.

Ponsel-ponsel baru yang
dipasarkan di tanah air memang
banyak mengakomodasi pasar
low end sehingga biasanya
mereka meluncurkan dua atau
tiga produk baru dari kelas mahal
dan kelas murah yang (hampir)

berbarengan untuk
mempertahankan penguasaan
pasar.

Kelas low end umumnya
hanya diberi fasilitas basic untuk
menelepon dan SMS saja. Namun
ada juga yang memberi
kemewahan dalam hal warna
atau polifonik. Masing-masing
vendor punya andalan untuk
kelas low end. Untuk ponsel yang
harga barunya di bawah 1 juta,
Nokia punya Nokia 1100, dan
2100. Sony Ericsson memasang
T100 dan T105. Siemens
mengunggulkan A55, C55, dan
M50.Samsung dengan SGH-N500
dan SGH-R220. Philips
mengedepankan Fisio 625.
Motorola mengandalkan C300,
C330, T190, dan V66. Alcatel
menyodorkan OT320, OT331,
OT512, dan OT525.

Sedang ponsel-ponsel kelas
atas umumnya merupakan ponsel
yang pintar (smartphone) atau
dirancang dengan
mengutamakan kemewahan
bentuk. Di jajaran puncak
terdapat Sony Ericsson P800 dan
P900 (yang merupakan PDA-
phone), Nokia 6600, Samsung
SGH-E700, dan Siemens SX1.

JARINGAN
Operator GSM di sini

umumnya beroperasi pada
frekuensi 900MHz, sedang IM3
menjadi pelopor dengan
beroperasi pada 1800MHz. Untuk
mengatasi perbedaan-perbedaan
frekuensi operasi ini, vendor
ponsel membuat ponsel mereka
bisa beroperasi pada sebanyak
mungkin jaringan dengan
memberi kapabilitas tri-band pada
ponsel-ponsel terbaru dan yang
disasarkan untuk kelas menengah.

Namun mulai tahun 2003 lalu
kita juga diberi pilihan untuk
menggunakan teknologi seluler
lain selain GSM, yaitu CDMA.
Bahkan sampai akhir tahun lalu,
kita sudah disodori dengan tiga

operator CDMA baru, yaitu
TelkomFlexi, Esia, dan Mobile-8.
Mobile-8 malah sudah
mengusung teknologi CDMA
2000 1x EV-DO yang
memungkinkan transfer data
multimedia berlangsung dengan
kilat.

Ponsel-ponsel untuk CDMA
pun sudah bermunculan di pasar
Indonesia. Nokia, Samsung, dan
Sanex adalah nama-nama yang
bertarung memerebutkan pasar
yang mulai tumbuh ini.

KAMERA
Ponsel kamera mungkin

merupakan fitur yang paling
fenomenal tahun lalu. Ponsel
yang dilengkapi dengan alat
memotret momen laris seperti
permen. Camera-phone yang
menonjol tahun 2003 adalah
Nokia 3650, Nokia 7650, dan
Samsung SGH-V200c.

Pengguna memilih kamera
berponsel umumnya karena
alasan fun. Dengan alat ini jadi
seakan mempunyai kamera yang
terus bisa ditenteng ke mana
pergi. Unsur fun ditunjang juga
oleh teknologi MMS untuk
mengirim gambar hasil jepretan
ke ponsel lain atau melalui e-
mail.

Seperti halnya pada kamera
digital, setidaknya ada dua
teknologi utama sensor gambar
yang diadopsi oleh vendor
ponsel berkamera. Untuk kelas
low end umumnya dipasangi
sensor jenis CCD (Charge Couple
Device) yang mampu
menyuguhkan format CIF
(Command Image Format)
dengan resolusi 160x128 sampai
288 pixel. Sedang untuk kamera
berponsel yang lebih mahal
umumnya dipasangi sensor jenis
CMOS (Complementary Metal
Oxide Semiconductor). Sensor ini
pada kamera ponsel mampu
menghasilkan resolusi VGA,
yaitu 480x640 pixel. PC+

Pedagang ponsel menawarkan seribu satu macam ponsel, silakan pilih
sesuai dengan kebutuhan.
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Alois Wisnuhardana
wisnu@e-pcplus.com Software Tambahan untuk Tingkatkan

Kemampuan Prosesor Intel Itanium

S

Intel tampaknya
masih setia pada

arsitektur komputer
32-bit. Pertengahan
Januari lalu, raksasa

semikonduktor ini
mengumumkan

ketersediaan soft-
ware IA-32 Execution

Layer (EL) untuk
sistem-sistem berbasis

prosesor Intel
Itanium-2 dengan
operating system

Microsoft Windows.
Sebuah kesetiaan

yang cerdas?

oftware
tersebut
memberikan
fleksibilitas yang lebih

besar bagi pelanggan, dengan
meningkatkan kinerja aplikasi-
aplikasi software 32-bit dan
memudahkan pelanggan dalam
melakukan migrasi ke platform
berbasis Itanium berbasis OS
Microsoft Windows.

“Meskipun para chief
information officer (CIO)
umumnya lebih memerlukan fitur
keandalan, skalabilitas, kinerja
kelas dunia dan pemenuhan
kebutuhan memori, beberapa di
antara mereka tetap berharap
dapat menjalankan aplikasi 32-bit.
Teknologi ini dapat meningkatkan
kemampuan tersebut tanpa
mengorbankan tujuan
utamanya,” ungkap Mike Fister,
Senior Vice President dan General
Manager Enterprise Platforms
Group dari Intel. “Meskipun
prosesor-prosesor berbasis
arsitektur Itanium selalu
mendukung aplikasi-aplikasi 32-
bit, pendekatan baru ini akan
meningkatkan kinerja dan
memberikan fleksibilitas yang
lebih besar untuk pembaruan dan
skalabilitas di masa depan.”

Dukungan IA-32 EL diberikan
pada Windows Server Enterprise
Edition untuk sistem berbasis
arsitektur Itanium 64-bit, Windows
Server 2003 Datacenter Edition
untuk sistem berbasis arsitektur
Itanium 64-bit dan Windows XP
64-bit Edition. Software tersebut
tersedia akan tersedia dalam
Microsoft Windows Server 2003
Service Pack 1 yang dirilis pada
semester kedua tahun ini dan bisa
diunduh langsung dari situs
Microsoft.

Langkah ini tampaknya kian
mengukuhkan dominasi duet
Windows-Intel (Wintel) yang telah
bertahun-tahun menguasai
belantara bisnis komputer desktop
maupun server di seluruh dunia.
“Microsoft telah bekerja sama
dengan Intel untuk menghadirkan
Execution Layer IA-32 bagi para
pengguna Windows yang
menjalankan sistem Intel Itanium
2,” kata Bob Muglian, Senior Vice
President, Windows Server
Division, Microsoft Corporation.
Bob menambahkan, “Peningkatan
yang diberikan EL akan sangat
membantu pengguna yang lebih
banyak menjalankan aplikasi 64-
bit, tetapi masih perlu

menjalankan software pendukung
32-bit. Peningkatan kemampuan
tersebut akan membantu
pelanggan dalam pengambilan
keputusan menggunakan Windows
64-bit untuk kebutuhan komputasi
enterprise yang integral.”

IA-32 EL sendiri merupakan
suatu paket software yang
terintegrasi dengan operating
system. Prosesor Itanium 2
menyediakan dukungan bagi
aplikasi-aplikasi 32-bit yang

menggunakan hardware pada chip
prosesor (on-die hardware).
Meskipun demikian, dengan IA-32
EL, dukungan untuk aplikasi IA-32
akan dijalankan di dalam software.
Setelah instalasi, eksekusi aplikasi
32-bit akan secara transparan
berjalan menggunakan IA-32 EL.
Pada saat berjalan, IA-32 Layer
Execution akan menerjemahkan
instruksi program aplikasi IA-32 ke
dalam instruksi spesifik (native code)
arsitektur Itanium  dan

memungkinkannya berjalan sebagai
native code.

Prosesor Intel Itanium 2
mengandalkan kinerja terbaik dan
didukung oleh lebih dari seribu
aplikasi. Dalam satu tahun terakhir,
pelanggan yang pembeli sistem
berbasis arsitektur Itanium lebih
banyak dari kalangan pelanggan
enterprise setelah sebelumnya
arsitektur ini lebih banyak diguna-
kan oleh kalangan pengguna
komputasi berkinerja tinggi/ilmiah.

Prosesor Itanium 2 sudah
diimplementasikan secara luas di
instalasi-instalasi enterprise
komersial, meliputi Bell Canada,
CBS Broadcasting, CFE, Chevron
Texaco, CitiStreet, CAN, CompUSA,
Cox Communications, Eckerd Drug,
The Firt American Company, First
Trust, Fortis Health, Fuji Film, ING,
Jet Blue Airways, Metro AG,
Raymond James, Sabre Holdings,
SK Telecom, Telecom Italia, Philips-
Van Heusen dan Wells Fargo.  PC+



plusTrik V • 20 - 26 Januari 2004
PCplus 159

10 |

Windows XP: Menghilangkan Tombol
Turn Off Computer di Welcome Screen

Windows XP:
Memunculkan Icon Control Panel

di My Computer

Pengaturan PlacesBar pada
Windows XP

Windows XP yang kini sudah berumur kurang-lebih dua tahun ini memiliki keunggulan multiuser
yang lebih tangguh dibandingkan dengan pendahulunya. Dengan fitur ini pengguna dapat
menggunakan komputer bersama-sama dengan user yang lain dengan personalisasi pada masing masing
account. Pengguna juga dapat mengatur account-nya sesuai dengan selera dan kebutuhannya.

Agar masing-masing user dapat menggunakan komputer dan masuk ke account-nya, sang user harus
memilih user ID-nya di Welcome Screen kemudian memasukkan password. Setelah prosedur ini
terlewati, hampir bisa dipastikan orang yang menggunakan komputer tersebut benar memiliki hak atas
penggunaan komputer. Sekarang user ini bisa melakukan apapun sesuai dengan hak aksesnya, termasuk
urusan men-shut down komputer.

Untuk mengatur shut down di masing-masing user tidak ada kesulitan. PCplus pun pernah
membahasnya. Masalahnya terdapat di Welcome Screen. Di sana terdapat sebuah tombol [Turn Off

Computer] pada bagian kiri bawah layar yang berfungsi untuk men-shut down komputer. Apabila Anda
cukup peka terhadap pengaturan mengenai hak shut down di komputer, tombol ini cukup mengganggu
rule Anda tersebut. Agar masalah ini dapat teratasi Anda harus menonaktifkan tombol [Turn Off] melalui
registry. Berikut ini caranya:
1. Klik [Start]>[Run…] kemudian ketik regedt32.exe.
2. Masuklah ke subkey

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\policies\system
3. Carilah DWORD value yang bernama shutdownwithoutlogon dibagian kanan window kemudian

klik dua kali entry tersebut.
4. Ubahlah value datanya yang sebelumnya bernilai 1 menjadi bernilai 0.
5. Tutup Registry Editor kemudian restart Windows Anda.

Ingat, sebelum mengaplikasikan trik ini Anda harus melakukan back-up terhadap registry, agar Anda
dapat kembali ke setting sebelumnya dengan mudah.

Steven Andy Pascal
steven@e-pcplus.com

Masih ingat menu My Computer di Windows 95 dan Windows 98? Kala itu
Anda dapat mengakses Control Panel yang berada di My Computer dengan
mengklik ikonnya. Sekarang (di Windows XP) ikon tersebut sudah tidak ada lagi. Ikon
[Control Panel] telah dihapuskan dan diganti dengan menu Change a setting yang
diletakkan di task pane.

Nah bagi Anda yang ingin “mengembalikan” ikon [Control Panel] di My Com-
puter seperti di Windows 95/98, Anda dapat memasangnya dengan cara:
1. Jalankan Windows Explorer atau My Computer.
2. Setelah salah satu aplikasi tadi terbuka, tekan [Tools]>[Folder Options...].
3. Klik tab [View] pada box Folder Options yang muncul.
4. Carilah checkbox [Show Control

Panel in My Computer] yang berada
di bagian Advanced settings.

5. Berikan tanda centang pada checkbox
tersebut, kemudian klik [OK] untuk
menutup box Folder Options.
Setelah Anda mengklik tombol [OK],

sekarang Anda perhatikan pada window
My Computer. Disana akan muncul
sebuah icon baru dengan nama Control
Panel yang akan me-link ke Control
Panel yang sebenarnya jika Anda klik.

Untuk mengembalikan ke setting
default Windows XP, Anda dapat
menghilangkan tanda cek pada checkbox
[Show Control Panel in My Computer].
Selamat mencoba.

Steven Andy Pascal
steven@e-pcplus.com

Ketika kita menjalankan Open atau Save as pada aplikasi-aplikasi Windows,
kita akan menjumpai suatu kotak dialog yang di dalamnya juga terdapat PlacesBar.
Secara default, PlacesBar berisi My Recent Documents, Desktop, My Documents,
My Computer dan Network place. Tahukah Anda bahwa sebenarnya kita dapat
mengatur PlacesBar ini? Pengaturan ini dapat berupa penyembunyian place bar atau
juga mengganti isinya dengan yang sesuai dengan kebutuhan Anda. Tentunya dengan
isi PlacesBar yang tepat akan mempercepat kerja Anda.
1. MENYEMBUNYIKAN PLACEBAR
Bila Anda merasa tidak begitu memerlukan PlaceBar, maka cobalah untuk

menyembunyikannya. Berikut caranya:
1. Jalankan Registry Editor yaitu dengan mengetikkan regedit pada [Start]>[Run].
2. Masuklah ke key HKEY_CURRENT_USER\Software\Microsoft\ Windows\

CurrentVersion\Policies\comdlg32.
3. Buatlah data DWORD dengan nama NoPlacesBar.
4. Klik ganda data tersebut dan isikan nilainya dengan 1.
Untuk menampilkannya kembali, Anda cukup mengganti nilainya menjadi 0 atau

menghapus data tersebut.
2. MENGGANTI ISI PLACESBAR

Untuk mengganti isi PlacesBar, caranya cukup mudah.
1. Masuklah ke key seperti di atas, kemudian buatlah subkey baru dengan nama

PlacesBar.
2. Pada subkey tersebut, buatlah data string dengan nama PlaceX dimana X adalah

urutan yang diinginkan, dimulai dari 0.
3. Klik ganda data tersebut kemudian isikan nilainya dengan path (lokasi) folder yang

Anda inginkan, misalnya D:\Documents\Digital Library
Mulailah dengan nama data Place0, kemudian jika ingin ditambah, buat data

baru dengan nama place1, place2, place3, dan seterusnya. Untuk melihat hasilnya,
silakan jalankan [Open]

atau [Save as] dari
sebarang aplikasi
Windows, misalnya
Notepad. Untuk
pengaturan nomer 2,
cara mengembalikan ke
PlacesBar default, cukup
dengan menghapus key
di mana Anda membuat
data-data tersebut.
Selamat mencoba.

Rizki Kurniawan
rizki.kurniawan.132
@students.itb.ac.id

Banner di Kotak
MS-DOS Prompt

Jika Anda bosan dengan penampilan MS-DOS yang standar
dan ingin mempercantik kotak MS-DOS Prompt dengan menambah-
kan banner berwarna yang menarik? Ikutilah tahapannya berikut ini:
1. Klik tombol [Start]>[Run], ketikkan Sysedit, lalu klik [OK]

untuk memanggil aplikasi System Editor.
2. Tambahkan baris berikut ini ke dalam file Config.sys:

Device=C:\Windows\Command\Ansi.sys
3. Tambahkan baris berikut ini ke dalam file Autoexec.bat:

SET WINPMT=$e[s$e[f$e[0;30;46m$e[K Mode DOS dalam
Windows $e[16CAlt+Tab to switch; type EXIT to
close$_$e[0;40;37;1m$e[K$e[u$P$G
Pastikan seluruhnya Anda ketikkan dalam satu baris memanjang.

4. Tutup System Editor dan pastikan untuk menyimpan semua
perubahan yang telah Anda lakukan. Selanjutnya boot ulang
Windows Anda.

Sekarang coba buka kotak MS–DOS Prompt. Akan terlihat ban-
ner berwarna biru di baris teratas kotak tersebut. Bila Anda tekan
[Alt]+[Enter], maka tampilan MS-DOS Prompt akan berpindah ke
layar penuh, sementara banner tetap berada di tempatnya.

Surya Arin Kusuma
suryarin@yahoo.com
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Memanfaatkan Sebarang
Teks Contoh dalam Word

Mengubah Teks Tombol Start
Windows XP Lebih dari 5 Huruf

Ada banyak alasan
mengapa orang harus membuat
sebarang teks contoh (dummy
text) dalam Word.  Bagi pemula,
ini akan menjadi alat eksperi-
men untuk mengeksplorasi
semua fitur dalam Word. Bagi
para pengajar, ini akan menjadi
alat peraga cepat untuk memu-
dahkan penyampaian materi.
Atau bagi para expert, teks con-
toh sering digunakan untuk me-
lihat bagaimana skrip VBA atau
macro editing yang dibuatnya
bekerja dan berkinerja.

Satu cara cepat yang tidak
terdokumentasi dalam Help
untuk membuat teks contoh
adalah mengetik: =rand() pada
baris baru, tabel, header/footer
atau text-box. Setelah Anda
[Enter], perintah ini akan me-
nulis 3 alinea dengan 5 kalimat
berbunyi The quick brown fox
jumps over the lazy dog.

Untuk sekadar mencoba
setting paragraf misalnya, teks
contoh di atas tentu sudah
memadai. Atau, masih kurang
banyak buat Anda? Coba
sisipkan parameter dengan
mengetik: =rand(10).  Setelah
[Enter], akan terlihat 10 alinea
dengan 5 kalimat sampel yang
dibuatkan Word.  Dan kalau

masih kurang juga lengkapi
parameternya menjadi:
=rand(10,8).  Anda akan segera
melihat 10 alinea dengan 8
kalimat sampel. Angka 10 dan 8
di atas hanyalah contoh nilai
parameter. Anda dapat mengisi
nilai parameter di dalam kurung
dengan bilangan bulat dalam
range 1 sampai 200.  Maksimal
kalimat juga dibatasi sampai
19.800 buah.  Dari kedua batasan
itu kita dapat simpulkan bahwa
maksimal angka dalam kurung
untuk formula dengan 1 param-
eter adalah (200) yang mengha-
silkan kurang lebih 14 halaman
Letter dengan setting default,
dan kombinasi angka maksimal
untuk formula dengan 2 param-
eter adalah (200,99) atau
(99,200) yang akan membuat
lebih dari 200 halaman default.

Hal lain yang didapatkan ada-
lah format Paragraph, Font, atau
Style pada teks contoh ini akan
mengikuti apa yang sudah terfor-
mat dalam formula kita. Sehingga
apabila misalnya Anda menekan
[Ctrl]+[B] dan [Ctrl]+[1] sebelum
mengetik formula, teks contoh
yang Anda dapatkan akan berfor-
mat bold dan berspasi baris 2.

Selain untuk membuat
sebarang teks contoh, formula

ampuh ini juga dapat digunakan
untuk pemanfaatan lainnya.
Coba kita lihat suatu hal menarik
dari kalimat sampel yang
dihasilkan. Itu adalah kalimat
yang sering dijadikan sampel
oleh Word berupa kalimat Inggris
yang kita tahu sudah mengan-
dung seluruh huruf alfabet.
Artinya bagi desainer atau siapa
pun yang ingin membandingkan
bentuk seluruh huruf di antara 8
jenis huruf tertentu misalnya, tak
perlu repot mengetik “a,b,…z”
dan copy-paste hingga 8 baris.
Cukup dengan mengetik:
=rand(8,1), [Enter], kemudian
ubah format huruf setiap baris
sesuai dengan jenis huruf yang
akan dibandingkan.

Satu lagi, jika suatu saat
Anda datang terlambat dalam
memenuhi janji kencan dengan
seseorang, dan beliau menghu-
kum Anda dengan memberikan
PR menulis kalimat “Saya kapok
janjian telat” sebanyak 100 buah,
kembangkan “semangat”
formula ini.  Caranya, buka
dokumen baru, ketik:
=rand(1,100) di baris pertama,
[Ctrl]+klik kalimat pertama,
[Ctrl]+[C], [Ctrl]+[H], [Ctrl]+[V],
[backspace] 2X untuk trim atau
membuang spasi, [Tab], ketik:

Saya kapok janjian telat., te-
kan [Alt]+[A] untuk Replace All.

Ya, kasus itu memperlihatkan
bahwa penggunaan formula
yang dilanjutkan dengan Find
and Replace bisa menghasilkan
kata, frase, atau kalimat Anda
sendiri sebanyak yang diinginkan.
Dengan sedikit kreativitas, Anda
bisa gunakan kemungkinan ini
untuk membuat desain yang
membutuhkan patern teks dalam
bidang segi empat, seperti
membuat watermark sertifikat,
corak sampul CDRW Anda, desain
poster, dan lain-lain.

Sebagai catatan, formula ini
bisa dipakai dalam Word 97/2000/
2002/2003.  Karena keampuhan
yang dikemas dalam ketersem-
bunyiannya, banyak yang meng-
klaim bahwa teknik ini merupa-
kan salah satu easter egg dalam

Word. Jika formula ini tidak ber-
jalan, pastikan bahwa Anda
tidak menggunakannya segera
setelah hard page-break ([Ctrl]+

[Enter]) dan column break
([Ctrl]+[Shift]+[Enter]). Pastikan
juga opsi Replace text as you
type pada tab [AutoCorrect]

sudah tercentang (menu [Tools]>
[AutoCorrect Options…]).

Akhirnya, sekadar memu-
dahkan pembaca yang belum
familiar dengan fungsi dalam
Office, ingat kata kunci
RAND(om) untuk menghafal
fungsi pembuat teks sebarang
ini.  Nah pengguna MS Word
yang budiman, selamat mencoba
dan mengurangi pengetikan
“sfdhsjdfhsjfdhsjfhs”.

Patria Susantosa
susantosa@HotPOP.com

Dari yang telah kita
ketahui, tombol [Start] Win-
dows XP bisa diubah dengan
karakter atau teks lain
sepanjang tidak lebih dari 5
huruf, baik diedit melalui
registry maupun lewat DOS.
Tetapi sekarang Anda bisa
mengubah kata “Start” menjadi
“KomputerKu”, “PCPribadi”
atau nama-nama lain sesuai
keinginan Anda. Tentu saja kali
inipun Anda masih harus meng-
edit registry untuk mengubah-
nya. Caranya sebagai berikut:

LANGKAH 1 –
MEMODIFIKASI FILE
EXPLORER.EXE

Kita modifikasi file
explorer.exe yang terletak di
C:\Windows. Karena
explorer.exe merupakan file
binary, kita perlu sebuah editor.
Kali ini kita pakai Resource
Hacker, yang salah satu
fungsinya untuk memodifikasi
file binary. Bila Anda belum
memiliki binary editor lain Anda
bisa dapatkan Resource Hacker
di http://www.users.on.net/

johnson/resourcehacker.
Langkah pertama, lakukan

backup file explorer.exe yang
berada di C:\Windows\
kemudian jalankan Resource
Hacker dan buka explorer.exe.
Pilih [String Table] lalu klik
ganda untuk melihat isi String
Table. Klik ganda lagi pada 37
dan klik sekali pada 1033. Yang
akan kita modifikasi adalah item
578, di sana tertulis “start” yang
merupakan kata pada tombol
[Start]. Lihat Gambar 1.

Ganti kata start sesuai yang
Anda kehendaki tetapi pastikan
tanda kutip tidak hilang. Pastikan

pula Anda tidak menggunakan
spasi. Kemudian simpan dengan
nama explorer[nama].exe di
direktori C:\Windows. Misalnya,
Anda menggantinya dengan
“TjokMirah” maka Anda harus
menyimpannya dengan nama
explorertjokmirah.exe. Lihat
Gambar 2.

LANGKAH 2 –
MEMODIFIKASI REGISTRY

Setelah menyimpan
perubahan di ,atas Anda bisa
keluar dari Resource Hacker.
Langkah berikutnya adalah
memodifikasi registry.

Klik [Start] kemudian
[Run], ketikkan regedit dan
tekan [Enter]. Selanjutnya
masuk ke
HKEY_LOCAL_MACHINE\
SOFTWARE\Microsoft\
Windows NT\CurrentVersion\
Winlogon. Cari string bernama
Shell kemudian klik ganda dan
ganti value data-nya dengan
nama yang tadi Anda simpan.
Akhiri dengan klik [OK] dan
keluar dari Registry Editor.
Untuk melihat hasilnya restart
komputer Anda. Mudah bukan?

Yusuf Sugiyanto
masyusuf@operamail.com

Gambar 1
Gambar 2

Gambar 3
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Mengedit Nilai Tertentu
pada Game

Cakrawala Gintings
cakra@e-pcplus.com

P

Bermain game sering
ditujukan untuk

menghilangkan stres.
Tergantung pada

game yang
dimainkan, tujuan ini

kadang kala bisa tidak
tercapai. Alih-alih

menghilangkan, stres
malah bertambah.

Lalu bagaimana
mengakali supaya

bermain game tetap
menghibur,

menyenangkan, dan
tidak bikin stres?

ada sebagian
game sering terdapat
parameter-parameter
tertentu yang berupa

angka. Angka-angka ini sering
sekali mempengaruhi hasil yang
bisa kita capai. Misalnya angka
yang menunjukkan jumlah uang
yang dimiliki pada banyak game
strategi menentukan banyaknya
unit yang bisa dibangun. Setiap
unit memang memerlukan se-
jumlah uang untuk memben-
tuknya. Keberhasilan seseorang
dalam menyelesaikan suatu misi
sering kali tergantung pada ba-
nyaknya uang yang dimiliki ter-
sebut. Daripada stres terus ka-
rena jumlah uang yang terba-
tas, seseorang bisa melakukan
penipuan dengan mengguna-
kan software tertentu untuk
menaikkan jumlah uang yang
dimiliki tersebut.

EDITOR MEMORI UTAMA
Untuk melakukan penge-

ditan ini, salah satu metode
yang bisa digunakan adalah
melakukan pengeditan pada
memori utama. Selain metoda
pengeditan memori utama,
masih ada metode lain seperti
metode pengeditan save games.

Untuk bisa melakukan pe-
ngeditan pada memori utama
tentunya diperlukan software
yang sesuai. Dua di antaranya
adalah ArtMoney dan TSearch.
Untuk bisa melakukan pengedi-
tan pada memori utama ini, pe-
ngeditan harus dilakukan pada

saat game yang ingin diedit itu
sedang berjalan. Ini wajar meng-
ingat nilai yang ingin diedit itu
harus berada pada memori utama.
Oleh karena itu sistem harus bisa
melakukan pergantian jendela
antara game dengan program
tanpa terjadinya masalah. Biasanya
pada program tersebut juga
diberikan semacam hot key untuk
menampilkan program tersebut.

Menggunakan pengeditan
seperti ini tentunya akan membe-
bani sistem apalagi bila sistem
yang digunakan sudah cukup ber-
umur. Pastikan dulu setting yang
digunakan tidak menyebabkan
sistem menjadi tidak stabil.

Untuk menghemat waktu
dan resources yang digunakan,
jangan mencari angka yang
terlampau umum. Cobalah untuk
mengatur angka yang ingin
diedit menjadi angka yang kecil
kemungkinannya digunakan oleh
game untuk hal lain. Biasanya
angka yang cukup besar nilainya
sudah memadai. Bila angka yang
diinginkan akhirnya sudah
ditemukan, perhatikanlah alamat
yang dimilikinya. Setelah
melakukan save, non aktifkan
game tersebut dan aktifkan
kembali. Cobalah untuk mencari
kembali nilai yang bersangkutan
tadi dan perhatikan kembali
alamatnya. Lakukan hal ini
beberapa kali. Bila ada kesamaan
ataupun ciri dari alamat nilai
yang diedit, gunakanlah
kesamaan ataupun ciri tersebut
untuk menghemat waktu bila
mencari nilai tersebut lain kali.

CARA MENGEDITNYA
Kali ini PCplus menggunakan

software ArtMoney 6.12. Jalan-
kanlah software ini dan kemu-
dian jalankan juga game yang
ingin diedit. Tentukan nilai yang
ingin diedit, sebaiknya jangan
menggunakan nilai yang umum.

Setelah itu berpindahlah ke
ArtMoney, pilihlah program yang

ingin diedit dan lakukanlah pen-
carian dengan menekan tombol
[Search]. Pada saat ditanya,
masukkan nilai yang ingin diubah
tersebut lalu tekanlah [Ok].

Setelah pencarian selesai kem-
balilah ke game tersebut. Ubahlah
nilai yang ingin diedit tersebut (mi-
salnya dengan membeli sesuatu).
Pilih kembali jendela ArtMoney
dan tekanlah tombol [Sieve] lalu
masukkan nilai baru tersebut. Sete-
lah itu tekanlah tombol [Ok] dan
tunggulah hasil yang diperoleh.

Bila alamat yang diperoleh
tinggal sedikit ataupun 1, Anda
bisa mencoba untuk mengedit
nilainya. Lihatlah hasil editan de-
ngan kembali ke game tersebut.

Bila benar seharusnya nilai yang
ingin diedit itu nilainya sudah
berubah seperti yang dimasuk-
kan. Kadang kala perlu dilakukan
kegiatan yang membuat game
menghitung/meng-update para-
meter yang ingin diubah terse-
but. Bila tidak berubah, kembali-
lah ke ArtMoney dan cobalah

untuk mengubah alamat yang
lain. Nilai dari alamat yang
telah diubah sebelumnya itu
sebaiknya dikembalikan ke nilai
aslinya. Lakukan terus hingga
ditemukan alamat yang benar.

Bila alamat yang diperoleh
masih banyak, kembalilah ke
game dan ubah kembali nilai
yang ingin diedit. Setelah itu
lakukan kembali Sieve dengan
menggunakan nilai yang baru.
Lakukan terus hingga alamat
yang diperoleh sedikit ataupun 1.

Satu hal yang harus diingat
adalah bila alamat yang diubah
nilainya adalah alamat yang sa-
lah, game bisa saja menjadi tidak
stabil. Begitu pula bila nilai yang
dimasukkan terlampau tinggi,
game bisa saja menjadi tidak sta-
bil atau nilai yang ditampilkan
pada game menjadi minus. PC+

Aktifkanlah ArtMoney.

Aktifkanlah game yang ingin diedit.
Pilihlah nilai yang tidak begitu umum.

Kembalilah ke ArtMoney dan pilihlah
program yang ingin diedit. Setelah itu
tekanlah tombol Search dan masukkan
nilai tersebut lalu tekanlah Ok.

Kembalilah pada game dan ubah kembali
nilai yang ingin diedit tersebut.

Kembali lagi ke ArtMoney dan tekanlah
tombol Sieve. Masukkan nilai baru
tersebut lalu tekanlah Ok.

Bila alamat yang tersisa tinggal sedikit,
ubahlah nilainya satu-persatu hingga
menemukan alamat yang benar.

1

2

3

4

5

6
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Buat Label CD Sendiri

Salin Strukturnya,
Bukan Isinya

TreeCopy

Multimedia Player Mini
BSPlayer

Apa saja yang biasa
dikoleksi dalam bentuk CD?
Foto, MP3, video clip, dan
berbagai jenis data lainnya.
Memusingkan, kalau CD-CD itu
tidak memiliki label. Akibatnya,
setiap kali hendak mencari data,
waktu yang dibutuhkan cukup
lama. Makanya, lebih baik, CD-
CD itu diberi label. Jangan
tanggung-tanggung, sekalian
saja label itu dibuat menjadi
indah.

Coba download Advanced
CD Label Maker yang berukuran
3.69MB dari
www.all4label.com. Software
yang berfungsi untuk membuat
label CD, juga cover depan dan
cover belakang kotak CD, ini
merupakan software yang
dapat di-download gratis. Versi
gratis ini menghasilkan cap
Advanced CD Label Maker pada
label hasil. Supaya cap

pengganggu ini hilang, Advanced
CD Label Maker harus di-register
dengan uang sebesar USD30.00.

Label yang dibuat dapat
terdiri dari tiga elemen. Elemen-
elemen tersebut adalah layout,
stamp, dan background. Elemen-
elemen itu dapat digunakan
sendiri-sendiri atau sekaligus
pada sebuah label. Misalnya, CD
itu bisa hanya menggunakan
background saja tanpa layout
dan stamp. Akan tetapi, bisa juga
semua elemen itu membentuk
label.

Advanced CD Label Maker
memiliki object properties yang
sangat memudahkan pembuatan
label. Fungsi kotak persegi
panjang yang defaultnya terletak
di layar bagian bawah ini adalah
untuk menentukan berbagai
variabel dari obyek yang dipilih
pada label yang sedang dibuat.
Sebagai contoh, setelah teks yang

ada pada label diklik, dari object
properties isi teks, jenis font,
ukuran font dan variabel lainnya
yang berhubungan dengan teks
bisa ditentukan.

Ada sebuah tool yang sangat
membantu, yaitu tool untuk
membuat teks yang melengkung
mengikuti bentuk CD. Tool ini
bisa diakses dari toolbar yang
terletak di sebelah kanan layar.
Ikonnya bergambar huruf “A”
dengan garis melengkung di
atasnya. Lengkungan teks ini
secara otomatis selalu berubah,
tergantung kepada besarnya
jarak antara teks dengan titik
pusat CD.

Sudah disebutkan kalau
Advanced Label Maker memiliki
background untuk label CD. Ada
26 background yang sudah
ditanamkan di dalam software
ini. Namun demikian, Advanced
Label Maker menyediakan fitur

yang dapat membuat gambar
lain menjadi background label.
Ini mengasyikan, karena label CD
yang dibuat bisa lain daripada
yang lain.

Pada saat menggunakan
gambar lain sebagai background
atau stamp, perlu diperhatikan
bahwa sebaiknya gambar itu
memiliki ukuran file yang kecil.
Pengalaman PCplus pada saat
mengimpor gambar yang file-nya

berukuran besar, kinerja
Advanced CD Label Maker
menjadi sangat lambat. Untuk
membuat background, bentuk
gambar perlu diperhatikan.
Agar tidak mengalami distorsi
alias mencang-mencong,
gambar yang diimpor lebih baik
berbentuk bujur sangkar.

Alex Pangestu
alex@e-pcplus.com

Copy yang lumrah
diketahui oleh orang adalah
menyalin file atau folder dari
satu tempat ke tempat yang
lain. Jika folder di-copy, maka
folder itu beserta isinya akan
tersalin di tempat tujuan,
kecuali tentunya jika folder itu
tidak ada isinya. Jadi, sedikit
repot kalau sebuah folder ingin
di-copy tanpa isinya. Apalagi
kalau folder itu masih memiliki
banyak sub folder yang
mungkin memiliki sub sub
folder lagi. Apakah setiap file di
masing-masing folder harus

dihapus secara manual dengan
membuka folder satu per satu
kemudian menghapus isinya?

Untuk mengatasi kerepotan
sebuah software gratis bernama
TreeCopy dibuat. Freeware ini
dapat digunakan untuk menyalin
struktur direktori (folder) tanpa
mengikutsertakan isinya.

Pada layar utamanya
terdapat dua buah boks yang
menampilkan direktori  yang ada
di dalam hard disk, floppy,
network, CD ROM drive, dan
RAM. Direktori yang ditampilkan
di kedua boks ini bisa diatur.

Dengan demikian,
direktori yang ditampilkan
bisa saja hanya direktori
yang berada di hard disk.
Ini tergantung dari drive
yang dipilih.

Penggunaan TreeCopy,
yang dapat di-download
dari
www.rjlsoftware.com,
sangat sederhana. Untuk
melakukan penyalinan,
pilih saja folder sumber di
boks sebelah kiri dan
folder tujuan di sebelah
kanan. Jika sudah, klik

[Start]. Sreet. Tunggu sebentar,
penyalinan selesai.

Kesederhanaannya yang lain
adalah ukuran file instalasinya
yang cuma 200KB dan juga tidak

perlu instalasi untuk
penggunaannya. Hanya perlu
di-unzip, jalankan file EXE-nya.

Alex Pangestu
alex@e-pcplus.com

Salah satu kemampuan komputer kita adalah untuk multimedia dan salah satunya yaitu
kemampuannya memainkan dan menampilkan video baik itu dari VCD  ataupun dari file-file yang didapat
dari internet. BSPlayer yang bisa didapat di www.bsplayer.org adalah salah satu software yang dapat
memainkan video dan file-file multimedia lainnya.

Setelah Anda mendownload installer BSPlayer yang berukuran 1.66MB, langsung jalankan file itu.
Setelah proses instalasi selesai, jalankan BSPlayer.

BSPlayer memiliki tampilan yang sangat familiar dan memiliki kemampuan yang tidak kalah dengan
multimedia player lain yang sudah terkenal. Lebih seru lagi, BSPlayer dibuat agar mampu menggunakan
skin yang dapat di-download di web site BSPlayer.

BSPlayer memiliki kemampuan yang hebat dalam memainkan banyak format file seperti AVI, MPG,
ASF, DAT, VOB, WMF, MP3, WAV, DivX, ASX, OGM, dan M2V. Dan dapat dikatakan BSPlayer termasuk
program yang irit tempat dan resource sehingga cocok digunakan komputer tanpa hardware dengan
spesifikasi yang tinggi.

Febriadi
febriadi@ilkom-ub.or.id

Advanced CD Label Maker
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Cara Cepat Mengambil
Teks dari Gambar

ABBYY FineReader 7.0 Professional Edition

Semudah Memotong Pisang
Banana Splitter

Pekerjaan menyalin
tulisan yang ada di dalam
sebuah bacaan adalah sebuah
pekerjaan yang sangat lama
dan membosankan. Paling
tidak, begitulah menurut saya.
Namun demikian, jika pekerjaan
tersebut dilakukan dengan
sebuah aplikasi yang bernama
ABBYY FineReader maka
pekerjaan tersebut akan
menjadi cepat dan tanpa perlu
merasa bosan.

ABBYY FineReader adalah
sebuah aplikasi OCR (Optical
Character Recognition), yaitu
aplikasi yang memungkinkan
kita mengambil teks dari
sebuah file image berformat
BMP, JPG, PCX, TIFF, dan PNG.
Hasilnya bisa disimpan dalam
format DOC, RTF, HTML, TXT,
CSV, PDF dan XML. Untuk lebih
jelasnya, Anda bisa mengikuti
langkah-langkah yang
disebutkan berikut.
1. Buku, koran, atau apapun

yang akan Anda salin, di-
scan lebih dulu dengan
menggunakan scanner. Jika
Anda tidak memiliki scanner,
pergilah ke warnet yang

menyewakan scanner, atau
pinjam scanner kawan Anda.
Hasilnya disimpan dalam salah
satu format image yang tadi
sudah disebutkan. Anda, yang
sudah punya scanner, bisa
menggunakan fasilitas scan
yang sudah ada di dalam
ABBYY FineReader.

2. Bukalah file tadi, kemudian,
kalau Anda ingin menyalin
semua teks yang ada di file
tersebut, Anda bisa memilih
opsi [Read All Pages] atau
dengan shortcut
[Ctrl]+[Shift]+[R]. Kalau Anda
hanya ingin mengambil
sebagian teksnya saja,
misalnya Anda hanya ingin
menyalin kolom pertamanya
saja, maka gunakan opsi
[Read] yang shortcut-nya
[Ctrl]+[R]. Jika Anda
menggunakan opsi Read,
maka Anda harus
menentukan dulu area mana
yang akan dibaca teksnya
dengan menggunakan tool
Draw Recognition Area. Cara
penggunaan tool tersebut
sama seperti fasilitas Marquee
pada Photoshop atau fasilitas

Select pada Paint yaitu
dengan cara klik lalu drag.

3. Setelah proses pembacaan
selesai, Anda bisa langsung
melihat teks hasil di window
yang  terletak di sebelah
kanan layar. Teks itu dapat di-
copy-paste, juga dapat
disimpan langsung dalam
format teks.
 Pada saat baru diinstal

untuk pertama kalinya, ABBYY
FineReader hanya bisa mengenali

kata-kata dalam bahasa Inggris.
Namun demikian, seandainya
Anda membeli versi penuhnya
yang seharga USD179,  maka
Anda bisa bisa menginstal
modul pengenalan bahasa
tambahan yang terdiri dari 177
bahasa termasuk bahasa kita,
Indonesia. Tidak hanya itu,
ABBY FineReader bahkan bisa
mengenali bahasa
pemrograman seperti Basic,
Cobol, Fortran, Java, dan rumus-
rumus kimia sederhana.

Versi trial 30 harinya dapat
Anda download di http://
download.abbyy.com/
dengan ukuran file instalasi
yang cukup besar, yaitu 38MB.

Rully Novrianto
roolee@telkom.net

Apakah Anda
memiliki kue black forest
yang ukurannya gede? Kotak
makanan yang Anda miliki
hanya mampu menampung
seperempat kue itu. Ada dua
aksi yang mungkin bakal Anda
lakukan. Yang pertama, hanya
membawa seperempat kue
tersebut. Yang ke dua
masukkan seperempat-
seperempat yang lain ke dalam
tepak-tepak yang lain juga.
Mana yang Anda pilih?

Beranjak dari kue dan
kotaknya, apa yang akan Anda
lakukan jika Anda menyimpan
file yang besar di dalam media
penyimpanan yang terbatas
kapasitasnya? Apakah Anda
akan mengabaikan file tersebut
mengingat media penyimpanan
yang tidak cukup? Tidak!
Penulis akan membantu Anda
untuk menyimpan file yang
besar meskipun media
penyimpanan yang anda miliki
berkapasitas terbatas.

Banana Splitter adalah
suatu program yang dapat
memecah file yang memiliki
ukuran besar. Sebagai contoh,
Anda ingin menyimpan satu file
*.exe yang memiliki ukuran
2MB, sedangkan Anda hanya
memiliki disket yang

berkapasitas 1,44 MB. Dengan
Banana Splitter, Anda dapat
memecah file tersebut menjadi
dua bagian atau lebih.

Pada tab Split File di bagian
Source, masukkan nama file yang
akan Anda pecah-pecah. Pada
kolom Destination, tentukan
folder yang menjadi tujuan file
pecahan tersebut. Selanjutnya,
Anda tentukan ukuran file untuk
masing-masing pecahan, Setelah
Anda menentukan sumber dan
tujuan file serta ukuran untuk
memecahnya, tekan tombol
[Split] untuk memulai
pemecahan file.

Anda tidak perlu khawatir
kalau file yang sudah pecah
tersebut tidak dapat tersambung
kembali. Untuk menyambungnya
pilih tab Merge/Verify. Sama
seperti pada saat Anda memecah
file, tentukan sumber dan tujuan
file. Selanjutnya tekan tombol
[Merge].

Kelebihan lain yang dimiliki
oleh software ini adalah
kemampuannya untuk
mengenkripsi dan mendekrispi
file. Tujuan dari enkripsi file
adalah untuk melindungi data
dari gangguan orang yang tak
berhak melihat data itu.

Kalau Anda tertarik untuk
memiliki software yang memiliki

masa percobaan selama 30 hari
ini, Anda bisa men-download
gratis installer-nya yang
berukuran 725 KB dari
www.pobox.com. Kalau Anda
sekiranya tertarik untuk memiliki

lebih lama, siapkan kocek
sebesar US$ 15 untuk biaya
registrasi.

Andi Pramono
kompunet@telkom.net



plusFokus V • 20 - 26 Januari 2004
PCplus 159

16 |

Tiga Jurus
‘tuk Punya Situs

Alex Pangestu
alex@e-pcplus.com

F

“Web site pribadinya
apa sih, Mas?” tanya

seorang kepada
Suryanto. “Nih,

www.geocities.com/
surjason,” Suryanto
menjawab dengan

bangga walau meng-
host situsnya di server
gratisan. Bayangkan,
betapa lebih bangga-
nya kalau suatu saat

Restituta Ajeng Arjanti
ajeng@e-pcplus.com

Steven Andi Pascal
steven@e-pcplus.com

nanti ia memiliki
www.surjason.com.

okus kali ini
tidak membahas teknik
membuat situs Web,
namun membahas cara

membuat situs Web kita mejeng
di Internet. Ada 3 cara yang

disajikan, yaitu membuat situs
Web dari layanan Web hosting
yang sudah menyediakan
template, Web hosting untuk
meng-upload situs yang sudah
jadi, dan meng-upload dengan
menggunakan software FTP.

FTP, File Transfer Protocol, ada-
lah salah satu protokol standar di

Internet. Dengan FTP file atau data
dari PC dapat di-upload ke server
FTP di Internet dan sebaliknya. Pro-
tokol ini menawarkan pengiriman
file yang lebih aman, mudah, dan
cepat dari dan ke Internet.

Untuk dapat mengakses se-
buah server FTP dibutuhkan se-
buah program yang biasa disebut

FTP client. Program inilah yang
akan mengatur pertukaran data
dari komputer Anda ke komputer
lain yang berjauhan (server FTP).
Beberapa jenis program yang
cukup populer bagi pengelola
situs Web, di antaranya adalah
WS_FTP Pro, CuteFTP, dan
SmartFTP. PC+

Ada banyak situs yang menawarkan jasa hosting gratis yang juga
menyediakan alat-alat dan template yang bisa dipakai untuk membangun sebuah
situs Web. Contohnya adalah www.freewebs.com.

BIKIN SITUS TANPA
BELAJAR HTML

Pertama kali
www.freewebs.com dibuka,
hadirlah halaman utama.
User yang sudah memiliki
account di sini bisa langsung
mengisi login name dan
password-nya di sebelah
kanan atas halaman.
Sedangkan pendatang baru
yang tertarik untuk
membuat situs Web bisa
langsung menglik tombol
[Sign Me Up!] yang terletak
di tengah halaman.

Setelah tombol [Sign Me Up!]

diklik, akan tampil halaman
yang meminta berbagai
informasi seperti nama
account, password, alamat
e-mail, dan dari mana
pengunjung tahu tentang
Freewebs. Setelah semua
field terisi, klik tombol [Next

Step]. Selanjutnya, muncullah
layar aggreement untuk
menggunakan layanan ini.
Baca, bila perlu, dan pilih [I
understand and agree with

the above policy] untuk
melanjutkan ke langkah
berikutnya.

Ada dua opsi yang bisa
dipilih, layanan untuk user
yang masih pemula atau
yang sudah ahli. Untuk
pemula, Freewebs
menyediakan mesin
generator untuk membangun
situs dengan template yang
telah disediakan. Sedangkan
user yang lebih ahli bisa
meng-upload desain Web
yang sudah dibuatnya
sendiri. Anggaplah kita
sebagai pemula, kita bisa
memilih [Beginner User – Free

Website Builder]. Secara
otomatis akan muncul form
berisi field-field yang harus
diisi, yaitu Site Title,
Secondary Site Title, Site
Footer, Public E-mail
Address, Site Category, dan
bahasa dominan yang akan
digunakan pada situs kita.
Setelah itu, klik tombol [Next

Step].

Muncul halaman yang
menampilkan halaman yang
berisi sejumlah template
yang bisa dipilih. Motifnya
banyak dengan warna yang
beraneka ragam Sebagai
contoh, PCplus memilih
template Space. Pemilihan
template ini merupakan
proses terakhir
pendaftaran. Selanjutnya
adalah menambahkan isi
situs Web.

Sign in dengan
menggunakan user name
yang sudah dibuat untuk
memulai proses
pengeditan. Setelah masuk
ke halaman account, Isi
dan halaman situs Web
bisa ditambah. Jika ingin
langsung menambah isi
homepage, klik [Add

content to your Homepage].
Yang dimaksud dengan
homepage adalah halaman
pembuka yang akan
pertama muncul setiap
kali situs dikunjungi. Untuk
mengedit isi halaman, klik
[Open Homepage in Page

Editor]. Setelah itu, klik
[New Paragraph]. Sebuah
halaman editor akan
muncul sebagai pop-up
window. Ikon-ikon dalam
halaman ini mirip dengan
ikon-ikon pada
Dreamweaver,
kegunaannya masing-
masing bisa dengan mudah
ditebak. Langkah-langkah
penggunaannya pun mudah
untuk diikuti.

Untuk menambah jumlah
halaman situs, klik [Add

Supporting Pages]. Setelah
itu, pilih [Get to Site
Manager] untuk melihat
tampilan urutan halaman
yang ada pada situs. Pilih
[Add a Page] untuk
menampilkan layar untuk
penambahan halaman.
Setelah memasukkan nama
halaman yang diinginkan,
klik [Done]. Pengeditan isi
setiap halaman berikutnya,
kita bisa langsung
menggunakan Site
Manager. Adanya ikon-ikon
bergambar, memudahkan
kita untuk memperindah
situs kita.

1

2

3

4

5

6



plusFokus V • 20 - 26 Januari 2004
PCplus 159

| 17

Penyedia Web hosting gratisan yang akan digunakan adalah Geocities
(www.geocities.com). Sebelum beranjak ke Geocities, ada beberapa hal penting
yang perlu diperhatikan.

Hal pertama, adalah optimasi ukuran  file yang di-upload. Semakin kecil
ukuran file, semakin cepat pula waktu upload. Tidak hanya pada saat di-upload,
pada saat di-download (baca: diakses) pun semakin cepat.

GRATIS DAN PRAKTIS DI GEOCITIES Hal ke dua adalah penamaan file. Usahakan nama file dalam huruf non-
kapital dan tanpa spasi. File-file HTML disimpan dengan extension html, bukan
htm. Juga penting agar halaman utama diberi nama index.html.

Hal berikutnya adalah pengaturan letak file. Elemen-elemen pendukung
lebih baik disiimpan dalam subfolder sendiri membuat manajemen situs lebih
mudah. Misalnya begini, sebuah halaman situs bernama index.html yang
tersimpan di C:\situs memiliki 5 gambar. Gambar-gambar itu dapat diletakkan di
dalam folder  C:\situs\index_files.

Link untuk mendaftar di Web
hosting gratis Geocities hanya
berupa teks kecil. Klik teks itu.
Pada halaman baru yang
muncul, klik [Sign Up]. Muncul
lagi halaman baru yang meminta
Yahoo! ID. Kalau belum punya
Yahoo! ID, klik [Sign up now].
Sedangkan kalau sudah,
langsung saja sign in dengan
memasukkan Yahoo! ID. Di
halaman baru yang muncul, klik
[Easy Upload] yang terletak di
boks sebelah kanan layar. Link
ini akan membawa kita ke
halaman untuk meng-upload file.

Misalnya begini, di hard disk,
file index.html berada di
C:\situs. Direktori C:\situs
itulah yang dinamakan direktori
root. Hitung jumlah file, tidak
termasuk folder, yang ada di
situ. Kemudian ubah Number of
Files to Download sesuai dengan
jumlah file. Klik [Display]. Kalau
halaman sudah muncul lagi, klik
[Upload Files] dan masukkan
semua file yang ada di direktori
root. Oleh karena nama file dan
extension sudah diatur, jangan
beri tanda centang pada dua
pilihan di bawah tombol [Upload

Files]. Di halaman verifikasi yang
muncul setelah file di-upload,
klik [File Manager].

Selanjutnya, gambar pendukung
halaman utama di-upload.
Misalnya, di harddisk, file
gambar pendukung index.html
berada di folder
C:\situs\index_files. Folder
yang bernama sama harus
dibuat dulu di Geocities. Klik
tombol [New] di bawah
Subdirectories. Sebuah
halaman baru yang meminta
nama subdirectory akan
muncul. Masukkan nama
subdirectory. Jika berdasarkan
contoh, maka nama
subdirectory yang dimasukkan
adalah index_files. Klik [Create

Subdirectory].

Secara otomatis, kita akan
kembali ke halaman File
Manager. Klik nama folder yang
tadi dibuat. Di halaman yang
muncul, klik [Upload Files].
Setelah tombol itu diklik,
halaman seperti pada langkah
2 akan muncul. Dari halaman
itu, upload semua file yang ada
di dalam folder
C:\situs\index_files. Untuk
kembali ke direktori root, klik
[Up One Level] di atas nama
folder. Lakukan langkah 3 dan
4 untuk seluruh folder yang
berisi elemen pendukung
masing-masing halaman situs.
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Setelah seluruh file
di-upload, situs dapat
di-preview. Klik saja
link di sebelah teks
Your site. Di contoh
yang digunakan, link
itu memiliki teks
http://
www.geocities.com/
alexpangestu280. Di
hasil preview,
periksa semua link
dan gambar. Kalau
ada link atau gambar
yang error, periksa
coding di HTML dan
posisi file HTML dan
file gambar.
Kesalahan ketik pada
HTML dan
penempatan file bisa
mengakibatkan
error.

Supaya lebih yakin,
buka Internet
Explorer dan ketikkan
alamat situs Web
yang tadi dibuat.
Berhasilkah?

MENG-UPLOAD SITUS DENGAN FTP

PCplus menggunakan WS_FTP Pro 8.02T dengan pertimbangan WS_FTP
sering digunakan, fiturnya lengkap, dan mudah penggunaannya. WS_FTP Pro
8.0T dapat di-download di http://www.ipswitch.com/downloads/index.html.
1. Langkah pertama adalah melakukan konfigurasi server pada program

WS_FTP. Kumpulkan seluruh file yang ingin di-upload ke dalam sebuah
folder terpisah. Setelah itu klik [Start]>[All Programs]>[WS_FTP

Pro]>[WS_FTP Pro].
2. Setelah program terbuka, klik tombol [Create site…] yang terletak pada

kotak dialog WS_FTP Pro: Connect to Remote Host.
3. Selanjutnya akan muncul WS_FTP Pro Site Profile Wizard. Masukkan nama

situs di bagian Name:, kemudian klik [Next].
4. Masukkan alamat server FTP pada bagian Host Address:. Alamat situs FTP

umumnya diawali dengan FTP diikuti dengan nama domain. Dalam hal ini
PCplus menggunakan ftp.tripod.com karena hosting situs Web pada
percobaan kali ini menggunakan Web hosting dari Tripod. Kalau sudah
dimasukkan klik [Next].

5. Masukkan username dan password. Apabila password tersebut disimpan
oleh program, maka tandai Save Password. Lanjutkan dengan mengklik
[Next].

6. Pilih FTP pada Server Type dan isi Port-nya dengan angka 21. Klik [Next],
kemudian [Next] sekali lagi.

7. Jika PC untuk meng-upload berada di belakang firewall, maka klik tombol
[Create New Firewall Entry…]. Apabila tidak, maka biarkan pilihan
firewall berada pada posisi <no firewall>.

8. Terakhir, klik [Finish]. Selesai sudah setting server hosting di WS_FTP.
Nama situs akan dimasukkan ke daftar Sites yang terdapat di bagian kiri.
Setelah seluruh setting untuk hosting server tersimpan, koneksi ke server

dapat langsung dibuat. Klik nama situs yang tadi dibuat, kemudian klik
[Connect]. Proses koneksi program ke server akan dilakukan secara otomatis.
Tunggu hingga terhubung. Proses koneksi ke server bisa dianggap selesai
apabila pesan 226 Transfer complete muncul di Log Window.

Program akan tampak dibagi menjadi dua secara vertikal. Sebelah kiri ada-
lah file dan folder yang terdapat di PC, sebelah kanan adalah remote computer
(server FTP). Sekarang masuklah ke folder tempat menyimpan file-file yang akan
di-upload ke server. Setelah itu pilih file mana saja yang ingin di-upload.

Pengiriman file akan segera berlangsung ketika setelah tombol [Upload],
yang digambarkan dengan panah kanan berwarna hijau, diklik. Waktu yang
diperlukan untuk proses pengiriman file ini tergantung dari besar file yang
dikirimkan. Proses pengiriman dan kecepatan transfer file dapat dilihat dari
Transfer Manager yang dapat diakses dengan mengklik tombol [Upload].

Setelah proses upload selesai, file yang Anda kirim tadi sudah dapat
diakses dari belahan dunia manapun. Mudah, kan? Untuk pengoperasian
lainnya seperti rename atau delete cara penggunaannya sama dengan
Windows Explorer, jadi Anda pasti bisa melakukannya.  PC+

WS_FTP Pro Explorer menawarkan kemudahan
upload dan download file melalui FTP semudah meng-
copy file di Windows Explorer.

Dengan wizard yang disediakan oleh kebanyakan FTP
client, Anda akan dipandu untuk mengatur setting
FTP Anda pada program yang bersangkutan.

Transfer Manager memudahkan Anda memantau proses
upload dan download file yang sedang berlangsung.
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Setting Kartu Jaringan
di Linux

Yahya Kurniawan
yahya@e-pcplus.com

T

Orang yang awam
terhadap Linux pun
paham bahwa Linux

memang sistem operasi
tangguh, digunakan

untuk jaringan. Namun
memang kebanyakan

pengguna Linux --
apalagi yang pemula--

hanya menggunakan
Linux untuk worksta-

tion yang bersifat
stand alone saja.

etapi setelah
pengetahuan akan
Linux mulai bertambah,
tentu tidak ada

salahnya belajar mengenal
jaringan menggunakan Linux.
Apalagi jika didukung adanya
dua komputer atau lebih. Seba-
gai awal dari semuanya itu ada-
lah setting kartu jaringan. Setting
kartu jaringan yang benar akan
mempermudah langkah berikut-
nya dalam menyusun jaringan
dengan sistem operasi Linux.

Pada edisi ini PCplus akan
memberikan sedikit gambaran ba-
gaimana melakukan setting kartu
jaringan pada sistem RedHat 9.0.

Kita ambil pengandaian
Anda belum memiliki kartu
jaringan sama sekali. Kemudian
Anda membeli sebuah kartu
jaringan dan menancapkannya ke
mainboard. Untung bagi Anda
apabila kebetulan kartu jaringan
tersebut telah dikenal oleh Linux.
Pada saat booting, Linux RH 9.0
akan menjalankan program
kudzu (semacam YAST di SuSE)
dan melakukan konfigurasi oto-
matis dari kartu jaringan tersebut.
Demikian pula halnya apabila pada
saat instalasi Linux Anda telah
menancapkan kartu jaringan yang
dikenal oleh kernel Linux, kartu
jaringan tersebut otomatis akan
terkonfigurasi. Orang bilang proses
seperti itu adalah plug and play.

Setelah proses booting
selesai, login-lah sebagai root
dan ketikkan perintah berikut:

# dmesg |grep eth0

Hasil yang diberikan kira-kira
adalah sebagai berikut
(tergantung dari spesifikasi
hardware yang Anda miliki):

divert: allocating divert_blk
for eth0
eth0: RealTek RTL-8029 found
at 0xe800, IRQ 5,
00:C0:26:EF:D5:66.

Catatan: hasil yang
diberikan harus disaring dengan
grep, karena jika tidak akan
panjang sekali dan menghabis-
kan halaman tabloid ini.

Di situ terlihat bahwa kartu
jaringan yang dimiliki adalah
RealTek RTL-8029.

Anda juga dapat
menjalankan perintah berikut:

# ifconfig
Hasil yang diberikan kira-kira

adalah sebagai berikut:

eth0 Link encap:Ethernet

HWaddr 00:C0:26:EF:D5:66
inet addr:192.168.0.1

Bcast:192.168.0.255
Mask:255.255.255.0

UP BROADCAST
RUNNING MULTICAST
MTU:1500  Metric:1

RX packets:0 errors:0
dropped:0 overruns:0 frame:0

TX packets:16 errors:0
dropped:0 overruns:0 carrier:0

collisions:0
txqueuelen:100

RX bytes:0 (0.0 b)  TX
bytes:960 (960.0 b)

Interrupt:5 Base
address:0xe800

lo Link encap:Local
Loopback

inet addr:127.0.0.1
Mask:255.0.0.0

UP LOOPBACK RUN-
NING  MTU:16436  Metric:1

RX packets:30433
errors:0 dropped:0 overruns:0
frame:0

TX packets:30433
errors:0 dropped:0 overruns:0
carrier:0

collisions:0
txqueuelen:0

RX bytes:2078435 (1.9
Mb)  TX bytes:2078435 (1.9
Mb)

Pada bagian eth0 terlihat
bahwa terdapat suatu hardware
yang beralamatkan di
00:C0:26:EF:D5:66, sama persis
dengan yang disebutkan pada
perintah dmesg.

Seandainya kartu jaringan
Anda tidak dapat dikenali secara
otomatis oleh kernel Linux, Anda
dapat mencoba cara di bawah ini,
mudah-mudahan berhasil.

Mula-mula lihatlah daftar
driver kartu jaringan yang
dikenal Linux di /lib/modules/
2.4.20-8/kernel/drivers/net
(letak direktori ini sangat
mungkin berbeda untuk kernel
dan distro yang berbeda). Anda
harus tahu jenis chip dari kartu
jaringan Anda kira-kira mende-
kati driver yang mana. Biasanya
kartu jaringan yang “biasa-biasa
saja” akan kompatibel dengan
ne2000. Karena itu Anda dapat
mencoba cara sebagai berikut:

# modprobe ne2k-pci

Modul dari kartu jaringan
yang kompatibel dengan ne2000
adalah ne2k-pci.o. Simpan hasil
probing ke dalam file /etc/modu-
les.conf (pada SuSE mungkin
namanya /etc/conf.modules).
Tambahkan baris berikut:

alias eth0 ne2k-pci

Salah satu kemungkinan
isi file /etc/conf.modules adalah
sebagai berikut:

alias eth0 ne2k-pci

alias usb-controller usb-uhci
alias sound-slot-0 es1371
post-install sound-slot-0 /bin/
aumix-minimal -f /etc/.aumixrc
-L >/dev/null 2>&1 || :
pre-remove sound-slot-0 /bin/
aumix-minimal -f /etc/.aumixrc
-S >/dev/null 2>&1 || :

Sekarang kita akan menga-
tur nomor IP dari kartu jaringan
tersebut. Seandainya nanti kom-
puter tersebut akan masuk ke da-
lam jaringan kelas C, maka nomor
IP nya harus memiliki pola
192.168.x.x. (Mengenai penomo-
ran IP ini mudah-mudahan lain
waktu PCplus dapat
membahasnya.)

Konfigurasi nomor IP
dilakukan dengan perintah
sebagai berikut:

# ifconfig eth0 192.168.1.2
broadcast 192.168.1.255
netmask 255.255.255.0

Untuk memeriksa
keberhasilan konfigurasi di atas,
ketikkan perintah ini:

# ping -c 5 192.168.1.2

Nomor IP tersebut tidak bo-
leh ada yang sama dalam sebuah
jaringan. Jika hasil yang diberi-
kan adalah seperti di bawah ini,
maka boleh dikatakan setting
kartu jaringan telah berhasil:

PING 192.168.0.1 (192.168.0.1)
56(84) bytes of data.
64 bytes from 192.168.0.1:
icmp_seq=1 ttl=64 time=0.125
ms
64 bytes from 192.168.0.1:
icmp_seq=2 ttl=64 time=0.113
ms
64 bytes from 192.168.0.1:
icmp_seq=3 ttl=64 time=0.114
ms
64 bytes from 192.168.0.1:
icmp_seq=4 ttl=64 time=0.110
ms
64 bytes from 192.168.0.1:
icmp_seq=5 ttl=64 time=0.115
ms

--- 192.168.0.1 ping statistics --
-
5 packets transmitted, 5
received, 0% packet loss, time
3999ms
rtt min/avg/max/mdev = 0.110/
0.115/0.125/0.010 ms

Untuk merujuk ke dirinya
sendiri, digunakan nomor IP
127.0.0.1, jadi perintah di atas
akan ekivalen dengan perintah ini:

# ping -c 5 127.0.0.1
Konfigurasi di atas

hendaknya disimpan di file /etc/
sysconfig/network-scripts/
ifcfg-eth0. Isi dari file tersebut
adalah sebagai berikut:

DEVICE=eth0

Ba
m

ba
ng

.W
/P

C
pl

us

BOOTPROTO=none
BROADCAST=192.168.1.255
IPADDR=192.168.1.2
NETMASK=255.255.255.0
NETWORK=192.168.0.0
ONBOOT=yes
USERCTL=no
PEERDNS=no
TYPE=Ethernet

Seandainya komputer Anda
terhubung ke jaringan yang
memiliki DHCP server (server
yang memberikan nomor IP
secara otomatis pada setiap
client-nya), Anda tidak perlu
mengatur setting nomor IP dan
isi dari file /etc/sysconfig/
network-scripts/ifcfg-eth0
cukup sebagai berikut:

DEVICE=eth0
BOOTPROTO=dhcp
ONBOOT=yes

Terakhir lakukan langkah
sebagai berikut:

# /etc/rc.d/init.d/network
restart

atau

# /etc/rc.d/init.d/network start

Jika Anda berhasil dalam
melakukan konfigurasi kartu
jaringan, seharusnya hasil yang
diberikan adalah sebagai berikut:

Shutting down interface eth0:
[  OK  ]
Shutting down loopback
interface:
[  OK  ]
Setting network parameters:
  OK  ]
Bringing up loopback inter-
face: [  OK  ]
Bringing up interface eth0:
[  OK  ]

Sedikit tambahan informasi,
jika Anda membuat jaringan
yang hanya terdiri dari dua

komputer saja, Anda dapat
langsung menghubungkan kedua
komputer tersebut dengan kabel
UTP tetapi susunan kabel UTPnya
harus cross. Sedangkan jika
menggunakan hub, seluruh
susunan kabel UTP straight.

Susunan kabel UTP yang
cross adalah kabel nomor 1 di
satu sisi akan keluar sebagai
kabel nomor 3 di sisi yang lain
dan kabel nomor 2 di satu sisi
akan keluar sebagai kabel nomor
6 di sisi yang lain.

Urutan kabel UTP untuk
standar EIA/TIA 568A adalah:
1. Hijau
2. Hijau-Putih
3. Oranye
4. Biru-Putih
5. Biru
6. Oranye-Putih
7. Coklat
8. Coklat-Putih

Sedangkan urutan kabel UTP
untuk standar EIA/TIA 568B
adalah:

1. Oranye
2. Oranye-Putih
3. Hijau
4. Biru-Putih
5. Biru
6. Hijau-Putih
7. Coklat
8. Coklat-Putih

Di lingkungan kolega-
kolega PCplus, standar yang
sering digunakan adalah EIA/TIA
568B.

Anda harus perhatikan betul
urutan tersebut. Pernah dalam
sebuah workshop yang diseleng-
garakan suatu lembaga pendidi-
kan tertentu, pemasangan kabel
UTP tersebut asal urutan di satu
sisi sama dengan sisi yang lain. Ini
jelas salah! Dengan cara ini
mungkin memang jaringan bisa
jalan, tetapi hanya untuk kece-
patan rendah dan tidak efisien.

Selamat mencoba. PC+
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Seleksi Rambut
( Subyek Berbentuk

Kompleks ):
...and The Wind Dancing on Her Hair

Vincent Bayu Tapa Brata
vincent@e-pcplus.com

Permintaan bahasan topik seleksi terhadap
subjek terurai, misalnya rambut, banyak masuk

ke e-mail redaksi. Oleh karena itu, kali ini kita
akan mencoba latihan melakukan seleksi

terhadap subjek tersebut. Kita akan
memanfaatkan fasilitas Channel.

eknik ini sering dikenal dengan Alpha Channel
Selection. Tanpa berpanjang kata, segera kita coba…T

1. Buka foto bahan dasar. Tampilkan palet Layers. Jika belum tampil,
klik menu [Window]>[Show Layers]. Klik ganda bar layer Back-
ground agar menjadi layer normal dan bisa dimanipulasi dengan leluasa. Beri
nama layer ini, misalnya, Asli.

2. Buka palet Channels. Pilih channel yang menyediakan tampilan bagian subjek
paling kontras terhadap latar belakang. Klik Arrow (ikon panah hitam
menghadap ke kanan di sebelah kanan atas palet Channels), lalu klik Duplicate
Channels. Kita akan bekerja pada salinan channel ini, sehingga tidak merusak
gambar asli.

3. Edit tingkat kontras nada subjek terhadap latar belakang menggunakan Levels.
Klik menu [Image]>[Adjustment]>[Levels]. Geser slider, baik Highlight, Midtone,
maupun Shadow.

4. Sapu bagian latar belakang yang akan disembunyikan (dalam latihan ini dengan
nada terang). Nada dapat dipilih pada palet Foreground Color pada palet
Toolbox. Pergunakan Paintbrush Tool pada Toolbox untuk menyapukan nada.
Kuat-lemahnya sapuan dapat diatur dengan menggeser slider Tool Opacity.
Sementara itu, ukuran diameter brush dapat diatur dengan menekan
tombol [  dan  tombol  ] pada keyboard. Pembesaran tampilan dilakukan dengan
kombinasi tombol [Ctrl] dan [+] pada keyboard. Sebaliknya, untuk mengecilkan
tampilan dengan kombinasi tombol [Ctrl] dan [-].

5. Sapu subjek dengan nada gelap. Sebelumnya, balik nada pada palet Foreground
Color. Caranya, sama dengan langkah 4.

6. Setelah sapuan nada sempurna, klik ikon Load Channel as Selection di bagian
bawah palet Channels.

7. Buka palet Layers. Klik menu [Select]>[Inverse] agar seleksi dibalik, sehingga
subjek terpilih/terseleksi. Klik menu [Select]>[Feather]. Beri nilai kecil, misalnya 1.
Tujuannya, agar tepian seleksi tidak terlihat tajam seperti kesan guntingan.

8. Klik ikon Add Layer Mask pada bagian bawah palet Layers. Bagian latar
belakang segera akan tersembunyi. Kita bisa memberi layer baru berwarna putih
di bawah layer Asli (klik [Arrow]>[New Layer]) untuk mengecek kehalusan hasil
seleksi.

Klik Ganda

Beri nama
Layer

Arrow

Slider Levels

Tool/Brush Opacity

Paintbrush Tool

Nada terang di palet
Foreground   Color

Nada gelap di palet
Foreground   Color

Ikon Load
Channel as
selection

Ikon add
layer mask
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9. Pada dasarnya proses Channel Selection sudah selesai. Bila kita ingin
memberikan efek-efek khusus, itu terpulang pada kreativitas kita. Efek kecepatan
pernah dibahas pada PCplus edisi 134. Secara ringkas, salin layer Asli dua kali,
lalu beri nama Wind dan Motion. Aktifkan layer Wind, lalu terapkan filter Wind
(klik menu [Filters]>[Stylize]>[Wind]). Demikian pula, terapkan filter Motion Blur
pada layer Motion (klik menu [Filters]>[Blur]>[Motion Blur]). Beri Layer Mask
pada layer Motion dan Wind (seperti langkah 8), lalu sembunyikan ( seperti
langkah 4) bagian efek kecepatan yang mengganggu (misalnya pada wajah).

10.Bila perlu, tambahkan elemen gambar penguat tema. Save dan beri nama
pekerjaan kita dalam format .PSD (klik menu [File]>[Save As]).
Tidak terlalu sulit bagi yang bersedia bertekun dan mencoba. Pertanyaan dan

permintaan file source latihan ini dapat dikirim ke e-mail penulis. PC+

Foto : ARE/PCplus
Model : Shintia
Properti : Agung

Layer
aktif

Mask aktif
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phpMyAdmin:
Tool Administrasi MySQL

Berbasis PHP

Yahya Kurniawan
yahya@e-pcplus.com

M

Minggu lalu PCplus
telah menyajikan

pembahasan tentang
phpPgAdmin yang

merupakan tools
administrasi server

database
PostgreSQL. Kali ini

PCplus akan sedikit
flashback ke belakang

dan membahas
phpMyAdmin, yaitu

tool serupa
phpPgAdmin tetapi

digunakan untuk
administrasi database

server MySQL. Tentu
saja hal ini dilakukan
agar penggemar dan

pengguna MySQL
tidak merasa

dianaktirikan.
Memang dahulu pada

saat pembahasan
tentang MySQL,

pembahasan tentang
phpMyAdmin

terlewat. Untuk itu
PCplus mohon maaf.

ula-mula carilah
dahulu distribusi
instalasi phpMyAdmin.
Anda bisa men-

download-nya dari berbagai
tempat, misalnya
www.sourforge.net,
www.phpmyadmin.net,
www.freshmeat.net dan lain-
lain. Rilis terakhir adalah
phpMyAdmin-2.5.5-pl1. File
distribusi yang PCplus dapatkan
adalah phpMyAdmin-2.5.5-
pl1.tar.bz2. Pada tutorial ini
PCplus menggunakan distro
RedHat 9.0.

Langkah-langkah instalas-
inya adalah sebagai berikut:
• Letakkan file distribusi

tersebut pada direktori root
webserver, misalnya /var/
www/root.

• Ekstrak dengan perintah
berikut:

# bunzip2 phpMyAdmin-
2.5.5-pl1.tar.bz2

Jika Anda mendapatkan
distribusi instalasi berupa file
phpMyAdmin-2.5.5-
pl1.tar.gz, maka perintah
ekstraksinya adalah sebagai
berikut:

# gunzip phpMyAdmin-2.5.5-
pl1.tar.gz

Langkah berikutnya adalah
mengekstraksi sekali lagi file tar
yang merupakan hasil ekstraksi
file zip tadi.

# tar -xvf phpMyAdmin-2.5.5-
pl1.tar

Sampai di sini Anda akan
mendapatkan sebuah direktori
baru bernama phpMyAdmin-
2.5.5-pl1 yang terletak di /var/
www/root. Kemudian carilah
file bernama config.inc.php
yang terletak di /var/www/
root/phpMyAdmin-2.5.5-pl1.
Edit beberapa hal pada file

tersebut sebagai berikut:
• Isilah variabel

$cfg['PmaAbsoluteUri']
dengan URL lengkap dari
phpMyAdmin Anda. Kalau
mengikuti contoh di atas
berarti nilai variabel
$cfg['PmaAbsoluteUri'] adalah
'http://localhost/

phpMyAdmin-2.5.5-pl1'.
• Isilah variabel

$cfg['Servers'][$i]['host']
dengan letak server MySQL
Anda. Jika server Anda

terletak di localhost, maka
nilai $cfg['Servers'][$i]['host']
adalah 'localhost'.

• Isilah variabel
$cfg['Servers'][$i]['user']
dengan user MySQL Anda.

• Isilah variabel
$cfg['Servers'][$i]['password']
dengan password user MySQL
di atas.

Seperti halnya juga dengan
phpPgAdmin, phpMyAdmin juga
dapat dijalankan untuk
menangani beberapa server
sekaligus.

Saat ini hal-hal yang dapat
ditangani oleh phpMyAdmin
adalah:
• Membuat dan menghapus

database.
• Membuat, menyalin,

menghapus, mengganti
nama, dan menyunting (alter)
tabel.

• Melakukan perawatan tabel.
• Menghapus, menyunting, dan

menambah field pada tabel.
• Mengeksekusi perintah SQL,

termasuk batch-queries.
• Manajemen kunci indeks pada

field.
• Konversi file teks ke dalam

tabel.
• Membuat dan membaca

dump tabel.
• Mengekspor data ke format

CSV, XML dan Latex.
• Mengadministrasi beberapa

server.
• Manajemen user dan hak

akses ke MySQL.
• Memeriksa referential

integrity pada tabel MyISAM.
• Menggunakan Query-

by-example (QBE).
• Membuat grafik

berformat PDF dari
layout database Anda.

• Melakukan pencarian
secara global dalam
database atau
subsetnya.

• Melakukan transformasi
data tersimpan ke
sembarang format
menggunakan fungsi-
fungsi yang ada,

misalnya menampilkan BLOB-
data sebagai image atau link
atau yang lainnya.

• Mendukung tabel InnoDB dan
foreign keys.

• Mendukung
penggunaan 47 bahasa.

Setelah semua siap,
phpMyAdmin dapat
dijalankan menggunakan
browser dengan
menuliskan alamat
berikut pada bagian
address: http://localhost/
phpMyAdmin-2.5.5-pl1/
index.php. Tampilan
phpMyAdmin akan nam-
pak seperti Gambar 1.

Frame sebelah kiri
digunakan untuk memilih
database dan tabel yang akan
dikerjakan dan frame kanan
berisi berbagai informasi
mengenai tabel dan database
tersebut. Misalnya Anda
memilih sebuah tabel dari
dropdown yang terdapat di
frame kiri, maka frame kanan
akan menampilkan informasi
mengenai tabel-tabel yang ada
pada database tersebut (lihat
Gambar 2).

Jika Anda klik link salah
satu nama tabel pada frame
sebelah kiri, maka pada frame
sebelah kanan akan muncul
berbagai informasi mengenai
tabel tersebut, misalnya field-
field yang ada, tipe data pada
suatu field, fasilitas untuk
menambah field, melakukan
query, dan lain-lain.

Berikut ini kita akan
mencoba untuk membuat tabel
baru dengan bantuan
phpMyAdmin tersebut.
1. Klik link [Home] pada bagian

atas frame kiri.
2. Pada kotak teks Create New

Database masukkan nama
sebuah database baru,
misalnya coba, lalu klik
tombol [Create].

3. Berikutnya Anda akan

diminta untuk memasukkan
nama sebuah tabel baru be-
serta jumlah fieldnya. Misal-
nya saja kita akan membuat
sebuah daftar nama teman-
teman Anda dengan field
nama, alamat, telpon, maka
masukkan daftar pada kotak
teks Name dan 3 pada kotak
teks Fields lalu klik [Go].

4. Selanjutnya Anda akan
menjumpai halaman seperti
pada Gambar 3. Pada
halaman tersebut Anda
diminta mengisikan nama
field, tipe data, nilai default,
dan indeks dari tabel Anda.

5. Masukkan nama pada field
pertama, tipe data varchar
sepanjang 20 karakater, lalu
aktifkan pilihan index.

6. Masukkan alamat pada field
kedua, tipe data varchar
sepanjang 30 karakter.

7. Masukkan telpon pada field
ketiga, tipe data varchar
sepanjang 15 karakter.

8. Klik [Save].

Tabel Anda kini telah selesai
dibuat. Pada halaman selanjutnya
Anda dapat mengisikan data-
data ke dalam tabel tersebut
dengan mengklik link [Insert].
Isikan record-record Anda pada
halaman tersebut dan di bagian
bawah.

 Anda bisa memilih apakah
setelah mengisikan record
tersebut Anda akan kembali ke
halaman selanjutnya atau
mengisikan record baru.

Anda juga bisa mengisikan
record berdasarkan sebuah file
teks. Jika Anda klik link nama
tabel pada frame kiri, maka pada

bagian bawah frame kanan akan
terdapat link [Insert data from a

textfile into table].
Pekerjaan membuat tabel

baru di atas adalah ekwivalen
dengan perintah berikut jika
dilakukan dari MySQL Client.

# mysql -p
Enter password:
Welcome to the MySQL
monitor.  Commands end with
; or \g.
Your MySQL connection id is
15 to server version: 3.23.54

Type 'help;' or '\h' for help.
Type '\c' to clear the buffer.

 mysql> create database
coba;
Query OK, 1 row affected
(0.12 sec)

mysql> use coba
Database changed
mysql> create table daftar(

-> nama varchar(20),
-> alamat

varchar(30),
-> telpon

varchar(15));
Query OK, 0 rows affected
(0.15 sec)

Setelah itu untuk
menyisipkan data baru, Anda
harus menggunakan perintah
Insert Into. Nah, setidaknya
dengan menggunakan
phpMyAdmin Anda tidak harus
menghapalkan perintah-
perintah tersebut bukan?

Karena phpMyAdmin
bersifat open source (sama
halnya dengan phpPgAdmin),
maka Anda bisa melihat seluruh
source code dari file-file php
yang digunakan dalam
membangun phpMyAdmin.
Sudah tentu seluruh file
tersebut akan terletak di /var/
www/html/phpMyAdmin-
2.5.5-pl1. Anda bisa
mengeditnya sesuai dengan
kebutuhan Anda sendiri. Hanya
saja jika memang ingin
mempelajari source code
phpMyAdmin Anda harus betul-
betul teliti karena seringkali
sebuah file php hanya terdiri
dari skrip yang pendek, namun
sebetulnya membutuhkan
referensi dari berbagai file php
yang lain. Misalnya saja file
chk_rel.php, isinya hanya
seperti ini:

<?php
/* $Id: chk_rel.php,v 2.2 2003/
11/26 22:52:24 rabus Exp $ */
// vim: expandtab sw=4 ts=4
sts=4:
/**
* Gets some core libraries
*/

require_once('./libraries/
grab_globals.lib.php');
require_once('./libraries/
common.lib.php');
require_once('./
db_details_common.php');
require_once('./libraries/
relation.lib.php');
/**
* Gets the relation set-
tings
*/
$cfgRelation =
PMA_getRelationsParam(TRUE);

/**
* Displays the footer
*/
require_once('./
footer.inc.php');
?>

Kelihatannya hanya
pendek, tetapi membutuhkan
referensi dari file
grab_globals.lib.php,
common.lib.php,
db_details_common.php,
relation.lib.php, serta
footer.inc.php.

OK, selamat mempelajari
phpMyAdmin beserta source
code-nya. PC+

Gambar 1

Gambar 2

Gambar 3
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Bagi pembaca yang tertarik untuk berinteraksi di rubrik ini, silakan mendaftar dengan mengirimkan e-mail  kosong ke mailplus-subscribe@yahoogroups.com.
Agar keanggotaan Anda segera diaktifkan, balas e-mail konfirmasi yang dikirimkan oleh Yahoo ke alamat e-mail Anda. Setelah terdaftar, Anda dapat mengirimkan e-mail pertanyaan ataupun tukar

menukar pengalaman seputar dunia komputer.
Jangan lupa untuk memeriksa account e-mail Anda secara rutin. Jika Anda tertarik untuk berdiskusi langsung secara online, silakan Anda join ke server DALnet pada channel #chatplus di mIRC.

PENTING!!!
Kalau Anda ingin menerima dan membaca e-mail secara digest (satu e-mail berisi beberapa message), kirim e-mail kosong ke mailplus-digest@yahoogroups.com. Sebagai informasi, setiap hari

Jum’at hingga Minggu adalah hari bebas di milis ini.
Setiap anggota dapat mem-posting e-mail diluar seputar masalah komputer asalkan tidak mengandung SARA, pornografi, bajak-membajak software, flamming, dan sebagainya. Jika Anda tidak

ingin menerima e-mail OOT (Out Of Topic), kirim e-mail ke mailplus-nomail@yahoogroups.com, dan silakan Anda aktifkan kembali ke mode normal dengan mengirim e-mail ke mailplus-
normal@yahoogroups.com.

•Redaksi

Need Help,
Cari PC Murah

Buat semua, salam kenal ya.
Saya anggota yang baru join
nih. Langsung aja ya, kalo kita
mau cari PC murah, mending
beli yang paket atau yang kita
rakit sendiri? Adakah di antara
teman-teman yang tau toko
dengan harga jual terendah?
Kalau dana saya sekitar 3 juta-
an, saya dapet yang gimana ya?
Spesifikasi komputer dengan
dana segitu kira-kira seperti apa
ya? Sebelumnya makasih
banyak.

atc6ers_27

Jawab:
Kalau menurut saya,

sebaiknya Anda ngerakit
sendiri. Kadang-kadang yang
paket lebih murah, tetapi
biasanya memakai komponen
yang nggak begitu bagus baik
dari segi kualitas ataupun dari
segi spesifikasi. Kalau mengenai
toko termurah, biasanya toko-
toko di daerah Harco Mangga
Dua atau di daerah Glodok
harganya bersaing koq. Paling
beda-beda tipis.

Dengan dana 3 juta, Anda
membutuhkan PC untuk apa
dulu nih? Kalau untuk
mengerjakan aplikasi biasa
ataupun memainkan game-
game versi lama masih cukup
lumayan lah. Kalau mau lebih
menekan biaya, gunakan
prosesor AMD.

Adhitya F. Anggoro

Komputerku Gak
Bisa Nyala

Hallo milis PC+, saya mau
nanya nih. Kok komputer saya
kadang-kadang waktu
dinyalakan nggak ada gambar
yang muncul di monitor. Tetapi
anehnya, harddisk-nya tetap
nyala. Kalau sudah begitu,
terpaksa saya matiin dulu baru
di hidupkan lagi. Karena
percuma saja, walaupun sudah
aku reset, tetap saja nggak mau
muncul gambar.

Terus satu lagi. Kenapa ya
kalau komputer ini sudah nyala,
pas buka menu Windows, saat
aku menggerakkan mouse,
kadang-kadang ada keluar
bunyi semacam noise. Keluarnya
bukan dari speaker, tapi
suaranya kayaknya dari dalam
CPU. Apa ya masalahnya?
Terima kasih sebelumnya.

ary ai

Jawab:
Biasanya sih, kalau

gejalanya seperti itu ada

masalah pada BIOS atau pada
hardware komputer Anda seperti
kartu grafis atau memori. Apakah
saat itu, PC speaker
mengeluarkan suara kode error?
Kalau ya, coba copot, bersihkan
konektor (kaki-kaki) memori,
VGA, dan dudukan (slot-nya) lalu
kemudian pasangkan lagi.

Untuk masalah yang ke dua,
bisa jadi ada kerusakan pada
hardware ataupun terjadi konflik
pada konfigurasi driver ataupun
IRQ. Coba ubah setting-nya.
Kalau tidak bisa juga,
kemungkinan terakhir adalah
sudah terjadi kerusakan hard-
ware.

edy sin, I Made C. Wirawan

Software Emulator PS
dan untuk Virtual
Drive

Halo milis Mailplus! To the
point aja ya. Saya ada dua
pertanyaan:
1. Apakah ada emulator Play

Station untuk Windows XP?
2. Apakah ada program yang

bisa membuat semacam
virtual drive di Windows XP?
Saya memiliki file Nero (.nrg).
Jadi intinya, saya ingin
software tersebut kompatibel
dengan format file virtual
drive milik NERO.
Mohon pencerahannya.

Terima Kasih

falcon_spm

Jawab:
1. Untuk software emulator,

kayaknya ePSXe atau
Connectix VGS bisa jalan deh
di Windows XP. Untuk ePSXe,
kalau gak salah bisa diambil
di www.epsxe.com.

2. Untuk software seperti ini, gu-
nakan pakai Daemon tools. Si-
lakan download di: http://
www.daemon-tools.cc/portal/
download.php?mode=Download&id=34

0340069

Skrip di Html Buat
Jadi Default
Homepage

Milisi Mailplus sekalian,
adakah di antara rekan yang
tahu skrip untuk membuat
website kita bisa jadi default
homepage-nya Internet Ex-
plorer atau browser yg lainnya?
Atau ada yang pernah
menemukan skrip semacam ini
di internet? Ngomong-
ngomong, posting-an gue yang
dulu tentang masalah ini
nyampe gak ya ke milis ini? Koq
saya nggak terima balik ya?

0340069

Jawab:
Kalau maksud kamu untuk

menjadi home page di Internet
Explorer komputer sendiri, coba
buka menu [Tools] > [Internet

Options…]. Setelah itu di kolom
Address, masukkan alamat situs
kamu. Kalau maksudnya supaya
alamat situs kamu bisa dijadikan

Install Windows XP ke Harddisk Serial ATA 80GB

Halo rekan-rekan milis. Aku punya harddisk
Serial ATA nih, dan sekarang saya mau nanya sama
rekan-rekan sekalian bagaimana cara
menginstalasikan Windows XP ke harddisk Serial
ATA 80GB-ku ini. Sebagai informasi, komputerku
menggunakan motherboard MSI dengan chipset
SiS655 serta menggunakan prosesor Intel Pentium-
4 2GHz. Tolong informasinya ya.

Doelche

Jawab:
Caranya, coba Anda lakukan booting sistem

dengan menggunakan CD Windows XP. Dari sana,
kalau kontroler Serial ATA Anda tidak tertanam
pada chipset (buatan pihak ke tiga), Anda siap-siap pencet tombol F6. Setelah itu Anda akan diminta
untuk memasukkan disket driver yang disertakan. Kalau pada paket motherboard tersebut tidak ada
disket driver Serial ATA, coba periksa di CD instalasinya. Kalau ada, kopikan ke disket.

Setelah harddisk terdeteksi, Anda tinggal menginstalasi sistem operasi Windows XP tersebut seperti
biasa. Kalau boleh ngasih saran nih, sebaiknya dibagi tiga saja partisinya. Ada koq, menunya untuk
membuat partisi pas instalasi Windows XP akan dimulai.

Adhitya F. Anggoro

Tanya Upgrade Lagi

Milisi Mailplus, saya mau upgrade komputer. Budget yang tersedia sekitar dua juta rupiah. Maksud
hati, saya ingin membeli prosesor AMD Athlon XP, motherboard dengan chipset nForce-2, juga memori.
(Kalau dananya masih mencukupi, saya inginnya yang 512MB).

Tolong sarannya ya, saya ingin membeli Athlon XP 2600+. Masalahnya, prosesor ini masih Thorouhbred
atau sudah Barton? Lalu ciri-ciri yang dapat membedakan fisiknya Barton dengan Thoroughbred apa?

Untuk motherboard-nya, saya sih kepinginnya memakai keluaran Epox atau Abit. Yang bagus tapi
cukup terjangkau dari kedua merek tersebut kira-kira seri yang mana ya? Untuk memorinya sendiri, yang
kompatibel untuk Epox dan Abit itu yang merek apa? Terus apakah HSF bawaan sudah memadai untuk
kondisi tak ter-overclock? Kalau nggak, ada yang mau merekomendasikan? Harganya berapa?

Satu lagi. Komponen saya yang lama de-
ngan spesifikasi Pentium-III 866MHz dengan
motherboard Asus TUSL2-C (lengkap dengan
dus, manual, dan CD driver), memori SDRAM
Visipro PC133 256MB, VGA PixelView GeForce-2
MX400 (juga masih lengkap) kira-kira laku
berapa ya kalau di jual? Maksud saya untuk
tambahan beli VGA atau harddisk baru.

0340069

Jawab:
Biasanya sih, kalau prosesor Barton dijual

dengan embel-embel FSB 333MHz atau L2
Cache 512KB. Untuk fisiknya sih agak sulit untuk membedakan. Yang jelas, Anda perhatikan saja kode
(nomor seri) prosesor tersebut.

Untuk motherboard, coba pakai seri NF5-S v2 dari Abit atau 8RDA3+ dari Epox. Harganya relatif
terjangkau koq. Buat memorinya, kalau dana tidak mencukupi untuk beli Corsair, coba pakai Kingston
atau Apacer. Yang penting PC3200. Kemarin ini, saya baru ngambil Kingston KVR PC3200 512MB seharga
625 ribu. Mungkin besok-besok sudah turun lagi tuh harganya. Kompatibilitas memori ini cukup luas koq.

Sedangkan HSF bawaan, kalau untuk sistem dalam kondisi standar, heat sink itu biasanya sudah
cukup memadai koq. Yang penting memasang HSF-nya harus benar dan mengoles thermal paste-nya juga
harus baik. Kalau bisa dioleskan secara tipis, setipis kulit ari.

Mengenai PC lama Anda, mungkin kalau dijual sekitar 750 ribu sampai 1 juta sih masih laku tuh. Cek
aja di bursanya Bhinneka.com atau lihat-lihat di iklanbaris.co.id.

Adhitya F. Anggoro, Diovan

home page untuk Internet Explo-
rer orang lain saya lupa. Kalau ti-
dak salah di http://
www.hotscripts.com ada tuh.
Search aja dengan keyword
"homepage". Biasanya ntar
ketemu deh. Banyak pilihannya
di sana.

Ngomong-ngomong, kalau

saya sih belum berani masang ini
di situs yang saya bikin. Kayak
situs kita hebat aja mau dijadiin
halaman utama web orang lain.
Kalau ada yang mau memasuk-
kan situs kita ke alamat Favorites
mereka saja sudah bagus.

harry lovesomeone, LuckyGuy354

✔

+

✔

+

✔

+

✔
+

+

✔

+
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Bagi perusahaan yang ingin produknya diulas pada rubrik ini, silakan kirim produk tersebut ke alamat Redaksi. Produk yang dikirimkan sebaiknya merupakan paket penjualan,
sesuai dengan yang akan dipasarkan. Sertakan pula informasi detail mengenai produk, nama distributor, telepon yang dapat dihubungi, dan kisaran harga produk tersebut untuk

end-user. Kami tidak memungut biaya apapun untuk produk yang dimuat, sedangkan pengujian dilakukan berdasarkan produk yang kami terima terlebih dahulu.

648 Neo:

Motherboard untuk
Stand Alone dari MSI

Corexindo Jaya Lestari
www.msi.com.tw
☎ (021) 6127464

78 dolar AS
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Albatron KX600S Pro:

Mobo VIA KT600 yang
Ringkas, Lengkap, dan Stabil

Internasional Computer
www.albatron.com.tw

☎ (021) 6242709
± 65 - 70 dolar AS

SysMark 2002
Rating :267
Internet Content :340
Office Productivity:209

SisoftSandra 2004
CPU Arithmetic
Dhrystone ALU (MIPS) :8238
Whetstone FPU (MFLOPS):3434

CPU Multimedia
Integer (it/s) :20105
Floating Point (it/s) :20686

Memori Bandwidth
Integer Buffered (MB/s) :2936
Float Buffered (MB/s) :2715

PCMark 04
Score :3700
CPU :3703
Memory :2453
Graphics :3782
HDD :3316

TMPG Encoder (detik) :2292
Sound Forge (detik) :63,812

Quake3 Arena
Normal (fps) :317,2
High Quality
1024x768 (fps) :290,6

3D Mark 2001
640 x 480  16bit :16132
1024 x 768  32bit :13077

Di penghujung
tahun lalu, Albatron
Technology akhirnya merilis seri
produk motherboard-nya yang
menggunakan chipset VIA
KT600. Kombinasi chipset yang
terpasang adalah northbridge
VIA KT600 dengan southbridge
VIA VT8237.

Kombinasi dari kedua chip
utama ini dapat meyediakan
dukungan prosesor AMD
generasi K7 mulai dari AMD
Duron hingga Athlon XP dengan
core Barton yang menggunakan
FSB 400. Untuk mengoptimalkan
sistem, VIA juga sudah mampu
memaksimalkan bandwidth
memori pada chipset KT600
sehingga sangat sepadan bila
memori DDR400 dipadukan
dengan prosesor AMD yang
menggunakan FSB400 di
motherboard ini. Meskipun
demikian, chipset ini juga tentu
backward compatible dengan
modul memori DDR jenis
DDR266 dan DDR333.

Motherboard ini juga
mewarisi kemampuan standar

produk-produk pendahulunya.
Fitur-fitur yang tersedia pada
board adalah OTP untuk
mencegah kerusakan fatal akibat
tingginya temperatur dan Watch
Dog Timer untuk menjaga BIOS
gagal booting.

Untuk lebih
memanjakan

pengguna sistem
berbasis AMD
nantinya, pada
motherboard ini juga sudah
dilengkapi dengan fitur Serial ATA
RAID, ATA 133, 6 Channel Audio, 8
buah port USB 2.0, kontroler 10/
100 LAN dari 3Com, DDR400,
FSB400, AGP 8X, dan jaminan
garansi 3 tahun dari vendornya.

Sebagai fasilitas ekspansi,
lima buah slot PCI, dua port IDE,
dua port Serial ATA, dan tiga slot

DDR DIMM tersedia. Penampilan
I/O panel di bagian belakang
motherboard ini cukup standar.
Hanya ada sepasang port PS/2,
USB, LAN, COM, sebuah port LPT,
Game/MIDI, serta Audio.

Namun demikian,
untuk mother-

board
KX600S Pro

ini, Albatron
tidak memberi-

kan spesifikasi PCB berukuran
penuh. Sebuah board ATX ber-
form factor ukuran 20 x 29,3 cm
sudah cukup untuk menampung
semua kelengkapan yang tersebut
di atas. Tetapi tentunya, ada yang
dijadikan korban dengan kondisi

ini. Tata letak komponen kompo-
nen seperti slot AGP, memori, port
catu daya, dan lain-lain menjadi
sangat berdekatan. Ini dapat
merepotkan pengguna yang se-
ring membongkar pasang PC-nya.

Dari sisi kinerja, produk
dengan chipset VIA KT600 ini
sudah mampu produk yang
menggunakan chipset nForce-2
Ultra 400. Bahkan produk
motherboard ini memiliki nilai
lebih yaitu di sisi harga bila
dibandingkan dengan pesaingnya
yang menggunakan chipset
nVidia. Dengan tingkat stabilitas
yang baik serta didukung
kelengkapan yang sangat
memadai, tentunya Albatron
KX600S Pro ini cukup menarik
untuk dimiliki.

Produk ini kami uji dengan
prosesor AMD Athlon XP 3200+
yang memiliki FSB400MHz dengan
clock speed 2200MHz, dua keping
memori Kingston DDR PC-3200
masing-masing berkapasitas
512MB, kartu grafis Albatron
FX5700 Ultra 128MB, dan harddisk
Seagate Barracuda 7200.7
kapasitas 40GB.

Sistem operasi yang kami
pasang adalah Windows XP
Professional dengan Service Pack 1
serta software benchmark antara
lain Sysmark 2002 untuk aplikasi
sehari-hari, Sisoft Sandra 2004 dan
PCMark 04 sebagai aplikasi uji
sintetik, TMPGEncoder untuk
mengolah video, Sound Forge
untuk mengolah audio,

ARE/PCplus

serta Quake 3 Arena dan
3DMark2001 untuk menguji
kinerja grafis berbasis OpenGL
dan Direct 3D. (fmn)

MSI yang mencatat
kesuksesan tahun lalu
memang mengeluarkan begitu
banyak produk motherboard
dengan chipset mutakhir. Salah
satu produknya yang bisa didapat
dengan harga lumayan
terjangkau adalah 648F Neo.
Dari sisi fitur yang ditawarkan,
produk dengan warna dasar
merah ini memang tidak
secanggih produk sejenis yang
menggunakan chipset yang lain.
Ini misalnya ditandai dengan tidak
adanya fitur teknologi dual
channel untuk memori yang
digunakan. Maklum, chipset
Northbridge SiS 648FX yang
digunakan memang tidak
mendukung teknologi tersebut.
Namun demikian, 648F yang
sudah mendukung sistem dengan
Front Side Bus 800MHz untuk
prosesor Intel ini telah mendu-
kung sistem hyper-threading.

Dari sisi kelengkapannya, 3
buah soket DIMM yang disertakan
mampu mendukung secara penuh
hingga 3GB memori DDR hingga

PC-3200. Sementara, yang paling
menonjol dari produk ini adalah
banyaknya jumlah slot PCI yang
dimilikinya sehingga pengguna bisa
menampung kartu add on lebih
banyak. Tak ketinggalan sebuah
port AGP dengan mode maksimal
hingga 8X disertakan pada
board-nya.

Nampaknya, MSI sengaja
merancang produk yang
menggunakan AMIBIOS ini untuk
penggunaan standar namun
dengan performa lumayan.
Selain fitur standar, tidak
ada fitur tambahan
berarti yang disertakan.
Untuk kepentingan
koneksi di dalam
sistem jaringan
misalnya,
penggunanya harus
menambahkan
kartu jaringan
tambahan
lantaran
produsennya
sama sekali
tidak

menyertakan controller jaringan
sama sekali. Begitu pula untuk
urusan perangkat interface. Selain 4
buah port USB 2.0 plus 2 port
dengan braket tambahan dan port-
port standar lainnya, tidak terlihat
adanya fitur tambahan seperti
layaknya motherboard mutakhir.
Hanya controller audio onboard
dari kelas Realtek ALC655 saja yang
terlihat menonjol karena MSI
menyertakan sebuah braket
tambahan yang

menampung jack S/PDIF tipe coaxial
berserta jack analog line out.
Artinya, pengguna bisa menikmati
tata suara audio 5.1 dengan kualitas
memadai tanpa perlu perangkat
kartu suara tambahan.

PCplus menguji produk ini
dengan menggunakan Pentium-4
3GHz FSB 800MHz, memori
Kingston PC-3200 1GB 2 keping,
harddisk Barracuda 7200.7 40GB,
kartu grafis Albatron GeForce
FX5600 Ultra, dan power supply
Enlight 420w. Sementara, driver
yang digunakan adalah driver SiS
AGP versi 117 dan IDE 203 dengan
VGA driver versi 52.16. Dari
performa kerjanya, produk ini
memang tergolong standar. Skor
yang dihasilkan harus diakui tidak
setinggi produk sejenis yang pernah
diuji meski internal clock default
yang dipakai tergolong tinggi yaitu

sebesar 3015,28MHz.
Namun, untuk
kestabilan sistemnya,
produk ini boleh
diacungi jempol
lantaran lulus semua
tes dengan sangat
mulus.

Pada kemasan
jual, selain
menyertakan buku
manual yang
sangat lengkap,
disertakan pula
sebuah CD driver
plus braket
tambahan serta

SysMark 2002
Rating :307
Internet Content :427
Office Productivity:221

3D Mark 2001
640 x 480  16bit :15313
1024 x 768  32bit :12548
1600 x 1200  32bit :12508

3D Mark 2003
640 x 480 :6165
1024 x 768 :3917
1600 x 1200 :2117

Quake III Arena Demo 001
640 x 480  normal :362,5fps
1024x768 high quality:355,5fps
1600x1200high quality :173,6fps

TMPG encoder
37 menit 13 detik
(lebih cepat lebih baik)

kabel data standar.
Buat kalangan rumahan, MSI

648F Neo ini memang cocok untuk
penggunaan standar namun
dengan teknologi mutakhir yang
cukup mumpuni. Apalagi harga
yang cukup terjangkau yang
ditawarkan memang jadi nilai plus
dari produk yang satu ini.
Sementara, untuk pengguna
kantoran yang terhubung dalam
sistem jaringan berbasis kabel
nampaknya harus berpikir ulang
karena LAN onboard hanya
bersifat optional saja. (sil)

ARE/PCplus



Cordless MX Duo:

Sepasang Keyboard dan
Mouse untuk Kenyamanan

Kerja dan Hiburan

Soca Marketing
www.logitech.com
☎ (021) 6347638
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Perkembangan
aplikasi yang dapat
diakomodasi oleh perangkat
komputer memberi ide buat
Logitech untuk
mengembangkan periferal
yang mampu membuat
pengguna PC lebih nyaman
dalam bekerja. Salah satu yang
sudah marak digunakan adalah
system keyboard dan mouse
yang berbasis wireless. Produk
semacam ini yang dimiliki oleh
Logitech salah satunya adalah
Cordless MX duo.

Produk yang berwarna
dasar hitam dan perak ini
memang tergolong cukup
lengkap. Sistem wireless yang
memanfaatkan frekuensi
2,4GHz yang digunakan
membuat penggunanya bisa
melakukan pengetikan
ataupun aplikasi program yang
lain tanpa dibatasi oleh
panjang kabel mouse maupun
keyboard.

Selain mengusung dua
tombol kiri dan kanan  serta
sebuah scroll seperti pada
mouse modern standar, mouse
Cordless MX 700 yang
disertakan juga dilengkapi
dengan dua tombol untuk
mengarahkan tampilan pada
layar untuk kecepatan
pembacaan halaman yang
memanjang. Sementara, satu
tombol lain di bagian tengah
dapat difungsikan untuk

kemudahan dalam membuka
beragam aplikasi program yang
tengah dijalankan. Mouse yang
menggunakan dua buah baterai
rechargeable jenis AA ini juga
memiliki dua tombol tambahan
di bagian samping kiri yang
dapat difungsikan sebagai
tombol back dan forward ketika
membuka halaman situs.
Menariknya, disertakan pula
sebuah lampu LED pada bagian
atas yang akan menyala jika
tenaga baterai yang digunakan
hamper habis. Untuk koneksi
dengan receiver wireless-nya,
pada bagian bawah mouse yang
menggunakan sensor LED ini
disertakan sebuah tombol yang
juga dapat berfungsi untuk
memilih channel frekuensi yang
dipakai. Sayangnya, respons
mouse terkadang masih kurang
mampu menangkap pergerakan
kecil yang dilakukan. Kekurangan
semacam ini memang tipikal dari
mouse berbasis optik untuk
sensor gerakan.

Sementara, keyboard Cordless
Elite yang diusung sepertinya
memang diperuntukkan buat
pengguna yang menggunakan
banyak aplikasi multimedia. Selain
tombol-tombol standar,
disertakan pula beragam tombol
yang dapat difungsikan dengan
menginstal driver dari Logitech.
Menarik untuk diperhatikan
adalah tombol-tombol khusus
multimedia untuk menggantikan

peran mouse pada bagian
tengah. Selain dapat
memilih software
multimedia yang
digunakan, disertakan
pula tombol untuk
menjalankan aplikasi
multimedia tersebut,
lengkap dengan tombol
volume suaranya.

Untuk aplikasi lain
semisal membuka e-mail,
messenger, Webcam, pada bagian
kiri disertakan tombol-tombol
khusus. Bagian ini juga
menyertakan dua buah tombol
tambahan untuk surfing yang
lebih cepat plus sebuah scroll yang
untuk membuka halaman panjang
yang lebih cepat. Sementara, di
bagian kanan Cordless MX Duo
menyertakan 5 buah tombol
tambahan untuk surfing yang
lebih cepat dan nyaman yang
dapat berfungsi sebagai

pengganti
peran mouse.

Pada kemasan jual, selain
disertakan sebuah adapter dan
sebuah receiver yang juga bisa
berfungsi sebagai charger,
Logitech juga menyediakan
sebuah driver lengkap. Untuk
interface dengan PC atau
Macintosh, selain menggunakan
konektor USB, disertakan pula
adapter PS/2 untuk mouse dan
keyboard.  Buat pengguna PC
maupun Macintosh yang memiliki
banyak aplikasi multimedia dan

biasa mengakses Internet,
produk ini memang bisa jadi
pilihan menarik untuk
kenyamanan dan akses Internet
yang lebih cepat. (sil)

ARE
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RALAT: Produk Logitech Joystick
Attack 3 yang diulas pada
PCplus edisi 158 adalah kiriman
dari Soca Marketing.
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Creative Inspire GD580:

Membajak Air Force One,
Memburu Presiden AS

Astrindo Senayasa
www.creative.com
☎ (021) 6121330

Photon PF2 Series:

Mobo yang Sertakan
Chip BIOS Cadangan

ECS Indonesia
www.ecs.com.tw
☎ (021) 6282048

165 dolar AS

ECS yang
merupakan satu dari
empat besar produsen
perangkat komputer di Taiwan
tahun 2003 lalu memang
gencar sekali mengeluarkan
produk-produk yang
menggunakan chipset
mutakhir. Salah satu yang
sekarang jadi andalannya
adalah tipe Photon PF2 yang
menawarkan sistem multimedia
terintegrasi.

Datang dengan
mengusung chipset bikinan
Intel yaitu 865G, ECS memang
memproyeksikan sistem ini
menggunakan teknologi
mutakhir. Misalnya: Front Side
Bus sebesar 800MHz, sistem
dual channel, serta dukungan
penuh terhadap penggunaan
memori jenis double data rate
PC-3200 atau varian di
bawahnya. Sementara, empat
buah soket DIMM 184 pin yang
diusungnya mampu
menampung hingga 4GB
memori jenis DDR. Selain itu,
Northbridge yang dimilikinya

Aksi dar-der-dor
mengawali pembajakan
pesawat kepresidenan Amerika
Serikat, Air Force One.
Targetnya adalah memburu
orang nomor satu negara
adidaya tersebut. Sudah
demikian ketat, sistem
keamanan tingkat satu
berstandar sangat Amerika, toh
masih kebobolan juga. Pesawat
yang dilengkapi peralatan nan
canggih itu tak berdaya
memerisai dirinya. Pembajak
berhasil menguasai pesawat!

Bunyi saling tembak antara
pembajak dengan pengawal
presiden itu muncul dari
speaker multimedia Creative
Inspire GD580, yang berkanal
5.1, terdiri dari tiga speaker
untuk kanal kanan-tengah-kiri
depan, dua untuk kanal kanan-
kiri belakang dan satu
subwoofer untuk memunculkan
nada rendah. Kelima speaker
satelit itu diklaim berdaya
masing-masing 6 watt RMS,
sementara subwoofer 17 watt
RMS.

Yang menarik pada paket
Creative
Inspire GD580
ini adalah
disertakannya
decoder yang
telah
mendukung
tata suara
Dolby Digital
dan DTS.
Dengan adanya

decoder itu sistem koneksi bisa
lebih leluasa. Artinya tak hanya
melalui PC tapi juga bisa di-
koneksikan langsung ke pemutar
(player) semisal DVD player.

Menghubungkan player atau
PC ke decoder mudah dilakukan
karena disediakan masukan
digital optic, coaxial, dan analog.
Sebagai contoh bisa digunakan
kabel digital optik atau coaxial
saat menghubungkan pemutar

CD, MD, VCD, DVD yang
meyediakan kedua keluaran
digital itu ke masukan digital
pada decoder. Sementara dari
decoder ke subwoofer sebagai
terminal untuk mendistribusi
kelima speaker satelit dapat
dilakukan secara analog. Kabel-
kabel interkoneksi
antarperangkat, baik yang optik,
coaxial, maupun analog tersebut
tersedia pada paket GD580. Dan,

seluruh mode
pengoperasian termasuk
mengatur besaran
volume bisa dilakukan

melalui remote control.
Uji dengar kemampuan

speaker Creative Inspire GD580
ini kami awali dengan memutar
film Air Force One menggunakan
pemutar DVD dengan koneksi
optik. Bunyi saling tembak di
kabin pesawat direpro tajam
menyerang telinga oleh speaker.
Begitu pun teriakan panik
penumpang terdengar cukup
jelas. Film bertata suara Dolby
Digital 5.1 ini direspon baik oleh
decoder yang langsung memberi
tanda Dolby Digital pada lampu
petunjuknya, bahwa sinyal audio
itulah yang sedang beroperasi.

Setelah film, kami putar
audio CD stereo dari rekaman
apik Chesky Records yang
menampilkan vokal Rebecca
Pidgeon dalam lagu “Spanish
Harlem”. Vokal Pidgeon direpro
cukup terbuka meski agak tajam,
sementara, bunyi bas agak
berefek gentong. Ketika kami
pilih mode Pro Logic II music,
vokal terdengar terbuka dan
lebih lembut, dibanding pilihan
PL II movie. Namun, kami lebih
bisa menikmati vokal Pidgeon

dalam mode stereo dengan
staging yang cukup jelas.

Kami lanjutkan dengan
DVD musik salah satu konser
George Benson bertajuk
“Absolutely Live”. DVD musik
ini bertatasuara DTS 5.1, Dolby
Digital 5.1, dan Dolby Stereo.
Langsung kami pilih lagu
“Deeper Than You Think”.
Saling sahut antara petikan
gitar Benson dengan kepiawai-
an Joe Sample menjentik tuts
piano dalam opsi DTS terdengar
menawan. Kembali decoder
bekerja baik karena secara
otomatis memilih mode DTS.
Sementara, speaker merepro
instrumen musik ini tajam, dan
sesekali terdengar efek gentong
pada nada bas. Pilihan DTS
terasa lebih terbuka dibanding
Dolby Digital ketika memainkan
musik, sehingga suasana di
Waterfront Hall, Belfast terasa
hadir di tengah kami. (fon)
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juga memungkinkan
disertakannya port AGP hingga
mode 8X untuk tampilan grafis
yang lebih baik, meski produk ini
juga sudah menyertakan fitur
VGA onboard dari kelas Intel
extreme graphics.

Menarik diperhatikan adalah
banyaknya fitur yang diusung
produk yang juga menyertakan
dua buah port serial ATA untuk
harddisk teknologi terkini ini.
Selain 6 buah slot PCI yang
disertakan, ECS menyertakan
pula fitur LAN onboard, serta
sebuah port firewire 1394, selain
juga kartu suara onboard yang
mendukung sistem 6 channel dari
kelas CMI9739A.

Keistimewaan produk
mengusung heatsink fan dengan
lampu lampu yang atraktif  ini
adalah disertakannya sebuah chip
BIOS cadangan untuk antisipasi
kegagalan dalam meng-update
BIOS. Tidak seperti produsen lain
yang menyediakan mekanisme
recovery BIOS ataupun sistem
dual BIOS, ECS lebih memilih
menyertakan chip tambahan

untuk mengatasi kegagalan
update BIOS-nya.

Dari sisi BIOS yang
disertakan, Photon PF2
menyertakan fitur khusus
berupa Photon Turbo Mode yang
terdiri dari 3 fitur khusus yaitu
Fast Chip Select, CPC Address/
Control, dan Turbo Mode.
Sementara, untuk urusan
overclock, Phoenix-AwardBIOS
yang digunakannya ini
mengusung fitur yang cukup
menarik. Selain kenaikan FSB
hingga kecepatan 250MHz,
urusan frekuensi memori, PCI,
AGP, dan SATA juga dipikirkan.
Untuk fitur-fitur ini tersedia
pilihan clock frekuensi yang tetap
meski clock FSB dinaikkan atau
disesuaikan dengan kenaikan
FSB. Dengan demikian, kinerja
prosesor bisa diperas habis tanpa
perlu menaikkan clock memori
dan perangkat penting lainnya.
Pada kemasan jualnya, selain
menyertakan sebuah buku
manual lengkap dan CD driver,
ECS juga menyertakan kabel
kabel data termasuk kabel SATA.

PCplus
menguji produk ini dengan test
bed standar yaitu Pentium-4
3GHz FSB 800MHz, memori
Kingston PC-3200 1GB, harddisk
Barracuda 7200.7 40GB, power
supply Enlight 420W, dan
monitor Samsung SyncMaster
NF990. Dari hasil uji yang
dilakukan, terlihat kinerjanya
yang rata-rata dibanding produk
sejenis. Tidak ada skor yang
terlalu istimewa dari produk ini,
meski bila dibanding produk
chipset yang menggunakan VGA
onboard lainnya hasil yang
tampak cukup tinggi.

Buat pengguna yang
berkantong agak tipis, produk ini
memang cukup menarik. Selain
banyak fitur yang ditawarkan,
pengguna juga bisa meng-
eksplorasi lebih jauh dengan BIOS
pintar yang ditawarkan. (sil)

SysMark 2002
Rating :311
Internet Content :429
Office Productivity:226

3D Mark 2001
640 x 480  16bit :4204
1024 x 768  32bit :2883
1600 x 1200  32bit :1424

Quake III Arena Demo 001
640 x 480  normal :142,6fps
1024x768 high quality:76,2fps
1600x1200high quality :23,3fps

TMPG encoder
36 menit 53 detik
(lebih cepat lebih baik)

ARE/PCplus
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Dari Salesman ke Creative Director
T.J. Setyoadi

dino@e-pcplus.com

S

Belajar secara
otodidak bisa

mengubah nasib dan
jalan hidup.

Pilihannya adalah
mau serius atau tidak!

Serius ya berhasil,
tidak serius ya terlem-
par. Diwarnai dengan
nasib yang agak mu-
jur, jadilah keteram-
pilan otodidak seba-
gai penopang hidup.

aya punya
teman yang
“cukup kaya”,
sebut saja Godik, dia

punya beberapa perusahaan yang
bergerak di bidang komputer dan
real estate (itu yang saya tahu,
yang lainnya saya nggak tahu).
Bahkan karena sudah “cukup
kaya”, dia pernah lupa pada
sebuah villa yang dimilikinya.

Dia terheran-heran ketika
pada suatu hari ada seseorang
yang datang kepadanya dan
menyarankan agar villa-nya
diperbaiki. “Lho memang itu villa
siapa?” tanyanya. “Ya villa Bapak,”
ujar orang tersebut yang ternyata
sang penjaga villa.

Tapi cerita kali ini memang
bukan tentang Godik, tapi
seorang pegawainya yang tadinya
punya jabatan sales komputer di
tokonya, sebut saja Joko (nama
fiktif, tapi karakter dan kejadian-
nya nyata). Saya memang cukup
dekat dengan dia, sebab untuk
urusan dengan komputer dia yang
mewakili teman saya. Orangnya
cukup luwes dan pandai bergaul

Satu hal yang saya ingat
adalah dia sangat suka sekali
mengutak-atik software 3 dimensi
yang pada saat itu (tahun 1992)
masih cukup langka. Kalau nggak
salah saat itu adalah 3DS Max
yang versi 2 atau 3, saya agak lupa,
atau bahkan mungkin sama sekali
bukan 3DS Max.

“Saya sangat suka sekali
dengan animasi, entah itu sekadar
gambar ataupun bentuk 3 dimensi.
Coba lihat ini!” ujarnya sambil
menunjuk hasil karyanya yang
berbentuk burung 3 dimensi
walaupun sederhana. Saat itu dia
menunjukkan bahwa burungnya
tersebut dapat berlari. “Kalau mau
lihat kerangka tinggal klik ini, kalau
mau lihat ada warna dan teksturnya
tinggal klik ini. Tapi kalau bentuk
dan teksturnya rumit, butuh waktu
sampai 2 hari untuk me-render-
nya,” ujarnya penuh semangat.

Saya pikir dia mempelajari
software tersebut hanya untuk
menarik pelanggannya. Buat apa
sales komputer belajar software 3D?
Memang, pada saat itu komputer
(yang paling canggih saat itu Intel
486) yang bisa menampilkan
gambar 3 dimensi, apalagi animasi 3
dimensi, membuat orang sangat
terkagum-kagum.

Tapi ternyata saya keliru besar.
Dia memang sangat antusias de-
ngan komputer 3D. Dia mempela-
jari secara otodidak. Memang rasa
estetika cukup tinggi, terbukti dia
selalu dipercaya oleh bosnya untuk
mendesain brosur. Hasilnya sangat
bagus, mengingat jabatan dia
adalah seorang salesman komputer.

Tak dinyana, pada tahun 1994,
dia diterima oleh sebuah stasiun
televisi swasta yang cukup
terkemuka (mana ada stasiun
televisi swasta tidak terkemuka). Dia
diterima sebagai marketing. Nah,
sejak saat itu saya tidak pernah
mendengar kabarnya lagi.

Namun sekitar tahun 1997,
saya dapat kabar dari Godik, bahwa
sekarang Joko sudah cukup sukses.
Dia pernah dikirim ke Amerika dan
beberapa kali ke luar negeri. Lho,
memangnya ada program ke luar
negeri untuk marketing? “Oh,
tidak. Tapi Joko dikirim ke luar
negeri untuk belajar video editing
dan animasi,” ujar Godik. Wah,
ternyata apa yang semula menjadi
hobi, ternyata membawa kemajuan
bagi dirinya. “Sekarang Joko sudah
tidak di posisi marketing lagi, tapi
sudah di bagian editing dan

sekaligus membuat animasinya,”
ujar Godik lagi.

Tahun 1998, saat krisis moneter
melanda Indonesia dan dolar naik
gila-gilaan, Godik berpikir alangkah
senangnya kalau punya penghasilan
dolar. Kebetulan saat itu stasiun
televisi swasta yang diikuti Joko
pindah markas besar ke Jakarta. Hal
itu sangat merisaukan Joko yang
sangat tidak suka hidup di Jakarta.
Bagai gayung yang bersambut,
Godik mengajak Joko untuk
mendirikan sebuah perusahaan
desain grafis yang bergerak di
bidang animasi dan desain Web.

Walhasil, kini Joko menjalan-
kan perusahaan grafis tersebut

sebagai partner dari Godik. Bayang-
kan, dari salesman komputer yang
hobi utak-atik software 3 dimensi,
kini menjadi partner bosnya. Semua
hanya gara-gara utak-atik software
3 dimensi! Bahkan perusahaan
desain grafisnya boleh dibilang
yang paling top di Surabaya.

DARI JOGJAKARTA
Sebetulnya saya ingin

mengajak Joko dalam workshop 3
dimensi yang akan diadakan
tanggal 23-24 Januari mendatang di

Surabaya, tapi sayangnya dia punya
kesibukan yang tidak bisa
ditinggalkan. Akhirnya saya
mengajak Mas Kelik, seorang teman
adik saya yang kebetulan kuliah di
Jogja. Prestasinya di bidang
membuat film animasi 3 dimensi
boleh dibilang cukup pesat, bahkan
mungkin yang paling maju di
Indonesia saat ini.

Penghargaan pertama yang
diraih adalah Konfiden Award 2002
sebagai film favorit pilihan
penonton, lalu Kuldesak Award
2002 di Festival Film Video Indonesia
sebagai penghargaan khusus untuk
“kegilaan animasi dalam bercerita”.
Film ini juga diputar saat

pelaksanaan Jakarta International
Film Festival 2002.

Sejak saat itu, Mas Kelik yang
berbendera Studio Kasatmata
(PCplus edisi 158) ini makin malang
melintang di dunia animasi. Sudah
banyak klip video, iklan, dan film
pendek yang dihasilkannya selama
dua tahun terakhir ini.

Pada awal tahun 2003, Studio
Kasatmata me memperoleh
penghargaan Visi Anak Bangsa
Award 2003 karena dianggap
sebagai ’kelompok yang tahu

berkarya dengan teknologi tepat
guna, inovatif, dan punya good
manajemen.’

Selama Studio Kasatmata
berproduksi menyelesaikan film,
pada bulan Mei hingga September
2003, Visi Anak Bangsa
mengadakan kegiatan Anime
Goes to School (Toward to VAB
Award 2003) yaitu pengenalan
animasi kepada pelajar SMU di
wilayah DKI Jakarta disertai dialog
interaktif dengan kreator film.
Secara bergantian para kreator
film HOMELAND mengikuti
roadshow ini untuk berbagi cerita
dengan para pelajar 10 SMU di
wilayah DKI Jakarta. Bulan
Oktober 2003 tepatnya tanggal 19,
di Japan Foundation Jakarta
diadakan seminar film animasi
‘Keajaiban Animasi’ yang masih
menjadi satu rangkaian dalam
program kerja Visi Anak Bangsa
Award 2003.

Bulan Januari 2004, bekerja
sama dengan Tabloid PCplus
difasilitasi oleh Hi-Tech Mall
Surabaya dan disponsori produsen
motherboard no. 1 yaitu ASUS dari
Astrindo, harddisk andal Seagate,
casing Simbadda, dan tak lupa
Microsoft, Studio Kasatmata
menjadi instruktur dalam work-
shop animasi 3D.

Workshop ini diadakan di Hi-
Tech Mall Surabaya, tanggal 23-24
Januari 2003. Anda bisa mendaftar
pada perwakilan PCplus Surabaya,
Jl. Raya Gubeng 98, dengan Nurul
atau Mualim, telepon 031-
5049492, atau dengan Mbak Ririn,
Hi-Tech Mall, parkir mobil Lt. 1 THR
Surabaya Mall Jl. Kusuma Bangsa
116-118, telepon 031-5316557.
Bagi peserta luar Surabaya dapat
menghubungi Adi Baskoro 081
846 7353 atau Markus 0856 335
4313.

Kapan lagi Anda berkesem-
patan untuk belajar langsung dari
pembuat film animasi untuk layar
lebar yang pertama di Indonesia?
Segera daftarkan diri Anda jangan
sampai kehabisan tempat. Sampai
tulisan ini ditulis, sudah ada pen-
daftar dari Papua dan Ambon. PC+

Contoh jenis karya 3 dimensi. Dengan belajar otodidak pun, Anda
tetap berkesempatan meraih sukses yang lebih besar dibanding
mereka yang belajar formal. Modalnya ketekunan dan kreativitas, plus
imajinasi yang sedikit liar.
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Broken Sword: The Sleeping Dragon
Petualangan Penuh Teka-Teki

S

Seri game Broken
Sword mungkin tak
asing lagi bagi para

pecinta game
petualangan. Broken

Sword merupakan
sebuah game

petualangan klasik
yang dilengkapi

dengan teka-teki
(puzzle). Setelah

tampil dalam bentuk
2D pada seri pertama

dan keduanya, kini
seri terbarunya yang

berjudul Broken
Sword: The Sleep-
ing Dragon tampil

lebih menawan
dengan sentuhan 3D.

eperti dua
versi
sebelumnya,
tokoh utama

diperankan oleh George Stobart,
seorang pengacara
berkebangsaan Amerika, ditemani

dengan seorang wanita Perancis
bernama Nicole Collard,
panggilannya Nico, yang
berprofesi sebagai jurnalis sebuah
surat kabar.

Cerita berawal ketika George
sedang dalam perjalanan ke Congo
untuk menemui kliennya yang
bernama Cholmondely, seorang
ilmuwan yang berhasil
mengembangkan sebuah mesin
yang dapat menghasilkan energi
tak terbatas. Pada saat George tiba
di tempat, di sana ia melihat sang
ilmuwan telah tertembak mati. Di
lain tempat, yaitu di Paris, Nico
sedang menyelidiki sebuah kasus.
Kemudian, ia dikirim oleh
perusahaannya untuk
mewawancarai seorang hacker
profesional, namanya Vernon Blier,
yang telah berhasil memecahkan
kode manuskrip pada sebuah arca
kuno. Vernon berniat untuk
bercerita mengenai rahasia akhir
jaman yang diketahuinya kepada
Nico. Sayang sekali, sebelum sempat
bercerita, ia mengalami nasib yang
sama dengan sang ilmuwan,
dibunuh.

Keingintahuan untuk
memecahkan kasus tersebutlah
yang kemudian mempertemukan
George dan Nico. Mereka harus
berhadapan dengan sosok jahat
bernama Susarro yang berniat
membangkitkan kekuatan energi

dahsyat seekor
naga dengan
mesin sang
ilmuwan. Dalam
game ini, tujuan
kita adalah
menyelidiki dan
menghentikan
niat jahat Sussaro.
Ada lagi satu
tokoh bernama
Bruno di sini.
Bruno lah yang
akan membantu
George
menemukan

kebenaran mengenai pembunuhan
sang ilmuwan.

Dulu, game ini identik dengan
permainan yang klik sana-klik sini.
Dengan adanya perubahan transisi

ke tampilan 3D, cara bermain kita
pun ikut berubah. Jika tadinya kita
bermain dengan pointer mouse,
sekarang kita hanya perlu
menggunakan keyboard atau
sebuah controller pad untuk
mengontrol karakter secara
langsung sekaligus berinteraksi baik
dengan objek sekitar maupun
dengan karakter lainnya.

Untuk interaksi pemain dengan
objeknya, pengembang telah
memberikan kemudahan. Hal ini
dibuktikan dengan adanya gambar
ikon bersinar pada objek-objek
yang dianggap bermanfaat.
Dengan begitu kita tak perlu repot-
repot menyelidiki setiap objek yang
ada di sekitar kita.

Ketika mendekati sebuah
objek, kita akan melihat 4 tombol di
pojok kanan bawah layar monitor
berubah menjadi simbol-simbol
bergambar. Contohnya, jika kita
berdiri disamping sebuah tuas, akan
muncul simbol roda bergerigi.
Tombol tersebutlah yang bisa kita
pakai untuk menarik tuas.

Dalam game ini, ada banyak
simbol yang dipakai. Tiap simbol
memiliki satu arti. Misalnya, simbol
jari tangan menandakan bahwa kita

bisa mengambil objek yang ditunjuk
atau berada di dekat kita. Atau
seperti pada saat kita mendekati
sebuah pintu, akan muncul simbol
daun telinga, pintu terbuka dan
simbol mata. Kira-kira
melambangkan apa, ya? Kita pasti
bisa menebaknya kalau sudah
mencoba game ini.

Selain harus mencari tahu
mengenai berbagai jenis objek yang
bisa membantu penyelidikan, kita
juga harus mencari berbagai
petunjuk dari karakter lain – biasa
disebut NPC (Non-Playable Charac-
ter) -  yang memiliki simbol bibir.

Masih ingat aksi Lara Croft?
George dan Nico juga tak kalah
hebatnya dalam beraksi. Tidak
hanya berjalan atau berlari, mereka
juga dapat melompat, memanjat,
bergelantungan, dan melakukan
aksi yang akan sering kita temui –
aksi mendorong atau menarik balok
kayu. Kita juga bisa melakukan
“stealth” untuk menghindari
pengawasan para penjaga maupun
gonggongan anjing.

Ada cuplikan cerita dalam
game ini. Pada saat terjadi cuplikan,
kita membutuhkan kecermatan
untuk menghindari kesalahan alur
cerita. Biasanya akan muncul
sebuah simbol ditengah-tengah
cuplikan dan kita harus menekan
tombol pada simbol tersebut
dengan cepat. Bila kita tidak cermat,
cuplikan itu akan terus diulang
sampai kita berhasil melakukannya
dengan benar.

Broken Sword: The Sleeping
Dragon akan membawa kita
bertualang ke berbagai lokasi di
berbagai negara, mulai dari hutan
belantara Congo, jalanan kota Paris,
kastil di Prague hingga ke pelosok
desa bersejarah seperti Glastonbury.
Dari segi kualitas visual, tampilan
game ini bisa dibilang bagus. Model
karakter-karakter di dalamnya
terlihat detil. Fisik George yang
sebelumnya terlihat agak kurus, kini
tampil lebih gagah. Dalam setiap

Jenis Game : Petualangan
Publisher : THQ
Developer : Revolution

Software

Spesifikasi Sistem
Minimal:
• Prosesor Intel Pentium

III 750MHz
• RAM 128MB
• Kartu Grafis 32MB
• Sound card
• DirectX 8.1
• Ruang harddisk 2GB
• CD-ROM drive 8x
• GeForce2 64MB
• Ms Windows 98/2000/XP

perjalanan, pakaian yang
dikenakan George dan Nico selalu
berubah sesuai dengan kondisi
lokasi. Animasi karakternya pun
cukup halus dan desain latar
belakang pemandangan serta
areal lokasi terlihat sangat
menawan dan penuh warna.

Sama seperti tampilan,
kualitas suaranya juga sangat
bagus. Yang patut dibanggakan
dari serial Broken Sword ini adalah
akting suara yang diisi dengan
logat bicara yang berbeda-beda
disertai dengan dialog menarik
yang dibumbui sedikit lelucon.
Sedangkan untuk musiknya, tidak
lebih baik dibandingkan seri-seri
sebelumnya. Permainan musiknya
masih jarang terdengar. Yang
mungkin sering terdengar
hanyalah irama musik yang
pendek diselingi dengan suara-
suara latar.

Secara keseluruhan Broken
Sword: The Sleeping Dragon
merupakan game petualangan
yang menarik. Teka-teki di
dalamnya telah terintegrasi
dengan baik dalam gameplay
sehingga menjadi mudah
dipecahkan. Ingin menikmati
pengalaman bertualang yang
menarik dan mudah? Anda bisa
mencoba game yang satu ini. PC+
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Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga dalam Dolar AS
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MOTHERBOARD

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 95
Asus P4PE-X, i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 85
Asus P4SDX, SiS655, AGP8X, DDR,
6PCI, USB2.0, Hyper-threading 71
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 210
Asus P4P800 Deluxe, i865, FSB 800,
ATA100, 4DDR 158
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800, 4DDR,
RAID, LAN, audio 137
Asus P4C800, i875, FSB800, 4DDR,
RAID, Audio, Gigabit LAN 189
Asus P4P800 +WiFi, i865PE, FSB800,
ATA100_SATA, 4DDR, audio 179
Asus P4S533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 70
Asus P4S8X/L 1394, SiS648, FSB533,
3DDR, AGP8x, audio,
Serial ATA, 1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 67
Asus P4P800S, i848P, FSB800,
2DDR, audio, S/PDIF 111
Asus A7V8X/L 1394, KT400, ATA133,
AGP8x, FSB266, 3DDR, audio,
LAN, 1394 126
Asus A7V600, VIA KT600, 6 PCI,
3DDR, AGP8x 107
Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby,
AGP8x 101
Asus A7V8X/L, VIA KT400, 6 PCI,
3DDR, SATA, ATA133 116

APLUS AP984 SATA, i865PE,
FSB 800MHz, 4DDR400, ATX, AC97 91
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 74
APLUS AP980, i845PE, ATX,
FSB533,2DDR333 SOUND AC97 68

APLUS AP986 VIA P4X400, ATX,
FSB533, SOUND AC97 6 channel,
3DDR400, AGP8X 52
APLUS AP976E2, VIA P4X266E, FSB
533MHz, 2DDR,M- ATX, AC’97 49
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A3 VIA P4M266A, ATX,
533FSB, SOUND AC97, 2DDR 49
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 875P Neo FIS2R, i875P, ATX,
FSB800, 2DIMM, ATA100, AGP8X, 6PCI 200
MSI P4MAM-L, VIAP4M266A, ATX,
FSB533, 2DIMM, ATA133, AGP4X, 3PCI 59
MSI 651M-L, SiS 651, m-ATX, FSB533,
2DIMM, ATA133, AGP4X 66
MSI 648 MAX-V, SiS 648x, ATX,
FSB533, 3DIMM, ATA133, AGP8X, 6PCI 68
MSI 848P Neo-S, i848P, FSB800MHz,
AGP8X, 2GB DDR400, SATA, 5PCI 94
MSI 648F Neo, SiS648FX, FSB800MHz,
AGP8X, 3GB DDR ATA133, SATA,
AGP8X 78
MSI 645GVM, I845GV, Matx, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 72
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 74
MSI 865PE Neo2, I865pe, ATX,
FSB800, 2GBDDR, ATA133,
AGP8X, 5PCI 120
MSI K7N2 Delta-L, nForce2, ATX,
FSB400, 3GB DDR, ATA133,
AGP8X, 5PCI 102
MSI K8T Neo-FIS2R, VIA K800T800,
ATX, FSB800, 3DDR, ATA133,
AGP8X, 5 PCI 180
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 72

Matsonic 9158E+, VIA P4M266,
FSB533, USB2.0, VGA ONBOARD 49
Matsonic 9127C, VIAP4X400, FSB533,
USB2.0, DDR400, AGP8X 55
Matsonic 9327D+, SIS650, FSB533,
USB2.0, 2DDR, VGA ONBOARD 54
Matsonic 9337C, SIS648, FSB533,
USB2.0, 3DDR400, AGP8X 64
Matsonic 9377C, SIS648FX, FSB800,
3DDR400, AGP8X, HTT 69
Matsonic 9367E, SIS 650GX, FSB533,
2DDR, VGA ONBOARD +AGP 55
Matsonic 8137C, VIA KT266A,
FSB266, 2DDR, VGA ONBOARD +AGP 49
Matsonic 8157E, VIA KM266, FSB 266,
2DDR, AUDIO, VGA ONBOARD + AGP 58

Matsonic 8167C, VIA KT333,
FSB266, 3DDR333, AGP 4X, AUDIO 51
Matsonic 8147C, VIA KT400A, FSB333,
3DDR400, AGP 8X, LAN ONBOARD 59

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 65
Gigabyte GA-7VA, VIA KT400, ATX,
Soket A, ATA133 79
Gigabyte GA-7N400-EL, nForce2 ultra,
ATX, Soket A, ATA133 99
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-S648,  SiS 648, ATX,
FSB533, ATA133, AGP8X, 5PCI 73
Gigabyte GA-S648FX, SiS 648FX,
ATX, FSB800, ATA133, 5PCI 97
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 167
Gigabyte GA-S648-L, SiS648,ATX,
FSB533, ATA133, 5PCI 75
Gigabyte GA-8IPE1000, i865PE, ATX,
FSB800, 4DDR, 5PCI 127
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 92
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 217
Gigabyte GA-K8N, Nforce3 150,
FSB800, 3DDR, ATA133, AGP8X, 5PCI 132
Gigabyte GA-K8NNXP, Nforce3 150,
FSB800, 3DDR, SATA, AGP8X, 5PCI 217
Gigabyte GA-K8VT800M, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 122
Gigabyte GA-K8VNXP, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 207

DFI LAN Party Pro875, i875P, ATX,
FSB800, AGP8X, 2SATA 190
DFI LAN Party KT400A, VIA KT400A,
ATX, FSB400, AGP8X, 1SATA 130
DFI LAN Party NF II Ultra, nForce 2,
ATX, FSB400, AGP8X, 1SATA 155
DFI PS83-BL, i865PE, ATX, FSB800,
AGP8X, 2SATA 85
DFI 648FX-ALE, i648FX, ATX, FSB800,
AGP8X, DDR 400 67
DFI P4X800-AL, VIA P4X400, ATX,
FSB533, AGP8X, ATA133 52
DFI KT400A Infinity, VIA KT400A,
ATX, FSB333, AGP8X, 1SATA 88

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68

Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 78
Iwill P4SE, i865PE, soket 478, FSB 800,
DDR, Audio, ATA100, Serial ATA 110
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing, SCSI 999

Soltek SL-87CW-FL, i875P, AGP8X,
ATX, 4DDR 172
Soltek SL-86MPI-L, i865P, AGP8X,
ATX, 2DDR 98
Soltek SL-85MIR3-L, i845GE,
AGP4X, mATX, 2DDR 74
Soltek SL-85MIV4-L, VIA P4M266A,
2 PCI, mATX, 2DDR 55
Soltek SL-85MIV3-L, VIA P4M266A,
3 PCI, mATX, 3DDR 55

Soltek SL-KT600-RL, VIA KT600,
6PCI, ATX, 3DDR 73
Soltek SL-75MRN-L, nForce2, 5PCI,
ATX, 3DDR 91
Soltek SL-KT400A-L, VIA KT400A,
6PCI, ATX, 3DDR 62
Soltek SL-75MIV2-L, VIA KM400,
3PCI, mATX, 2DDR 69

Abit IC7 Max III  i875P, FSB800MHz,
4 DDR, AGP 8X, 5 PCI 325
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 102
Abit BH7, i845PE, FSB 800MHz,
3 DDR, AGP 4X, 5 PCI 94
Abit IC7 MAX III, i875P, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 233
Abit IC7, i875P, FSB 800MHz,
4DDR, AGP 8X, 5 PCI 143
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KURSUS

KURSUS Video Editing (Adobe Premier/Ulead.7)
350rb/250rb Digital Imaging (Photoshop) 195rb
Merakit PC 95rb LAN 95rb Praktis,Certificate IZZAH
Com Jl.Rawamangun muka Timur #78
Ph.47867273 http://izzahcomp.tripod.com

LAIN-LAIN

DISTROLINUX.NET,Menjual CD distro Linux
terbaru seperti:      Mandrake/Redhat/Fedora/
Slackware/Gentoo/SuSE/Knoppix/xBSD/
OpenOffice dll.Harga per CD cuma Rp.10.000.
Hubungi:(021) 7096 0522 HP (SMS): 08121876981
Mail: info@distrolinux.net. Selengkapnya kunjungi
http://www.distrolinux.net

@BISNIS DI RUMAH. Peluang mendapatkan
penghasilan tambahan dengan komputer
anda,mudah,hanya 60mnt/hr, tidak perlu
pengalaman, tersedia pelatihan lengkap
Hub: www.real60minutemoney.net

IKLAN BARIS

Abit AI7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 144
Abit IC7G i875/ICH5-R, FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 190
Abit IS7E, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 109
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 133
Abit VI7, VIA PT800, FSB 800MHz,
2 DDR, AGP 8X,  5 PCI 94
Abit KV7, Via KT600/8235,
FSB 400MHz, 4 DDR, AGP 8x, 6 PCI 93
Abit NF7S, nVidia nForce2,
FSB 333MHz, 3 DDR, AGP 8X, 3 PCI 116
Abit KD7-A, Via KT400, FSB 333MHz,
4DDR, AGP 8X, 6 PCI 84
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 93
Abit NF7-SL, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 111

MEMORI

Visipro 128MB (4 IC) PC 133 30
Visipro 128MB (8 IC) PC 133 38
Visipro 256MB (8 IC) PC-133 60
Visipro 256MB (16 IC) PC-133 73
Visipro 512MB PC-133 110
Visipro 128MB (8 IC) PC-2100 26
Visipro 256MB (8 IC) PC2100 45
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 88
Visipro 128MB (4 IC) PC-2700 26
Visipro 128MB (8 IC) PC-2700 29
Visipro 256MB (8 IC) PC2700 45
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 89
Visipro 256MB PC3200 (8IC) 50
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (8IC) 52
Visipro 256MB PC800 (8IC) 105

V-Gen SDRAM PC-133 (8IC) 64MB 17
V-Gen SDRAM PC-133 (4IC) 128MB 28
V-Gen SDRAM PC-133 (8IC) 128MB 36
V-Gen SDRAM PC-133 (8IC) 256MB 57
V-Gen SDRAM PC-133 (16IC) 256MB 75
V-Gen SDRAM PC-133 (16IC) 512MB 109
V-Gen DDR PC-2100  128MB 21
V-Gen DDR PC-2100  256MB 38
V-Gen DDR PC-2700  256MB 40
V-Gen DDR PC-2100  512MB 74
V-Gen DDR PC-2700  512MB 76
V-Gen DDR PC-3200  256MB 40
V-Gen DDR PC-3200  512MB 78
V-Gen RDRAM PC-800 128MB 51
V-Gen RDRAM PC-800 256MB 98

Kingston 128MB DDR PC2100 22.5

DigiSound II, 128MB, multi MP3,
voice recording, display 130

MagicStar 128 Turbo, USB 2.0,
128MB 70

Umax Flash Drive FD-201 64MB,
USB 2.0 43
Umax Flash Drive FD-201 128MB,
USB 2.0 65
Umax Flash Drive CD-101, 64MB +
SD/MMC card reader, USB1,1 45
Umax Flash Drive MP101 64MB + MP3
player, USB 1.1 73
Umax Flash Drive MP101 128MB +
MP3 player, USB 1.1 100

Nexus UFD-64, USB Flash Drive
64MB ver 1.1 31.5
Nexus UFD-128, USB Flash Drive
128MB ver 1.1 42
Nexus UFD-256, USB Flash Drive
256MB ver 1.1 70.5
Nexus UFD-512, USB Flash Drive
512MB ver 1.1 141

Samba Flash disk & MP3 player
128MB FSI-128 156
Samba Flash disk & MP3 player
256MB FSI-256 209

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm ATA133,
2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 59
Maxtor 6Y060L 60GB 7200rpm ATA133,
8MB Cache, dual processor 72
Maxtor 6Y080L 80GB 7200rpm ATA133,
8mb cache, dual processor 75
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 105
Maxtor 6Y160PO, 160GB,
7200rpm, ATA 133/serial ATA,
8MB cache 165
Maxtor 6Y200PO, 200GB,
7200rpm, ATA 133/serial ATA,
8MB cache 225

Kingston 256MB DDR PC2700 42
Kingston 512MB DDR PC2700 81
Kingston 256MB DDR PC3200 45
Kingston 512MB DDR PC3200 89

MCPRO 512MB DDR PC-3200 86,5
MCPRO 256MB DDR PC-3200 43.5
MCPRO 512MB DDR PC-2700 84,8
MCPRO 256MB DDR PC-2700 40.6
MCPRO 128MB DDR PC-2100 20.7

MULTIMEDIA CARD

MCPRO 64MB 22
MCPRO 128MB 35
MCPRO 256MB 69,5

Twinmos MMC 64MB 27.5
Twinmos MMC 128MB 41

Visipro 64MB 26
Visipro 128MB 43
Visipro 256MB 75

COMPACT FLASH

MCPRO Flash memory 32MB 17
MCPRO Flash memory 64MB 21.5
MCPRO Flash memory 128MB 37.5
MCPRO Flash memory 256MB 54

Visipro Flash Memory 64MB 26
Visipro Flash Memory 128MB 42
Visipro Flash Memory 256MB 65
Visipro Flash Memory 512MB 125

Twinmos 64MB 27.5
Twinmos 128MB 36.5
Twinmos 256MB 64
Twinmos 512MB 121

USB FLASH MEMORI/
MP3/PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 85
Prolink USB Pen Drive, MP3 128MB 110
Prolink USB Pen Drive, MP3 256MB 165

MCPRO pen drive 128MB USB 2.0 39,5
MCPRO pen drive 256MB USB 2.0 58,5
MCPRO pen drive 512MB USB 2.0 120.5

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3,
128MB, MP3 115



Pemenang Kuis Edisi 155/III/2002:
HADIAH SOUVENIR PCplus

1. Aprianto R.S.
Jl. Melati III B6/13 Perum P.U.P
Bekasi Utara - Jawa Barat 17125

2. Denny Sela
Wergu Wetan 155 04/II
Kudus 59318

3. Iwan Kustiawan
Jl. Babakan Sari Gg. Pacul VI No.12
Kiara Condong - Bandung 40283

4. Ayu Kadek Sri Utami
Jl. Melati Belakang PDAM
Singaraja - Bali 81113

5. Lukito Budi S.
Jl. Teh No.17D Komplek Cengkeh Indah
Pinangsia - Jakarta Barat

KUIS Kata Febi, akhir tahun lalu salah satu vendor ponsel terkemuka
yaitu Siemens merilis tiga buah ponsel terbaru yang ditujukan untuk
pengguna MMS. Katanya sih MMS ini akan segera populer di

Indonesia. Si Ciplus tertarik untuk membeli, tetapi ia lupa seri dari ponsel terbut. Tolong dong
si Ciplus, sebutkan satu saja seri ponsel Siemens tersebut. Tuliskan jawaban tersebut di
sehelai kartu pos dengan mencantumkan alamat yang jelas dan sudah dibubuhi Kupon Kuis
asli (di pojok kanan). Jangan menunda-nunda, karena jawaban sudah harus masuk ke meja
Redaksi PCplus paling lambat tanggal 30 Januari 2004. PCplus akan memberikan 5 buah kaos
PCplus untuk 5 orang pemenang yang menjawab dengan benar dan beruntung! Buruan!!!
Hadiah akan dikirim langsung ke alamat pemenang.

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini
Jawaban Kuis No. 155/III/2002: GeForce dari nVidia dan Radeon dari ATi
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Seagate Ux/Cuda 5400.1 20GB
ATA 100 51.2
Seagate Ux/Cuda 5400.1 40GB
ATA 100 52.3
Seagate Barracuda 7200.7 40GB
ATA100 56
Seagate Barracuda 7200.7 80GB
ATA100 71.9
Seagate Barracuda 7200.7 120GB
ATA V/100 100.4
Seagate Barracuda 7200.7 Plus
160GB ATA V/100
(8MB cache) 134.6
Seagate Barracuda SATA 80GB,
ATA100 103,5
Seagate Barracuda SATA 120GB,
ATA100 126.3

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 50
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 53
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 58
Maxtor 4R060J/4D060H, 60GB 5400rpm,
ATA-133, 2MB cache 67
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call
Maxtor 4G160H, 160GB, 5400rpm,
9,0ms, ATA100, 2MB cache,
dual processor 165
Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 103

Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 125
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 170
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 235

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79
Western Digital WDC 7200rpm
cache 8MB 80GB 112

Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210

Samsung HDD 20GB 5400rpm 56
Samsung HDD 40GB 5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB, USB 2.0,
8MB Cache, 7200rpm 299
Maxtor 7000, 120GB, external,
USB 2.0, 2MB cache, 5400rpm 235

Maxtor 7000, 200GB, external,
USB 2.0, 8MB cache, 7200rpm 360
Maxtor 7000, 250GB, external,
1394/USB2.0, 8MB cache,
7200rpm 405

DVD-ROM

Pioneer 120T 9 (Trayload) 42
Pioneer 120S (slot in) 49

Samsung DVD 16X 30
Sony DVD 16X white 31
Sony DVD 16X Black 32
Asus DVD 16X 41
MSI DVD-ROM 38
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Joke dari Internet:
Lucu atau Menyebalkan?

Restituta Ajeng Arjanti
ajeng@e-pcplus.com

C

Joke alias humor
seharusnya memang

dibuat untuk lucu-
lucuan. Tapi, apa

benar semua humor
yang beredar di

Internet bertujuan
untuk lucu-lucuan?

Ternyata tidak.

ukup banyak
humor dari jagat
maya tersebut yang
bertujuan untuk mem-

buat resah para pengguna kom-
puter. Joke yang dimaksud da-
lam tulisan ini adalah humor bo-
hongan alias satu jenis tipuan di
Internet yang bisa dimasukkan
dalam kategori geng malware.

JOKE: MENYEBALKAN
Ciplus adalah satu dari

jutaan orang yang tak bisa
bekerja tanpa komputer. Setiap
harinya ia harus membuka
komputer, konek ke Internet,
memeriksa e-mail-e-mail yang
masuk, memilahnya ke dalam
folder “penting” atau “tak
penting”, baru kemudian
menjawab e-mail-e-mail
berlabel “penting” tersebut.
Suatu hari, Ciplus menerima e-
mail dari seorang sahabat yang
bersubjek “Lucu”. Karena ingin
tahu, dibukanya attachment
dalam e-mail tersebut. Tiba-tiba

sebuah pesan berbunyi “The
harddisk will be formatted,
do you want to continue?: Y/
N” muncul di layar monitor
dengan latar berwarna biru.

Apa yang terjadi dengan PC
si Ciplus? Ciplus bingung. Ia
memang banyak bekerja dengan
komputer, tapi ia bukan ahli
komputer. Apa yang harus
dilakukannya dengan PC
tersebut? Sudah barang tentu ia
tak ingin data-data dalam
komputernya hilang. Ciplus
panik, dan tanpa sempat berpikir
panjang memilih “N”. Ternyata,
tak ada bedanya jika ia memilih
“N” atau “Y”. Reaksi yang diha-
silkan tetap sama, muncul layar
yang menampilkan komentar
bahwa drive C: sedang diformat.
Ciplus hanya bisa duduk pasrah,
melihat semua data dalam
komputernya terhapus.

Untungnya Ciplus bekerja di
lingkungan yang melek TI. Segera
dipanggilnya staf TI kantor untuk
memeriksa PC tersebut. Setelah
diperiksa, tak ada yang satu pun
yang berubah pada konfigurasi PC
Ciplus. Ternyata file humor tadi
berisi sebuah program iseng yang
tujuannya tak lain hanya untuk
ngerjain orang. Lucu atau menye-

balkan? Pastinya menyebalkan!
Apa yang akan terjadi kalau

Ciplus langsung mematikan PC-nya
pada saat program tersebut masih
menampilkan proses format?
Kemungkinan, akan ada data yang
hilang atau kekacauan pada
konfigurasi sistem komputernya
akibat dimatikan secara paksa.

Atau seandainya Ciplus be-
kerja di lingkungan yang gaptek
alias gagap teknologi, kemungki-
nan besar ia akan membawa PC
yang dikiranya rusak ke sebuah
service center. Ciplus rugi, ia
harus membayar biaya servis,
padahal PC-nya tidak rusak.

JOKE: MALWARE
Bagaimana jika dalam satu

perusahaan, bukan Ciplus saja
yang menerima humor norak
tersebut? Bukan tak mungkin
semua user mematikan
komputernya dan diskonek dari
jaringan komputer perusahaan
untuk menghindari kemungkinan
kerusakan sistem. Bukan hanya
kerugian waktu yang dialami
perusahaan, tetapi juga
hilangnya produktivitas kerja
karyawan. Ditambah pula jika
staf TI perusahaan kurang
waspada akan bahaya dari

Internet sehingga kurang
mengerti masalah yang terjadi,
kemungkinan ia akan menghabis-
kan waktunya untuk mencari so-
lusi untuk masalah ini atau untuk
menginstal ulang semua seting
komputer perusahaan akibat
proses shut down yang menda-
dak. Joke bisa menimbulkan

masalah, karena itu ia dimasuk-
kan dalam kelompok malware.

Adakah cara paling aman
untuk menghindari joke? Kalau
ingin cara yang paling aman,
sebaiknya jangan buka e-mail tak
dikenal, apalagi jika e-mail ter-
sebut memiliki attachment. Atau
jika kita mendapatkan e-mail
semacam itu, dan memang sudah
tahu kalau e-mail tersebut adalah
joke yang mengganggu dan bisa
bikin sport jantung, jangan mem-
forward-nya ke orang lain sebab
belum tentu orang tersebut
mengerti bahwa program itu
hanya sekadar untuk iseng. PC+

CONTOH JOKE

Joke.Jep/Russ
Pesan yang Ditampilkan:
Please Wait. Initialising...

Akan muncul pesan:

Confirm Folder Delete
Are you sure you want to delete the folder [Windows] and all its contents ?
[Yes] [No]

Tombol [No] sengaja di-disable sehingga user tak diberi pilihan selain [Yes].
Setelah itu muncul pesan:

Shut Down Windows
Windows has detected there is no system software on your computer
 (*) Shut down the computer?
 ( ) Restart the computer?
 ( ) Close all programs and log on as a different user?
 [Yes] [No] [Cancel]

Di akhir program, akan muncul pesan yang mengatakan bahwa semua tadi
hanyalah sebuah permainan:

Thank god this is only a game...


